INTRODUCTION  J

It’s so hot it’s cool, it’s free, and it’s a prime contender for a place of honor in the
MicroScare Hall of Fame. Introducing StarOffice 5.0, the award-winning office suite from
StarDivision, a German-based software development house that is garnering the attention of
many industry insiders.

StarOffice is arguably the most feature-complete office suite available today, and if you’re
looking for an alternative to you-know-what, you need not look any further.

Visually slick, Web-enabled, and Microsoft Office-compatible, StarOffice can do word pro-
cessing (StarWriter), spreadsheets (StarCalc), presentations (StarImpress), vector and bitmap
graphics (StarDraw and StarImage respectively), formulas (StarMath), email (StarMail) and
newsgroups (StarDiscussion), Web browsing and HTML editing, and databases (StarBase)
in one fully integrated environment.

And if you familiarize yourself with the application’s programming and macro language,
StarBasic, you’ll discover that there’s virtually nothing StarOffice can’t do—okay, except, at
the moment, handle fully relational databases across all platforms. (Relations are implement-
ed only on the Win32 platform.) This is the weakest link in an otherwise outstanding pack-
age whose price-point can’t be beat. StarOffice is free for personal use and
cost-of-ownership for businesses is comparatively low due to StarDivision’s attractive site
licensing models and the program’s intuitive, context-sensitive tools and menus.

Clearly, StarOffice is a more-than-worthy challenger to the hoary old Office suite. It’s not
perfect—what software package ever is>—but it has an amazingly rich range of features,
including some unique ones like the Navigator and the Stylist, which Microsoft is reported-
ly busily copying for inclusion in (the optimistically named?) Office 2000 suite.

StarOffice’s strength does not just lie in features, however. Built around a task-centered
logic, StarOffice puts the focus of an office suite where it should be—on you and what you
need to do, not on the applications you use.



2 | Introduction

In the course of carrying out a common business task—say, creating a spreadsheet for a for-
mal presentation that combines a company logo, a company mission statement, and current
financial figures—you may end up needing to create pictures, text, documents, complex
charts and numerical calculations, as well as slides and other visual aids.

Conventional office suites would require you to open four or more applications and perhaps
master a different interface and set of tools in each one.

StarOffice has none of that.

Guided by the principle of “Make Your Ideas Work,” the program’s integrated desktop puts
all the tools you need to carry out a full range of tasks at your fingertips—but only when
and where you need them.

In short, StarOffice works the way you work—and the way other office suites promise, but
don’t.

Who Should Use This Book?

Special Edition Using StarOffice is designed for intermediate to advanced computer users.

It’s the right choice for corporate personnel, people running a home business, students,
instructors, computer support staff, small businesses, non-profit organizations and anyone
else interested in getting up to speed on StarOffice. Since the free version comes with limit-
ed documentation, individual users may find this book particularly useful as it offers a more
in-depth introduction of the program than is currently available in in English. Corporate
IT specialists considering making the switch to Linux but concerned about available end-
user applications may also find this book a useful introduction to the power and flexibility
of StarOffice across platforms.

How to Use This Book

Special Edition Using StarOffice consists of eight parts, broken down by application and com-
mon features.

Part I: Introducing StarOffice

Part I, “Introducing StarOffice,” gives you a basic introduction to this office suite as well as
an overview of the common tools and features in StarOffice.

Chapter 1, “A Star Is Born,” introduces the StarOffice program suite, complete with a fea-
ture review of each individual module.

Chapter 2, “Stepping into StarOffice,” gives you a tour of the StarOffice desktop, your cen-
tral command post for all your work in StarOffice, as well as the online Help system.

Chapter 3, “Getting Ready for Work,” takes you through the steps of setting up your online
accounts and configuring your StarOffice work environment.
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Chapter 4, “Working in StarOffice,” introduces you to common tools and features that are
shared among program modules and explains the basics of opening, saving, and closing files
in StarOffice.

Chapter 5, “Managing Folders, Files, and Mail,” introduces you to file and desktop man-
agement principles that will help you manage your work more efficiently.

Part II: Creating Documents—StarWriter

Part II, “Creating Documents—StarWriter,” takes you into the heart of the StarOffice word
processing module that is giving MS Word a run for its money.

Chapter 6, “Creating and Editing Text Documents,” introduces you to the StarWriter
workspace and toolbars. It takes you through the basics of entering, editing, and selecting
text as well as saving, closing, and opening documents.

Chapter 7, “Formatting Text Documents,” explains your character, paragraph, and page
direct formatting options, including numbered and bulleted lists, as well as the AutoFormat
function.

Chapter 8, “Using Styles and Templates,” covers the essentials of working with styles and
templates and shows you how to be more efficient by using them.

Chapter 9, “Working with Tables, Charts, and Fields,” tells you how to create, edit, and
format tables in StarWriter and make the most of using fields, including mail merge.

Chapter 10, “Working with Long Documents,” details the challenges and tools involved in
creating complex and long documents, including using the Navigator, outlines, indexes, and
master documents.

Chapter 11, “Desktop Publishing with StarOffice,” describes ways you can add a desktop
publishing flair to your documents by using multicolumn layouts and inserting graphics and
objects into documents.

Chapter 12, “Proofing and Printing Your Documents,” discusses StarWriter’s proofing and
spelling tools, search and replace, previewing, printing, and faxing options.

Part Ill: Working with Spreadsheets—StarCalc

Part III, “Working with Spreadsheets—StarCalc,” introduces StarOffice’s workhorse,
StarCalc, which offers all the calculating and analysis power you would expect plus a bevy of
database management features.

Chapter 13, “Creating Spreadsheets,” gives you a tour of StarCalc’s tools and workspace. It
also gives you thorough grounding in basic data entry, selection, and navigation techniques,
and steps you through the basics of opening and saving files.

Chapter 14, “Editing Spreadsheets,” explains the hidden mysteries of worksheet cells and
introduces basic editing techniques and tools in StarCalc, including its superior drag and
drop features and Navigator, StarOffice’s roaming office assistant.
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Chapter 15, “Formatting Spreadsheets,” discusses issues to consider when formatting
spreadsheets and explains how to use the many cell, row, and column formatting options
you have in StarCalc.

Chapter 16, “Using Formulas and Functions,” explains how to create and work with formu-
las in StarCale, introduces some of StarCalc’s many built in functions, and shows you how
to use the Function AutoPilot.

Chapter 17, “Creating Lists and Databases with StarCalc,” discusses the benefits of using
StarCalc to manage lists and databases and introduces you to the tools you’ll need to do so.

Chapter 18, “Analyzing and Charting Data,” introduces you to some of StarCalc’s more
advanced data sorting and analysis features, including pivot tables and the DataPilot,
StarCalc’s unique data analysis wizard, and takes you through the steps of creating charts
with StarChart.

Chapter 19, “Preparing and Printing Reports,” explains page formatting and page styles and
takes you through the steps of preparing a report for printing, including dressing up your
document with graphics, setting your print range, and previewing your page layout.

Part IV: Getting Graphical—StarDraw and Starimage

Part IV, “Getting Graphical—StarDraw and StarImage,” tells you all you need to know
about StarOffice’s drawing and image manipulation modules.

Chapter 20, “Getting Sketchy with StarDraw,” provides a basic introduction to vector ver-
sus bitmap graphics, explains their uses, and details your options when working with vector
graphics, including using the geometric drawing tools, drawing lines, shapes, and curves,
and creating 3D objects.

Chapter 21, “Creating and Modifying Images with Starlmage,” covers image conversion
and manipulation options in StarImpress and shows you how to work directly on the image
in numerous image formats.

Part V: Presenting Results—Starimpress

Part V, “Presenting Results—StarImpress,” tells you how to make the most of presentations
with StarImpress.

Chapter 22, “Getting Started with StarImpress,” introduces you to the basics of presenta-
tions, including planning, creating, saving and opening presentations.

Chapter 23, “Enhancing Your Presentation,” explains how to enhance your presentation
with 3D, font, transition, and animation effects.

Chapter 24, “Previewing and Presenting Your Presentation,” tells you how to preview and
) g g ’ y

print presentations, produce on-screen slide shows, and create speaker notes and audience

handouts.
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Part VI. Spreading the Word—StarOffice on the
Web and at Work

Part VI, “Spreading the Word—StarOffice on the Web and at Work,” introduces you to
StarOffice’s Web features and Groupware capabilities.

Chapter 25, “Getting Started with StarWriter/Web,” describes how you can use StarWriter
as an HTML editor and covers basic HI'ML editing and formatting techniques, including
adding hyperlinks and objects.

Chapter 26, “Enhancing HI'ML Documents,” shows you how to take advantage of
StarOffice’s integrated desktop to create great-looking Web pages for personal and business
use.

Chapter 27, “Publishing Your Work on the Web,” goes into details on uploading and down-
loading files and setting up a StarOffice FTP account.

Chapter 28, “Teaming Up at Work,” gives you tips on how to best utilize StarOffice in a
workgroup or network environment, including making the most of time and document
management features such as StarSchedule and revision marks in documents.

Chapter 29, “Communicating with StarMail and StarDiscussion,” tells you all about using
StarOffice’s email and newsgroup modules, including how to create email mail merges, han-
dle attachments, and manage mail and news effectively.

Part VII: Working with Databases—StarBase

Part VII, “Working with Databases—StarBase,” introduces you to one of StarOffice’s newer
modules, the StarBase relational database.

Chapter 30, “Working with Databases in StarBase,” explains StarBase’s central role as inte-
grated data manager in StarOffice and your database import and export options. It also
introduces you to the four types of StarBase objects and gives a brief tour of their tools and
menus.

Chapter 31, “Creating Stand-Alone Database Tables,” takes you through the steps of creat-
ing flat list database tables with both the AutoPilot and from scratch, introducing you to
some important database design issues along the way.

Chapter 32, ,”Creating Tables with Relations,” takes off from Chapter 31 to introduce basic
relational database concepts, including primary keys and data normalization, and discuss
creating relational tables in the native StarBase format (available only on the Win32 plat-
form).

Chapter 33, “Working with Data in Tables,” discusses not only entering and editing data in
StarBase tables, but more importantly how to get that data where you want it in your
StarOffice text and spreadsheet documents.
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Chapter 34, “Creating Forms for Easy Data Entry,” shows you how to create queries with
the AutoPilot as well as modify them afterwards, and touches upon StarBase’s implementa-
tion of SQL (Structured Query Language), a computer language used to query external
data sources.

Chapter 35, Getting Answers with Queries and Fields,” introduces you to StarOffice’s form
building tools and explains how to create new forms in StarBase.

Chapter 36, “Creating and Printing Reports,” demonstrates how to generate database
reports in StarBase using the AutoPilot. It also discusses the attractive alternative of creat-
ing reports and report templates by importing StarBase data and fields into ordinary
StarOffice documents.

Part VIII: Automating Your Work—StarBasic

Part VIII, “Automating Your Work—StarBasic,” introduces you to StarOffice’s macro and
programming language, StarBasic, and shows you how you can create your own macros,
organize a library of programs, and customize your desktop by using the macros and com-
mands already included with the program.

Chapter 37, “Familiarizing Yourself with StarBasic,” introduces you to StarBasic and
StarOne, its cousin, and plunges you into creating and editing macros to automate your
work. It also explains the StarOffice object hierarchy of macros, modules, and libraries and
offers tips for organizing your StarBasic macros and programs.

Chapter 38, “Understanding StarBasic Structures and Statements,” takes you more deeply
into StarBasic’s programming statements and structures. The chapter is packed with
detailed examples of code that you can enter for yourself.

Chapter 39, “Programming with StarBasic,” discusses programming with StarOffice objects,
using StarWriter and StarCalc as examples. It also explains how to assign macros to events
and takes you through creating an entire application in StarBasic—creating a custom dialog
box as an alternative to StarWriter’s AutoComplete feature.

Appendixes

The appendixes offer a potpourri of useful information to help you get StarOffice up and
running and put it to work for you.

Appendix A, “Installing StarOffice,” goes over the basics of installing StarOffice on both
single user and network systems, and explains the StarDivision registration process, which
must be successfully completed for the program to function past its 30-day trial period.

Appendix B, “File Formats and Extensions,” lists all the file types StarOffice imports and
exports, as well as all the file extensions of native StarOffice file formats.

Appendix C, “StarOffice Program Directories and Files,” gives a selected list of program
files, their locations, and tips about which files you might edit to directly manage aspects of
your StarOffice environment.
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Appendix D, “Default Keyboard Shortcuts,” lists the default keyboard shortcut assignments
for each program module.

Appendix E, “StarBasic Error Codes,” provides a complete list of undocumented error
codes in StarBasic.

Conventions Used in This Book

StarOffice enables you to use both the keyboard and the mouse to select menu and dialog
items: you can press the Alt key plus letter your keyboard to open menus and menu items,
or you can open a menu and select an item by clicking it with the mouse. A typical com-
mand sequence may read: Select File, Open, or press Ctrl+O.

"This book assumes that your mouse is set for right-handed operation. You use the left
mouse button for clicking toolbar buttons, menus, and dialog options. You use the right
mouse button for bringing up shortcut menus. Unless otherwise noted, click means clicking
the left mouse button, and right-click refers to using the right mouse button.

Note that your screen may appear slightly different from the examples in this book.
StarOffice gives you numerous ways of customizing and changing the look of your desktop
and interface. Although we’ve tried to keep StarOffice’s default settings as much as possible,
there may be discrepancies between what you see on your screen and what you see in the
screen shot—nothing to worry about, though.

"This book also uses several eye-catching icons that you ought to familiarize yourself with:

This icon highlights a special point of interest about the current topic

Tip #1001 from
Michael & Garah

This icon helps you work smarter and faster by pointing out killer techniques or shortcuts.

Sometimes it’s best to be careful. This icon alerts you to those instances.

[l This icon sends you to other places in the book for more information on a current term or topic.

L
Ll

WINDOWS

These icons highlight platform-specific issues. For the most part, StarOffice works the same
across platforms. These icons highlight the few occasions where something on one plat-
form may not work, or may work a bit differently, on another.

II:II:I

%]  StarOffice comes with numerous toolbars and buttons that you can click to execute a com-
mand. This book uses button icons in the margins, indicating which button to click to exe-
cute the currently discussed task.
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Introducing StarOffice

Welcome to StarOffice, the award-winning Office suite from Star Division Corporation
based in Fremont, California. Once the official Office suite for IBM (which then bought
Lotus instead, requiring an official switch to Lotus SmartSuite), StarOffice is the only high-
end Office software available worldwide that supports the most commonly used operating
systems, including Windows 95/98; Windows N'T; OS/2; the diverse UNIX-based systems,
such as Sun Solaris and Linux; and Java, which, for the first time, makes the complete func-
tionality of an Office suite available on network computers (NCs)!

StarOffice 5.1 is the Linux community’s favorite Office suite because of its low cost and rea-
sonably high degree of Microsoft compatibility. It also runs great on Windows 95/98,
Windows N'T, OS/2, Java, and Solaris boxes. If you’re willing to spend a couple of hours on
the Internet to download the Personal Edition from www.stardivision.com, you can have a
solid Office suite with word processor, spreadsheet, 3D drawing, and presentation programs;
an easy-to-use database application; an email client and news reader; an event
scheduler/planner; and an integrated Web browser—for free!

The suite’s standard Personal Edition is quite complete, including clip art and document
templates. For as little as $39.95, however, you can upgrade to the Personal Edition Deluxe,
which includes more import and export filters for greater compatibility with other desktop
application suites and some modest documentation. As a business owner or company deci-
sion-maker, you might want to look into the Professional or Business Edition, which comes
with a reasonably priced and variable license program that provides the most favorable
opportunity to implement a modern high-end Office suite in your company.

In short, if you've been looking for a lower-cost, higher-performance suite than what you
can find around the corner at the computer store, you owe it to yourself to give StarOffice

atry.

Why Use StarOffice?

If you've invested in Microsoft Office (on Windows) or Corel (on Linux), you might ask
yourself why you would need another Office suite. The answer depends on how you like to
work.

StarOffice can boost your productivity because you can perform all tasks from a perfectly
integrated workplace. It doesn’t matter whether you are editing text or spreadsheets, creat-
ing presentations, or working in a team. You can also surf the Internet and read and write
email or news postings. Plus, you will never again have to start various individual programs
to manage specific tasks.

The StarOffice suite provides powerful Web-enabled word processing and HTML editing
(StarWriter), spreadsheet (StarCalc), presentation (StarImpress), bitmap and vector graphic
(StarImage and StarDraw, respectively), formula (StarMath), charting (StarChart), email
(StarMail), news reader (StarDiscussion), scheduling (StarSchedule), and database (StarBase)
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applications, plus an integrated FTP client. It also manages to unite all functions for work-

ing with text, graphics, spreadsheets, or databases into one integrated work environment. Part
With optional add-ons, you can connect a PalmPilot and Dragon NaturallySpeaking soft- |
ware. And when you familiarize yourself with the application’s programming and macro lan-
guage, StarBasic, you’ll discover that there’s virtually nothing that you can do in other
Office suites that StarOffice can’t do at least as well if not better—with the exception of han- 1
dling fully relational databases across all platforms. (Relations are implemented only on the

Win32 platform.)

Ch

StarOffice has been designed with its own internal implementation of object linking and
embedding (OLE), which allows information to be carried seamlessly from one application
to another—even to store that information in an area where any StarOffice application can
grab it at any time. If necessary, you can have your spreadsheets transparently dump their
data into your text documents without having to switch programs, or you can embed a chart
into a spreadsheet and have it update its columns whenever you edit the tabular data, to
name but a few options.

What's Included in StarOffice?

Because appearance matters a great deal, often the first thing people notice about any pro-
gram is how it looks—the user interface. StarOffice gives you complete control over your
user interface. Most of StarOffice’s frames and toolbars can be “torn off” and placed or
docked anywhere within the master frame. If you like, you can also switch off everything
and maximize your workspace to the hilt.

When you start StarOffice, you’ll find that working with the interface is not dissimilar to
working on a Windows 95 machine. The StarOffice shell is similar in form and function to
Windows 95’ Explorer. And the integration between the different StarOffice “modules” is
very well implemented to say the least.

The StarDesktop is a major factor in the design of this Office suite. It has its own icons, fold-
ers, and directory tree, and it ensures consistency across platforms. When you open a docu-
ment in StarOffice, it appears in its own private taskbar, which resembles the Windows
taskbar, including a Start button and system tray. Although you cannot detach a document
window and have it float outside the StarOffice desktop, you can choose whether you want
to run StarOffice as an integrated desktop. If not, StarOffice floats on your desktop like any
other Windows application. If you’re not used to the Windows paradigm, you might find
working in StarOffice a bit confusing at first. However, after you orient yourself in
“StarSpace” and learn to navigate the desktop, you will find that your workflow and speed
improve tremendously. StarOffice’s navigation is simplified through the Beamer and
Explorer—frames that you can toggle on and off and which show directory structures and
directory contents. These features are useful when you want to drag and drop files or links
to files in other places.
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The Explorer, found on the left-hand side of your application window, enables you to orga-
nize your work and your work’s peripherals (including clip art, images, sounds, and so on) in
such a way that you can easily access them without leaving your document. You can assign it
to link to anywhere you like. You can also create folders that link to other areas on your sys-
tem or network. For example, you could conceivably create a new folder called apps in the
Explorer, link it to your application directory on the hard drive, and then use StarOffice like
a program-launching shell in conjunction with the Beamer.

The oddly named Beamer serves as your center for importing data. You can open tables and
queries in the Beamer, and you can drag and drop data, merge fields, and form controls into
open documents. No complicated dialog boxes, no searching through menus for the right
command! You can also insert data with database fields. You can consolidate and copy tables
through drag and drop in the Explorer and on the desktop. The Beamer is located at the top
of your application window. If the Explorer is set to Hierarchical view, it can display the
contents of whatever Explorer folder you have selected in the open Beamer.

The Explorer and the Beamer, when used together, enable you to quickly assemble and
reuse pieces of documents over and over again. Not surprisingly, the Explorer and the
Beamer are fairly consistent StarOffice features that you can toggle on or off at your whim,
regardless of what kind of document you are working in at the time.

Each StarOffice component has all the features you would expect from a program of its
type, plus a lot more:

= StarDesktop is the center of your work in StarOffice. Together with the Explorer and
the Beamer, it allows access to all available program and system resources. In addition
to several features that help with your daily work in StarOffice, StarOffice 5.1 offers
you extra highlights for working in utmost comfort. Tapping into various configuration
options, users can easily create their own personalized work environment.

= StarWriter is a powerful word processor that comes with a host of features, including
numerous styles, autoformatting capabilities, a spelling checker with multilingual and
custom user dictionaries, and (for an Office suite) a superb capability for handling mul-
tiple formats in the same document, complex multichapter documents, and booklet-
style layouts. If you acquired the Personal Edition Deluxe, this module can open and
save even more files and documents created in Microsoft Office, WordPerfect, Lotus 1-
2-3, and AmiPro. The module also doubles as a Web browser, which enables you to edit
both Hypertext Markup Language (HTML) source code and Web pages in
WYSIWYG (What You See Is What You Get) format with all the advantages of a word
processor. As a browser, StarWriter supports Cascading Style Sheets, frames (even when
editing), Java, JavaScript, and proprietary Netscape Navigator and Internet Explorer
HTML features and plug-ins.

= StarCalc looks and works very much like Microsoft Excel. All the features are there,
including macros (not Visual Basic for Applications, though), advanced formula con-
struction, Microsoft Excel 5 and 95, Lotus, and dBASE compatibility. StarCalc also
enables you to create lists or clearly present your data and create impressive 3D charts,
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and an easy-to-use scenario manager helps analyze data according to various factors.
Plus the module is fit for the new millennium, with four-digit data handling and com-
plete Y2K compliance. It also handles Euro conversions with typical European flair.

Starlmpress is Star Division’s answer to Microsoft’s PowerPoint. It imports
PowerPoint files reasonably well and includes vector graphic and special effects tools
that enable you to create impressive presentations and object animation, as well as
import documents and objects from other StarOffice applications. Graphic tools include
flowchart-style shapes, and a wizard walks you through the process of creating a Web-
based slide show. You can save your presentation in HTML format, allowing you to
easily create a copy for a World Wide Web home page. Each slide of your presentation
will be saved as a picture on an HTML page (so any multimedia or animation your pre-
sentation may have had will not be kept in the transfer), and an index page will auto-
matically be created, allowing Web users to easily access all of your presentation’s slides.
Just upload the converted HTML to a Web site, and you're ready to go.

StarDraw has the power of a vector graphics program that enables you to create a wide
range of 3D graphics and Bézier curves very quickly (in fact, its functionality might be
compared to Corel DRAW). Using StarDraw, you can create drawings of varying
degrees of complexity. You can add color, text or textures to your shapes and 3D
objects, create buttons and icons for your Web pages, or design a multipage interactive
document. You can create organizational charts and technical drawings. In general,
every object you create in StarDraw can be inserted into any other StarOffice document
as a graphic object. And since StarDraw is an OLE-compliant application, you can use
OLE to move images between Draw and other StarOffice modules. In short, StarDraw
can enhance your creative freedom. Like the rest of StarOffice, StarDraw is fully inte-
grated into the package as a whole and able to import some legacy graphics formats.

Starlmage is a graphics utility similar in scope to Paint Shop Pro with the capability to
transform, filter, and otherwise perform basic image editing tasks. It includes many con-
version and manipulation functions, including bitmap tools to control brightness, con-
trast, and other image attributes; it also enables you to work directly on the image in
numerous image formats, including BMP, JPEG, GIFE, TIE, XBM, EPS, and PNG. As is
the case with the other StarOffice modules, StarImage is fully tied into the rest of the
suite and can import some legacy image formats. It’s also quite fast and has several
handy effects and filters.

StarChart is an efficient applet for chart creation. Using StarDraw, you can create and
import charts of any size into your text, table, drawing, and presentation documents.
StarDraw renders charts in 3D format, and generates simple pie, bar, and line diagrams.
If you want to present complex data in even more visually impressive ways, use
StarDraw.

StarBase is StarOffice’s built-in data manager. It’s been considerably improved in ver-
sion 5.1 with a switch to the new Oterro database engine made by rbase. In addition,
many bugs have been fixed, and ODBC and JDBC support have been improved on both
Windows and Linux platforms. If you want, you can create relational databases in the

|15
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native StarBase format on the Win32 platform. However, StarBase is not intended to be
a fully robust relational database management system (RDBMS), so you must take off
your Microsoft Access glasses when you look at StarBase’s features! As a data manager,
StarBase enables you to create mail merges and import data into your StarWriter and
StarCalc documents in a snap. The built-in Address Book is a StarBase database (in
dBASE format), so playing around with the Address Book is a great way to learn
StarBase’s tricks. You can create and import tables in dBASE format; import data in text
format; and connect to ODBC, JDBC, Oracle, and DB2 client/server databases. If you
have the Microsoft Jet Engine and DAO installed, you can import Microsoft Access 97
databases as well.

= StarMail and StarDiscussion are the suites’ email and news clients, respectively. Both
modules are totally integrated into the StarDesktop. With release 5.1, these email and
news functions have been improved and extended, with security, comfort, and reliability
being the development watchwords. No other office suite offers you comparable ease of
email use or flexibility in addressing, storing, and exporting email and news postings.

= StarSchedule is a robust scheduling and task management tool that you can use alone
or as part of a workgroup environment. StarSchedule does an excellent job of keeping
track of events and to-do lists, enabling you to combine both, together with your data-
base Address Book, into a single screen. With StarSchedule, you can define a one-day
or recurring event, check your free time and appointments, or update your to-do lists.
In addition, it features a reminder system that not only supports the usual “pop-up” dia-
log alerts (with or without sound), but also sends email reminders to yourself at a pre-
scribed time (up to two days before an appointment or event)—a welcome feature when
you’re on the road or dividing your time between two or more computers. Naturally,
you can also directly synchronize data with hand-held digital assistants such as the
3Com/U.S. Robotics PalmPilot.

= StarMath is a powerful and user-friendly formula editor that enables WYSIWYG edit-
ing and comes with numerous symbol sets and operators.

What's New in StarOffice 5.1

Committed StarOffice fans and the ABM (Anyone But Microsoft) crowd will find lots to like
in the latest version of the award-winning software, and newcomers to the StarOffice world
will find much to like as well. Compatibility and efficiency were Star Division’s major goals
for this release. In StarOffice 5.1, for example, you can open and save in earlier StarOffice
file formats. This version also offers the following new conveniences:

= New and more efficient AutoPilot wizards—including an Internet Setup Wizard
(Windows only), a Microsoft Import Wizard for documents and templates, and an
HTML Export Wizard for presentations and graphics—make it a breeze to get online
quickly and without hazzle or create professional-looking documents.
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m Version 5.1 provides (near) seamless collaboration for Microsoft Office users, not only
with document import and export, but also with templates. Part

= The option to integrate external browsers rather than use the built-in StarOffice brows- |
er enables you to surf the Internet with the most up-to-date technology. StarOffice 5.1
supports MS Internet Explorer 4.0 and 5.0. Netscape Navigator integration is planned
in the near future. 1
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» Perfect interaction with the operating system enables you to import existing bookmarks
into your StarOffice work environment, as well as define the program’s email client and
news reader as default applications for mail and news.

m Version 5.1 comes with completely revamped Open and Save As dialog boxes. The
focus has been on optimizing and improving the navigational and file management
options. You can now access directories and files more quickly and with greater focus
than ever before.

= The new Explorer provides single-click support and more organized, easier, and quicker
access to files, functions, and objects.

= The improved uniform approach to working with documents of any kind makes work-
ing in StarOffice more intuitive.

» The StarOffice help system, including the Help Agent and Extended Tips feature,
guides you step by step through your work process so that you can quickly reach any
goal with ease.

= Efficient tools to convert bitmapped images to vector graphics or to 3D objects give
you creative freedom and variable design options.

= New effective 3D diagrams and descriptive share charts give you the option to visualize
your data even more impressively.

m Version 5.1 provides improved security for your personal mail with standard PGP
encryption support (Windows only).

» This version provides for individual configuration in a matter of seconds.

» The advanced groupware functions make it easy to work in a team environment, share
documents and data, and coordinate events and tasks among network users.

Other improvements include an enhanced database, the completely revised Formula Editor,
and the substantially enhanced performance when printing graphics.

Advantages of Using StarOffice

StarOffice was designed from scratch to be ported across many platforms and to solve the
problem of different user interface “experiences” at the same time. As a result, it feels like a
window manager within a window manager. It has its own desktop, scripting language, file
management system, and taskbar, and it comes with a slick-looking interface that is more
than just skin deep. You’ll enjoy many benefits when working with StarOffice.
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Microsoft Office-Compatible

You can import existing Microsoft Office documents and templates to create spreadsheets,
presentations, and documents in StarOffice; then you can save all your data in Microsoft (as
well as other) formats or as HI'ML files to post on Web servers. Although it is not 100 per-
cent perfect, compatibility between StarOffice and Microsoft Office is often better than
compatibility between different versions of Microsoft Office. (In general, it’s impossible to
create 100 percent working import/export filters since different Office suites are using dif-
ferent approaches. In our humble opinion, however, StarOffice provides the best Microsoft
filters available.)

Seamlessly Integrated Work Environment

StarOffice is the first Office package to unite all functions for working with text, graphics,
spreadsheets, slides, mathematical formulas, and databases into one common, visually slick
user interface. The modules that make up StarOffice have standardized, context-sensitive
toolbars and menus and consistent commands and dialog boxes. After you learn one applica-
tion, you can easily familiarize yourself with the others. Best of all, with StarOffice you no
longer have to start several applications while working on a project. The suite does every-
thing in one place. If you have worked in Office suites like Microsoft Office, for example,
you certainly have experienced the frustration of working in one application and then having
to find another application, clicking on its icon or menu entry, and waiting for it to start.
With StarOffice, you don’t need to wait. Everything is in one single application, which rep-
resents StarOffice itself. You can simply start with one project (or document) and have
StarOffice put the items and commands you need on your desktop automatically when you
need them.

Web Aware

StarOffice is not only a fully integrated Office suite, but it is also essentially an Internet
application. Many aspects of the product make access and communication across the
Internet almost invisible. The function bar at the top of the screen features browser controls
that enable you to browse both the Web and your desktop and files. In the adjacent URL
text box, you can type an Internet address or the location and name of a locally stored file.
The path to a file you are working on is accessed as if you were on the Internet. Local files
are accessed using the FILE: protocol, whereas documents stored on Internet servers can be
accessed with the FTP and HTTP protocols, for example. The history list of recently
opened documents mixes both the Web pages you’ve visited next to your spreadsheets, let-
ters, and memos. From StarOffice’s point of view, the difference between a file on your own
hard drive and a file on a server somewhere on the Internet is slim.

In addition, you can easily select text and then add a hyperlink to the text by using the
hyperlink bar, which also doubles as a gateway to your favorite Web search engines. The
product also recognizes references to objects on the Internet, such as URLs or email
addresses. When you click on an address, StarMail is launched. Email is fully integrated, so
you can create mass emailings with mail merge in a few easy steps.
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One of the suite’s neatest tricks is its capability to open and publish documents directly to

and from Internet FTP and HTTP servers. Star Division supports industry standard tech- Part
nologies such as Internet protocols and services and is open for established industry stan- |
dards. In general, if HTML is your bag, StarOffice definitely takes the gold. Its HTML
integration is unsurpassed, and its image manipulation and creation capabilities will no
doubt come in handy when you’re doing any serious Web publishing. Last, but not least, the 1
built-in browser is almost on par with Netscape Navigator and Microsoft Internet Explorer

4; it supports Java, JavaScript, plug-ins, frames, and blinking text and is integrated with

StarWriter’s impressive HTML support.
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In its current incarnation, StarOffice’s browser is still a little slow compared to other
commercial browsers.

Resource Efficient

Aside from the convenience and time you save by working in an integrated environment,
you also can save system resources with StarOffice’s single-user interface—provided you'’re
not working on an old PC and attempt to start other programs from StarOffice, in which
case the integrated desktop is a speed and resource killer.

Groupware Enabled

All major modules in StarOffice include both email and groupware integration, allowing you
to send your presentations easily to any person or workgroup. StarOffice also has excellent
multiaccount email features built in and comes with a useful news reader. The program also
reveals its European heritage (the parent company is German) with its multilingual spelling
checker and strong support for international keyboards and characters. The StarOffice
Server extends StarOffice into a full-blown network application. It is perfectly suited for
those who want to take full advantage of network possibilities, regardless of whether you
work with PCs, NCs, or heterogeneous systems.

Cost Efficient and Affordable

Migrating to StarOffice involves minimal cost for personal and business users thanks to Star
Division’s attractive license offers. Because StarOffice can be used on various operating sys-
tems, and because it can quickly exchange documents in all important formats, including
Microsoft formats, migration to StarOffice reduces cost of ownership, offering enormous
advantages for both business and private use.

Reduced Cost of Ownership

Perfectly aware that businesses and individuals have made investments in other Office
suites, Star Division is working to reduce total cost of ownership of its Office suite through
revolutionary licensing models. For example, private users can download a fully functional
StarOffice Personal Edition for free from the Star Division Web site at
www.stardivision.com. For the educational market, Star Division offers two licenses
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(K-12 and Campus) at an affordable price, which also entitles registered users worldwide to
free updates and free upgrades for future versions. For businesses and corporations,
StarOffice offers a choice of three site licenses (Small Business, Business, and Enterprise). In
addition, Star Division is expanding its support and service network to solidify its market
position as the leading office solution provider. For the German market, it is already offer-
ing consulting services and the new StarOffice Certified User Program (CUP); similar plans
are in the works for the international market.

Easy Customization

StarOffice is easily one of the most customizable programs available. Each application with-
in StarOffice has its own set of tools and customization features, allowing you to create a
working environment best suited for your situation. For example, each application comes
with its own set of toolbars. These toolbars are tailored to the kind of work you do.
StarWriter, for example, loads toolbars focusing on formatting documents if you use a text
document template, but it loads toolbars focusing on Web design if you use an HTML tem-
plate.

In addition, you can easily show or hide the icons associated with a toolbar function (via the
toolbar’s configuration and context menus), edit the menu items, assign keyboard shortcuts
to your favorite commands, and even save entire configuration schemes so that different
users can share the same computer without one of them having to compromise his or her
preferred working style. (By the way, the toolbar icons are actually 160015 bitmaps, stored in
the office51\config\symbol directory, so you can stick your own bitmaps there and use them
in your menu bars.) In addition, you can automate your workflow by creating macros with
StarBasic.

Disadvantages of Using StarOffice

Now the bad news. Despite all StarOffice’s features, some components of the program are
not yet as powerful as those of its competitors—first and foremost Microsoft Office and
Corel’s Office suite—which started out as separately marketed programs long before the
idea of an Office suite came along. By the way, this factor may also prevent those established
suites from integrating their components together in StarOffice-fashion as easily as
StarDivision has. So there is a trade-off. For example, StarWriter comes with a solid
spellchecking program but does not include a grammar checker, and its revision marks fea-
ture is somewhat temperamental and incompatible with Microsoft’s or Corel’s. Also, if one
application crashes the whole suite is off, and you typically have to reboot to be able start
the suite again. In its favor, however, one has to commend the suite’s ability to restore docu-
ments lost by a crash—it’s quite good.

As of this writing, the documentation is still undergoing translation into English, so the
online help system is still under construction (to say the least), and what little there is could
benefit from a better localization job. However, the Tool Tips and Extended Tips that guide
you through the various buttons and their functions don’t leave you totally stranded.
Besides, you also have this book to nudge you on.
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Furthermore, many users are disappointed by the lack of a distinct database. However, as

mentioned earlier, StarBase is not intended to be a fully robust relational database manage- Part
ment system (RDBMS). Instead, it’s meant to be used as a data manager that enables you to |
create mail merges and import data into your StarWriter and StarCalc documents in a snap,
as well as filter and query Oracle, SQL, and other huge databases. And although Linux users
are generally delighted to have such a powerful suite, many among them have repeatedly 1
requested a native LaserJet driver instead of StarOffice’s default PostScript driver. Under

Windows 95/98 or Windows N'T, StarOffice uses the standard Windows printer drivers.
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Also, although StarOffice does a reasonably good job of importing documents, the
Import/Export functions can never be 100 percent perfect for all the more complex and
obscure features of Microsoft Office, for example. Microsoft constantly changes them to
prevent compatibility and to force upgrades. (From that perspective, StarOffice is often
more compatible with Microsoft Office than Microsoft Office is among its different ver-
sions.)

Despite these shortcomings, the bottom line is that if you’re looking for a single Office suite
that will run natively on most major platform and tie the entire company and all its divisions
together, this is the one. If you’re just looking for a great Office suite and don’t want to base
your operating system choice on what kind of applications you want to run, this is the one.
Also, the suite supports most, if not every, major language straight out of the box, so it’s per-
fect for a company dealing with international offices or for anyone who does business inter-
nationally (and StarOffice does run quite nicely on a laptop). And by the end of the day,
StarOffice is much more intuitive to use than its competitors, which is mainly due to the
fact that the tools you need aren’t hidden in out-of-the-way menus that you stumble on by
chance or luck.

StarOffice Versus Microsoft Office

StarOffice may emulate the look and feel of Microsoft Office and the Windows operating
system; looks, however, can be deceiving. The following is a list of advantages that
StarOffice has over the Microsoft Office suite:

= Low cost—StarOffice is significantly less expensive than Microsoft Office and provides
a meaningful alternative to Microsoft’s practice of increasing the cost of Office with
every new release while tightening the licensing restrictions every year.

= Easy migration—Using the new StarOffice Microsoft Import Wizard, Windows users
don’t have to be afraid of losing their valuable data and templates. StarOffice can con-
vert Microsoft Word, Excel, and PowerPoint documents and templates on-the-fly.

= Better stability—Even the Windows versions of StarOffice crash much less often than
Microsoft Office. On other platforms, crashes are extremely rare. Greater stability
means higher employee productivity.

= Better performance—StarOffice’s high performance means you do not have to
upgrade your computers to the level required for Microsoft Office 97 or Office 2000.
Better performance means higher productivity—for you and your employees.
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= Freedom of choice—You can use the best environment for your specific jobs yet main-
tain consistency. Microsoft Office is designed to prevent you from using non-Microsoft
products or even older versions of Microsoft products, even when they may better suit
your needs. StarOffice, by contrast, is available for Windows 95/98, Windows NT;
0S/2, Linux, and a few other UNIX dialects. Thus, no matter which operating system
you have, you can take advantage of its features.

» Java-enabled—The StarOffice Java client is compatible with the new component archi-
tectures and “thin clients,” including network computers (NCs). With StarOne (pro-
gramming API) and StarOffice Beans, you are ready for emerging low Total Cost of
Ownership (TCO) environments. Microsoft Office, by contrast, is still mired in the
monolithic programming practices of 1984—despite all the recent fanfare of an HTML
companion file format and Web collaboration features of Office 2000.
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Launching StarOffice for the First Time

Although the StarOffice installation process is very similar across platforms, how you launch
StarOffice varies slightly according to your platform, operating system, and setup.

m Whatever your platform, you are greeted with an opening screen that prompts you to regis-
ter the program, and to configure StarOffice for use with the Internet. For instructions on
registering, see Appendix A, “Installing StarOffice.” For instructions on stepping through the
Internet setup process, see “Getting Online,” p. 85. You may want to refer to “Getting
Online” before you launch the program, as stepping through the Internet wizard requires
you to have some information ready as well as make some decisions about how StarOffice
will handle your Internet chores.

Windows Users

Open the Start Menu and click the StarOffice 5.1 icon. Alternatively, open the Office51 or
StarOffice 5.1 folder and double-click the StarOffice 5.1 icon.

Your desktop will look similar to Figure 2.1.
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Linux Users

The steps for launching StarOffice vary depending on your system configuration. This
book assumes that you are launching StarOffice from within the X Window System, with
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StarOffice located in your usr directory. Note that you must be running X to launch
StarOffice.

There are two common ways to launch StarOffice. Follow these steps to launch StarOffice
directly from within the X Window prompt:

1. Make sure you are in your usr/0ffice51/bin directory. This is where the script for start-
ing StarOffice is installed in the default installation.

2. Type ./soffice at the X Window prompt. o
If you want to launch StarOffice as a background application to the xterm from which I
you are launching the program, add a space and an ampersand (&) afterwards, like this: Ch
. /soffice &. 2

3. Press Enter.

Most modern Linux distributions automatically launch your window manager when you
launch X. However, if your system is not configured in this way, you will need to launch
your window manager from within X before you launch StarOffice. To launch your window
manager (in this case, fvwm) first, and then launch StarOffice from the window manager
desktop, follow these steps:

1. Type fvwm at the X Window prompt.
2. Press Enter.

& 3 Double-click the StarOffice icon on your fvwm desktop; or, if you do not see a
StarOffice icon, open a new shell, navigate to your /usr/0ffice51/bin directory, type
. /soffice, and press Enter.

Note that it takes a minute or longer to launch StarOffice for the first time, as it runs
through its initialization protocol.

Your desktop will look similar to the Windows version desktop shown in Figure 2.1.
However, special to the Linux version, a Printer setup wizard is provided, which can be
launched by double-clicking its icon on the desktop. (Note that StarOffice supports only
PostScript printers on Linux; if you have a non-PostScript printer, you’ll need to use a
translation program like Ghostscript.)

m Throughout this book, all illustrations and examples for Linux are for StarOffice run in X

Window, using fvwm as the window manager, under the Red Hat implementation. For
more information, see Appendix A.

Don’t worry if the opening screen for your operating system doesn’t look exactly like the
one shown here. The look of your desktop depends on which edition of StarOffice you have
and how your system has been configured.
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New to version 5.1, you’re greeted by an Internet setup wizard that considerably simplifies
your setup process. If you currently use Netscape Communicator and/or MS Internet
Explorer and MS Outlook Express for email and browsing, you’ll have the option of just
importing your inbox and browser settings from your program of choice. You can also
choose to set StarOffice to handle any or all of your Internet chores by default (which
include Web browsing, email and news accounts, and FTP); or, you can continue to your
existing programs from within StarOffice. The wizard also prompts you to enter your basic
Internet account information.

While the wizard makes the process easy, there are some complex issues involved in choos-
ing one option over another. If you are already familiar with StarOffice and how it handles
Web browsing, mail, and news, you’re likely familiar with the issues already and can easily
follow the wizard. If you’re new to StarOffice, we recommend that you refer to “Getting
Online” in Chapter 3 before proceeding.

[] Getting online is covered in detail in “Getting Online,” p. 85. For more information on troubleshooting
installation and registration problems, see “Appendix A,” p. 1353.

If you choose to have another browser serve as your default, StarOffice will continue to
greet you on startup with a screen that asks if you want to set StarOffice as your default
browser. If this screen annoys you, uncheck the option Always Perform This Test at the Start
of StarOffice, and it won't display any more.

You will also be prompted with a dialog that reminds you that your program will expire in
30 days and asks if you want to register now. If you choose Yes, a wizard will step you
through the registration process. You can register online, by fax, or by mail. Your best
choice is to register online, as your registration is then handled by an automated process
which typically only takes a few minutes. If you’ve already completed the Internet wizard,
you’ll be all set to go. If you were unable to complete your Internet setup, you can defer
registering for now. It’s recommended that you print or fax your registration only if you will
not be connected to the Internet at all.

If you choose No, you will continue to be prompted to register every time you start
StarOffice. Note that if you don’t successfully register the program within the 30-day peri-
od, your installed version of the program will expire and you will need to re-install the pro-
gram from your CD or file.

m If you have problems opening the program and you installed it from an intranet or CD-
ROM, run the Setup program from the StarOffice directory on the hard drive. Windows
users should select Repair in the opening installation screen. Linux users should launch
setup from the usr/bin directory using the -repair option, like this: . /startup
-repair. If you downloaded StarOffice from the Internet and continue to have problems,
you might need to download another copy.
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What Happened to My Desktop?

For users who are familiar with other office suites, opening StarOffice for the first time can
be startling. The program does not open to a blank document, spreadsheet, or drawing
board, but to an integrated desktop that offers you a complete set of tools for creating and
managing your work.

Under Windows, when the integrated desktop is on (as it is when you initially launch the
program), StarOffice incorporates Windows menu items and elements of your Windows
system. If you click the Start menu, for example, you’ll see your familiar Windows Start
menu of program selections.

Under Linux, how StarOffice behaves depends on the window manager you use and selec-
tions you made during installation. In the implementation used in this book, the fvwm
menus are not incorporated into the StarOffice menus. They are hidden initially, but click-
ing the taskbar button that says fvwm makes the fvwm taskbar visible. Regardless of your
window manager, though, StarOffice behaves strangely for a UNIX/Linux program: It does
not allow you to drag windows outside of the StarOffice window. This is not a bug, it’s a
feature; it’s part of Star Division Inc.’s efforts to maintain interface consistency across plat-
forms.

m KDE menu integration is installed as an option by default. If KDE is already installed in your

system, your KDE menus will be integrated automatically during installation. If you install
KDE after installing StarOffice, you'll need to run the KDE setup separately from the
/usr/0ffice51/bin directory. CDE menu integration is available as an option with cus-
tom installation. For more information, see Appendix A.

Some of the StarOffice tools are standard—such as Cut, Copy, and Paste functions—but
others are unique to StarOffice. Understanding the desktop and its tools is the key to using
StarOffice effectively.

Not all these tools are visible at one time. What you see on your screen and menus changes
as you move between different kinds of tasks or select different kinds of objects on which to
work.

m In some Linux configurations, the StarOffice screen may be too large to fit on a single desk-

top. You will need to resize your window to match your screen resolution. This can be done
in the StarOffice desktop.

Regardless of your operating system, the StarOffice desktop is the control center of the
StarOffice workspace—the equivalent of the bridge on a starship. Everything you need in
StarOffice can be launched, opened, or located right here.

Part

Ch
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m If you find it disorienting that StarOffice takes over your desktop, you can turn off the
Integrated Desktop by clicking the Integrated Desktop command on the View menu
(Ctrl+Shift+1). (When you have documents open, this command is also available under a
different name, Desktop mode, on the Window menu.) StarOffice becomes a window on
your system desktop and can be resized, moved, and reduced to a taskbar button just like
any other window.

m The StarOffice online Help uses Desktop mode and Integrated Desktop interchangeably.
These are just different names for the same command (Ctrl+Shift+l).

Understanding the Desktop Workspace

On first launch, the program automatically creates a default StarOffice desktop. Under
Windows, this desktop incorporates the same program icons and documents as your
Windows desktop. Note also that icons on your Windows Start menu show up in the
StarOffice Start menu. Under Linu, if you have a desktop folder, it will incorporate this
folder; otherwise, it will use the StarOffice desktop (/usr/0ffice51/Desktop) as your default
desktop. It does not replicate your fvwm menus within itself.

Tip #1 from You can customize the Start menu by creating links to or copying items into the
Michae| & Sasah office51\config\start directory.

The incorporation of your usual desktop icons on your StarOffice desktop makes access to
other commonly used programs easy from within StarOffice.

Gaining access to these folders and programs is easy. If you double-click a folder, StarOffice
opens a window on the desktop that displays the folder’s contents. If you double-click a pro-
gram icon, it runs as a window on top of the StarOffice desktop. You can change the con-
tents of this desktop workspace and customize it in many ways. You can also select another
folder to be the default desktop, or you can have multiple desktops. However, you must
always have one designated default desktop. That desktop is always active while the program
is running. You can think of this desktop as the root desktop.

[ For information on customizing your desktop and creating and working with multiple desktops, see
“Managing Multiple Desktops,” p. 123.
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The contents of your desktop workspace change continually as you open and close docu-
ments and folders, and as each document or window you open is placed on top of your
desktop workspace in succession. You can have as many as 255 documents open at one time;
however, it is not recommended that you open this many because it slows your system per-
formance quite a bit—unless you have mega megabytes of RAM!

However, your default desktop is always there.

You'll also notice that there are two icons, an arrow and a stickpin, on the upper left border
of your window and on the upper border of the Help Agent at the bottom of your screen.
These icons are controls for floating desktop windows. (Look ahead to 2.3 to see them
identified.) Clicking the arrow hides or reveals the window—so if you want to clear your
desktop, click the arrow to hide the Help Agent. Clicking the stickpin “pins” the window to
the desktop. Otherwise, it floats on top and therefore may cover some of the desktop con-
tents.

Clicking the arrow on the upper left reveals (or hides) the Explorer, a key component of the
StarOffice desktop which is discussed in detail in “Using the Explorer and Beamer,” later in
this chapter.

Ch
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Orienting Yourself in StarSpace

Now that you’ve stepped into StarOffice, the first step is to look around and familiarize
yourself with the layout and basic functions of the desktop tools.

It’s a good idea to read this section in front of the open program so that you can explore as

you read along.

Elements of the StarOffice Desktop

Your desktop is made up of a number of elements. Figure 2.3 identifies some of these ele-
ments, each of which is discussed in more detail in this section.
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The title bar, which is shown in Figure 2.3, is displayed only if the Integrated Desktop
feature is turned off.
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The title bar lists the version name and number of StarOffice. If you have not yet registered

your program, the bar reads [not registered]. The title bar also lists the name of the cur-

rently active window on your desktop, as you can see in Figure 2.4. Figure 2.4 shows

StarOffice with an open StarWriter document and the Integrated Desktop turned off, which

means that the program control buttons (Minimize, Maximize/Restore, and Close) are visi-

ble in the upper-right corner. If the Integrated Desktop is turned on, you will not see these

buttons for the StarOffice program, only for tasks, and you must use the Control or File

menus to exit StarOffice. Part
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As you open new documents, they are automatically assigned the default titles of Untitledl,
Untitled2, and so on. This appears in the title bar until you first save a document, when
your assigned filename appears. If you later assign a title to the document using the File
menu Properties command, the title bar shows the assigned title rather than the filename.

You can manipulate your program and tasks windows in a variety of ways:

= In the right corner are buttons that enable you to control the size and location of the
StarOffice window, and close the program.

= Clicking the Maximize/Restore button causes your StarOffice window to either fill
your entire screen as a docked window (Maximize), or float as a window of the
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previously set size (Restore). When the program is in Restore mode and floats as a
window, you can move and resize the window with your mouse.

= 'To move the window, position your cursor on an empty spot anywhere on the desktop
and drag the window to the desired location.

= To resize the window, move your mouse to the borders of the window until your cursor
changes appearance to a double-headed black arrow. Then, drag the side or corner to
the desired size.

The program remembers only your most recent window size; therefore, as you resize
the StarOffice window throughout a work session, the Restore button automatically
adjusts to return you to the last window size you created.

» Clicking the Minimize button reduces StarOffice to a button on your operating system
desktop taskbar, and clicking the Close button closes StarOffice and returns you to your
operating system.

» In the left corner is an icon that represents the StarOffice program. Clicking it opens a
menu that offers the same commands as the buttons.

The Menu Bar

Just below the title bar is the main menu bar, which lists the titles of current desktop menus.
The commands that are available on these menus vary, depending on the type of document
or object you have open on your desktop. Some commands might be listed but grayed out,
which indicates that they’re not suitable for your task and are therefore temporarily unavail-

able.

When you have a window or document open on the desktop, the menu bar also displays
Maximize/Restore, Minimize, and Close buttons as it does with the title bar. These buttons
function in a similar manner, except that they affect open windows and documents rather
than the StarOffice program window as a whole.

TiP #2 from Your default desktop has no Maximize, Minimize, and Close buttons because the desktop is
Mickael & arah not a task, and can therefore never be closed or resized independently of the program
window.

The menus are logically organized to help you find commands quickly without memorizing
their locations. Some of the more frequently used menu commands are also assigned to but-
tons on the function and object bars and to program context menus, which open with a

right-click.

TiP #3 from To speed up your work, you can assign your own frequently used commands or macros to
Michael & Zarah buttons on toolbars. For more information about customizing toolbars, see Chapter 3,
“Getting Ready for Work.”
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"To open a menu, click its name or press the Alt key in combination with the underlined let-
ter in the menu name. To select a menu command, click it. Some commands also have key-
board shortcuts. These shortcuts are indicated to the right of the command.

1 For a list of the most commonly used keyboard shortcuts, see “Appendix E,” p. 1429.

The File Menu

The File menu, along with the desktop and Explorer (described later in this chapter), is the

. Part
launching pad for your most common work tasks.

On the File menu, you can open new documents of all types with the New command, create
documents with template wizards using AutoPilot, or open existing documents that are
saved to files with the Open command. The File menu also contains all the basic commands 2
for managing documents that you have open on your desktop, including saving, sending as

email, and printing.

Ch

The Edit Menu

The Edit menu contains commands for deleting, changing, and moving data, as well as for
inserting objects, images, and links. It also contains the very important Undo command
(Curl+Z), which undoes your regrets and mistakes up to 20 steps back.

TiP #4 from Change the default number of undo steps in the Tools, Options, General, Save dialog. You
Michael & Sarah can set undo to any number from 0-100.

The Address Book command opens a dialog box that speeds the process of entering and
finding contacts in your StarOffice Address Book database. The Address Book is a dBase 111
database that is fully integrated into the StarDesktop and helps automate common office
tasks, such as creating form letters and mass emails.

] For an introduction to working with the Address Book, including tips on importing an existing Address
Book into StarOffice, see “Introducing the Address Book,” p. 180.

If you alter the structure of the program’s Address database, this dialog box no longer
works with the address book.

[] For a complete visual presentation of the various StarOffice menus and submenus, see “Appendix D,”
p. 1413.

The View Menu

The View menu enables you to turn on and off the display of the Explorer, Beamer, and
toolbars. You can also switch between a full screen view (which gives you an uncluttered
desktop with no visible menus or toolbars) and a normal desktop view, and you can turn the
Integrated Desktop on and off.
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The Tools Menu

The Tools menu contains commands for customizing the applications and tools on your
desktop. The Macro and Configure commands enable you to create and edit macros and to
associate macros and StarBasic modules with program elements. The Options command
opens a master dialog box. On the left is a list of program functions and modules. Click the
+ sign to open a list of dialog boxes that enable you to set options related to the function or
module. Click on a dialog box name to make the dialog box appear. Some of the options you
can modify include your StarOffice Internet and browser settings, your default workspace
look and feel, and defaults for your StarOffice module work environments.

[l For in-depth information about configuring your desktop and document defaults, see Chapter 3,
p. 75.

I For more information about working with macros in StarOffice, see Chapter 37, p. 1239.

The Window Menu

The Window menu contains basic commands for managing your desktop windows, as well
as a dynamic list of currently open windows. One way to place a currently hidden, open
window on top of the desktop is to click its name on this list. The window that is currently
on top is identified with a bullet character.

The Help Menu

The Help menu contains commands that enable you to turn the Help Agent and help tips
on and off, and to open the User’s Guide. It also contains three other very important com-
mands:

= Registration—Enables you to register your StarOffice program (see Figure 2.5)

= StarChannels—Takes you to the area of the StarDivision Web site where you can
download program patches and updates

= About StarOffice—Contains information about the version of StarOffice you are
running

If you change key parts of your user data, you must re-register the program or it will expire.
See Appendix A for more information.

Exploring Desktop Toolbars

StarOffice also makes many commands immediately visible as tools on the toolbars that bor-
der your desktop. Some of these tools are shortcuts to commands that are found on the
menus, but others are only found on the toolbars.



Figure 2.5
Choosing Registration
from the Help menu
launches a wizard to
guide you through
the registration
process. After you've
successfully regis-
tered, the Registration
command is grayed
out.
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Tools are activated with a single-click. All toolbars can be made into floating toolbars by
pressing Ctrl while double-clicking in an empty area of the toolbar. To reattach a toolbar,
press Ctrl and double-click again in the same area. You can also press Ctrl and drag the
toolbar toward the edge of the desktop at which you want to dock it. As you approach the
desktop edge, the toolbar previews its docked size and shape in outline form. When you
release the mouse button, it automatically attaches.

If you want to learn the names of tools, turn on Tips in the Help menu. When you move

your mouse pointer over a tool, a tip pops up with its name. You can also right-click in any
toolbar to open a toobar context menu. In turn, you can open a submenu that matches all
the toolbar icons to their names.

The Main Toolbar

The Main toolbar appears only when you have an open document on top of your desktop.
This toolbar appears by default at the left of the workspace. Its contents change, depending

on what you’re working on, because each document type has its own tools.

Tip #5 from
Michael & Farah

An extended-click on main toolbar buttons with a small green arrow on them opens tear-

off floating toolbars that you can drag anywhere on your desktop.
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There are also three general desktop toolbars that are always available:

= Function bar
m Object bar
= Hyperlink bar

The Function Bar

By default, the function bar is always visible on program startup. To turn the function bar
off or on, click the View, Toolbars, Function bar command (see Figure 2.6). When the bar is
turned on, a check mark appears to the left of its name.

Help Agent
File command buttons Navigator
Stop Loading File Explorer
Bookmarks Forward Undo

Figure 26 [Tt/ ebvatficeSt template persanal e+ R BHAEGFBE==ME P @]

The function bar I ] )
opens key program URL Locator Back Online
tools and World Wide Other Browser buttons - Stylist

Web pages on your
desktop.

Edit command buttons

Redo

— Beamer

The function bar is the one toolbar with tools that remain constant across tasks and appli-

cations. Generally speaking, the function bar contains three types of commands:

s Commands that turn on and off the display of critical desktop components such as
Explorer, Beamer, Help Agent, and Navigator

= Common editing and file commands such as saving, opening, printing, and sending

email

= Browser functions that enable you to browse the Web from your desktop, including a
URL Locator and Forward and Back buttons that enable you to scroll through recently
opened documents, Web pages, and windows

m URL stands for uniform resource locator, and usually refers to a World Wide Web address.
To visit a Web site, you need to know its URL, just as you need to know a store’s street
address. StarOffice uses URL more broadly to refer to any address on a computer, includ-

ing local path names.
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Tip #6 from

X For a detailed glossary of Internet terms, search in the Help Agent or the online Contents
Michael & Sarah

Index for Terminology Descriptions: Internet Glossary.

Tip #7 from If you've reduced StarOffice to a window, you might not have enough room to display all
Michael & Farah the function bar tools at one time. If this happens, a double arrow appears on the far right
of the function bar (as in Figure 2.7). Click the black arrow head to make the missing part Part
of the bar visible. |
Ch
Flgure 2.7 [ Fe7rarsiecsinemeissiesonaomiter = @ 9 ol SH=8]4 B[0P Ell 2

Reducing StarOffice
to a window on your
desktop reduces the
visibility of tools, but
they're still there.
Here, clicking the
arrow head on the
function bar’s double
arrow reveals hidden
tools, including the
Explorer and Beamer.

The URL Locator, Web Browsing, and Local Drives

The URL Locator is the most visible sign of StarOffice’s integration, not only with your
operating system desktop, but also with the wider world of computers beyond your desktop.
After you’ve configured StarOffice for Internet access, surfing the Web is as simple as typ-
ing a Web address in the locator and pressing Enter.

[l For information about setting up your Internet account from within StarOffice, see “Getting Online,”
p. 85.
However, the URL Locator is more than a Web browsing tool. StarOffice treats your local
drives as part of an Internet or intranet network. It therefore refers to both local pathnames
and Internet addresses (including FTP, Web, and email addresses) as URLs, and enables
you to search for both using the URL Locator. The syntax for entering a local path is

file:///c,/[foldername]/[filename]
For example, if you want to open a file on your desktop called fundraising, which is locat-

ed on your C: drive in a folder called volunteer, you type the following in the URL
Locator, and then press Enter:

file:///c}|/volunteer/fundraising
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Tip #8 from
Michael & Sarah

The symbol that is used to separate the ¢ from volunteer in this example is called a pipe,
and it looks similar to a colon. Its location on keyboards varies, but it is usually on a key
near the edge of the standard keyboard, and often on the same key as the backslash
symbol.

The Object Bar

The object bar is also visible, by default, on startup. To turn it off and on, click the Toolbars,
Object bar command on the View menu. When the bar is turned on, a check mark appears
to the left of its menu name.

In general, the object bar contains commands that enable you to change and manipulate the
object that is currently open on your desktop. The contents of the object bar vary a great
deal depending on your current task. Figure 2.8 shows the desktop object bar, which you use
to move around in directories, view files, and view and change file and folder properties.

Icon view=] rPreview on/off
Details view- -File description on/off
Directory navigation- File extensions on/off — Multiple Search on/off
Properties— - Window layout buttons Desktop
Fiagure 2.8 Fie| £at Yo Indnt Ffmat [foos| Daa lgmnw Teb - ZI5Tx]|
The deskop obect |1 Pl s alani2b-8 | mEoy ]
B[ Emi

bar has tools for
browsing in your
directories, preview-
ing document con-
tents, and viewing
properties of desktop
objects. Although
you can preview only
graphics files in the
Beamer, you can pre-
view all types of doc-
uments in the
desktop Preview
pane. This is a pre-
view of a spread-
sheet sample
document.

TS~

Biorhythm Calculation
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Preview window  To resize panes, grab
this border and drag
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However, when a document is open, the object bar contains formatting tools that can
change the look and layout of your text. When a spreadsheet is open, the object bar contains
a formula entry box, the AutoSum tool, and the Sheet Navigation box.

This book follows StarOffice’s own logic and discusses the object bar for each program

module in the context of introducing program modules and explaining how to execute spe-

cific tasks. Therefore, this section introduces only the desktop object bar as it appears when

you have a folder open on your desktop. The desktop object bar enables you to carry out Part
basic desktop management tasks: I

On the far left (refer to Figure 2.8) is the Properties button, which opens the Properties
dialog box for the selected object. Next are the Up One Directory button, for browsing,
and the Originals button, which can help you locate the original source file of a link. P

Ch

The next buttons, Icon Display and Details Display, change the display of objects on
your desktop. Their neighbors to the right turn on or off document previews and dis-
play of document properties, respectively. When document previews and document
properties are turned on, additional window panes open on your desktop; you can resize
these panes by grabbing their borders and dragging.

"To show file extensions when you are displaying objects as icons, click the button with
an asterisk. This button is grayed out when list display is turned on because file exten-
sions automatically display in List view.

The next four buttons change the arrangement of your desktop’s frames when you have
document preview or document properties turned on.

The last button on the right turns the Multiple Search feature on and off. Searching in
StarOffice is described in detail in Chapter 5, “Managing Folders, Files, and Mail.”

The Hyperlink Bar

The hyperlink bar is not visible at startup. To turn it on and off, click View, Toolbars,
Hyperlink bar (see Figure 2.9).

create and keep track
of hyperlinks, which
are used in preparing
documents that are
to be used as Web

Figure 2.9 | — C T T0 0 R
The hyperlink bar can | | l

be turned on in any Text phrase Internet URL  Target Frame - Search
document, it helps hyperlinked to Hyperlink— Link (Bookmark)

that URL
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The hyperlink bar contains tools for quickly creating and navigating among hyperlinks in
documents. Highlight text in your document, and type a URL in the URL Locator; your
text is now hyperlinked to that address. If you press Enter, you instantly see the Web page
on your desktop. The drop-down list on the left of the URL Locator lists the phrase that
you've highlighted so that you can both keep track of the sites that are associated with your
hyperlink words or phrases and jump around your document hyperlinks by clicking them on

the list.

You can also drag and drop URLs from the URL Locator into your documents to create
hyperlinks. (After dropping, you must press the spacebar or Enter before it will become a
hyperlink.) You can also create bookmarks to Web sites or local paths by clicking the
Bookmark tool. A bookmark for the URL displayed in the hyperlink bar is automatically
created in the Explorer Bookmarks folder.

[] For more information about using the hyperlink bar when you are creating Web documents, see Part VI,
“Spreading the Word—StarOffice on the Web and at Work,” p. 917.

m Despite sharing its name with the Hyperlink toolbar Bookmark tool, the function bar
Bookmark tool does not automatically create a bookmark. Instead, it enables you to drag
and drop URLs into the Bookmarks folder or an open document.

Clicking the Binoculars icon on the end opens a list of all the Web search engines that are
specified in the Tools, Options, Internet, Search tab; with a quick click, you can be sleuthing
on the Web. On the bottom of the menu, click the Address Book or Bookmark name to
drop a URL into the Address Book URL field or to create a new bookmark.

[l For information on changing the default menu list of search engines, see “Getting Online,” p. 85.

m To get on the Web, you must first be connected to the Internet through a network or a dial-
up connection.

Using the Mouse on the Desktop

Although many commands and tools are available through toolbars and the main menus,
StarOffice makes maximum use of the mouse to put commands at your fingertips and make
working intuitive.

Clicks, Double-Clicks, and Extended-Clicks

Highlighting, selecting, dragging, and dropping all use mouse clicks and double-clicks in
ways you're surely familiar with from other Windows or X Window programs. However,
some functions in StarOffice are activated with the less familiar extended-click.
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An extended-click is a single, long click with the left mouse button. A tool with extended-
click response usually responds to a regular click as well—but it executes a different com-
mand.

Tip #9 from If you have trouble getting extended-clicks to work, try changing your mouse click speed.
Mickael & Sarah

For example, a click on the desktop function bar Back button takes you back to the docu- Part
ment or Web page you previously opened from the URL Locator. However, an extended- |
click opens a submenu with a history list of the most recently entered filenames and URLs.

Ch
Just click a path or URL in this list to return to the selected location.

The simplest way to learn where extended-clicks apply is to explore the desktop when Help,
Extended Tips is turned on.

Dragging and Dropping
Often, the most efficient way to work in StarOffice is to drag and drop with your mouse.
Not only can you copy and move data and objects this way, but you can also create links,
insert objects, and insert data from databases into documents. Drag and drop works between
documents as well as among documents, the Beamer, and the Explorer.

1 For more information on the Beamer and Explorer, see “Using the Explorer and Beamer,” p. 43.

Some of the many ways in which you can use drag and drop are summarized in Table 2.1.

Table 2.1 Selected Drag-and-Drop Functions in StarOffice

Do this... And the result is...

Drag file, folder, link, or email Moves the selected object to the new location.
from one Explorer location to

another.

Ctrl+drag file, folder, link, or Copies the selected object to the selected location.
email from one Explorer location

to another.

Ctrl+Shift+drag file, folder, link, Creates a link between the object and the selected
or email from one Explorer location location.

to another.

Drag file or link from the Explorer Creates a copy of the file or link into the current
into the desktop. desktop directory and opens it on the desktop.
Drag text, spreadsheet, HTML Creates a link to the file.

document, or Web page file from
the Beamer into an open document.

continues
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Table 2.1
Do this...

Continued

And the result is...

Drag a graphic or presentation
filename from the Beamer into an
open document.

Opens an Insert Slide, Objects dialog box. Objects you
select are inserted as copies into the open document.

Drag an image file or formula from
the Beamer into an open document or
other desktop task window.

Opens the image file in StarImage or formula in
StarMath.

Ctrl+Shift+drag an image file,
presentation, or formula from the
Beamer into an open document.

Creates a hyperlink or link to that object.

Drag a Gallery image, sound, or
graphic from the Beamer into an
open document.

Inserts a copy of the object into the open document.

Drag a URL address from the URL
Locator into an open document.

Creates a hyperlink (an Internet address) or link
(a local path) to that address.

Drag and drop an email account from
the Explorer or an open task window
into the desktop.

Opens your Inbox in a task window.

Drag and drop an entry from the
Address Book into an open document.

Copies the data to the new location.

Drag or Ctrl+drag a table from
one database to another.

Opens a Copy Table dialog box that enables you to
copy the table definition and data or definition only,
or to append the table.

The varieties of drag and drop are so great that the best way to learn is to try things and see
what happens. If something unexpected happens, immediately invoke the Undo command
(Ctrl+Z). The shape of the pointer also often gives it away—when you drag and see only a
gray outline, the object is moved; when you see a gray outline with a plus (+) sign, the object
is copied; and a gray outline with an arrow shows that a link will be created.

Tip #10 from
Michael & Farah

Generally, drag-and-drop functions in StarOffice work the same as in the Windows Explorer.

If you want to know exactly what has happened after you've dragged and dropped some-
thing, open the Edit menu and look at the Undo command, which specifies the action.

Tip #11 from
Michael & Farah

button away.

Want to see two tasks side by side? Combine them into one task window by dragging and
dropping one task button on top of the other. To separate them again, drag the top Task
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Although you can drag and drop between StarOffice and other applications, sometimes
parts of the data or the object are missing, or system crashes occur. If you have problems,
try opening your non-StarOffice files in StarOffice, dragging and dropping within StarOffice,
and then reopening them in other applications as necessary.

Right-clicks and Context Menus

Par
Context menus contain most of the commands that are essential for managing your desktop. Ia |
If you can’t figure out how to do something in StarOffice, usually the best way to find out is
to position your pointer where you want to be or to highlight the object with which you Ch
want to work, and then open the context menu by right-clicking. 2

Context menu commands are discussed throughout the book with the objects and tasks to
which they are related. Check the Index to locate the discussion of a specific command. Also
see Appendix D, “Default Keyboard Shortcuts,” for illustrations of all the program context
menus. Explorer context menus, which are crucial for creating and managing desktop
objects (including StarBase databases), are discussed in the next section.

Using the Explorer and Beamer

If your desktop is like the bridge of a spaceship, the Explorer is similar to the captain’s chair,
the seat from which you direct the operations, survey your universe, and begin new projects.
The Beamer is your second mate—your assistant in carrying out a variety of important
tasks. Although the program does not launch with the Explorer and Beamer visible on your
desktop, they are integral parts of working in StarOffice. (The Explorer is open, but hidden
on the left side.) You will probably frequently work with one or both of them open all the
time.

Table 2.2 shows the various objects that you can find in the Explorer and briefly describes
their function. Each is described in more detail later in this chapter.

Table 2.2 Default Explorer Objects

Explorer Icon Object Name and Function
8 Address book The Address Book is a StarBase database you use as a contact
manager.

B workplace The Workplace displays your system’s drives or volumes and

directories. It also appears as a group.

[0 Work Folde The Workfolder is either a link to your system work folder or

the Workfolder in the Office51/Explorer directory. It also
appears as a group.

continues
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Table 2.2 Continued

Explorer Icon

Object Name and Function

Samplez

The Samples folder contains subfolders and files with sample
databases, drawings, formulas, presentations, spreadsheets, and
text documents.

E#] Bookmarks

The Bookmark folder contains hyperlinks to Internet sites. It
also appears as a group.

The Gallery contains clip art and sounds that you can insert in
your documents.

=

Fecycle Bin [15

The Recycle Bin stores files deleted from within StarOffice
until you empty it.

StarSchedule

i

StarSchedule is your personal appointment planner and
calendar within StarOffice.

@ Help

Help contains links to sections of the online Help system, and a
Help bookmarks folder so you can create your own links as you
go along.

Table 2.3 shows the various objects you create and store in the Explorer via the Explorer
context menu. These objects enable you to connect with external data sources like Internet

accounts and databases.

Table 2.3 Objects Created in the Explorer

Icon

Name and Function

A POP3 mail account Inbox downloads email from POP3
servers.

An IMAP mail account Inbox downloads email from IMAP
servers.

A VIM account downloads email from VIM intranet mail
systems.

Your Outbox stores all sent and unsent emails.

A news account enables you to subscribe to and read Usenet
news groups.

An FTP account enables file exchange via the Internet.

A Link enables you to jump to the folder or file you designate
as its target from the Explorer.

EiEIZCRERENER:

A starBase database enables you to connect to external
sources of data or to create your own dBasellIl and StarBase-
format databases.
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Icon Name and Function

A search folder enables you to bring distant files and folders
to your StarOffice desktop.

A Web subscription enables you to receive messages when
the contents of Web pages you designate change.

[ERET| The Templates folder contains StarOffice templates and any Part
you create with the AutoPilot I

. . . Ch
The Explorer has been improved since version 5.0 and has a number of new features, most

visibly, the capability to create groups that enable you to better organize your desktop. To 24
recognize its new features, it’s now called the extended Explorer. You now also can choose to

display files in the Explorer (whereas in version 3, files displayed only in the Beamer) by

selecting the Display Documents command on the Group context menu.

In addition, you can choose to display objects in the Explorer in one of three views:
Hierarchical, Small Symbols, or Large Symbols. Objects in groups respond differently to
your mouse actions when a group is set to Hierarchical view versus the two symbols view;
some special functions are available only when a group is set to Hierarchical view. This sec-
tion therefore focuses on discussing using the extended Explorer in Hierarchical view.

[] For more information on the effects of choosing different views of groups, see “Working with Groups in
the Explorer,” p. 49.

m To set the Explorer to hierarchical view, right-click the Explorer group title button and
choose Hierarchical View from the context menu.

In the Hierarchical view, double-clicking an object in the Explorer opens it on your desktop.
Clicking the plus sign to the left of an Explorer object shows you the contents of its subdi-
rectories. If you open the Workplace icon at the bottom, you’ll see a branching list of all
your volumes and drives.

When your group is set to display on Hierarchical view, the Beamer displays the contents of
most types of Explorer objects when you select and extended-click them. Displaying files in
the Beamer gives you access to special drag-and-drop features. For example, when the
Address Book is open in the Beamer, you can drag and drop Address Book entries or merge
fields into an open document. Likewise, you can show the contents of any folder in the
Explorer in the Beamer, double-click the files in the Beamer to open them, and drag and
drop the contents of the Gallery theme into an open document.

m For the contents of an object to display, the Beamer must first be open before you
extended-click the object in the Explorer.
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Tip #12 from
Mickae! & Garah

Display one folder’s contents on your desktop and another in the Beamer, and you can
easily copy files and create links with drag and drop.

The Explorer is your usual starting point for creating what you might think of as new inter-
face objects—that is, objects that enable you to connect with and perhaps (if you choose)
store some outside source of data and information. These include links to other directories,
email account Inboxes, your email and news Outbox, StarBase databases (which are most
frequently used to import data from external sources), and FTP accounts. (The Tasks group,
StarOffice desktop, and File, New menu, on the other hand, are where you are more likely
to start new tasks and documents.)

Manipulating the Explorer and Beamer Windows

When you first launch StarOffice 5.1, the Explorer is open but hidden on your desktop.
Click the gray arrow on the left edge of your desktop to reveal it.

If the Explorer is off, you can open it by clicking its icon on the function bar, pressing
Ctrl+Shift+E, or selecting Explorer from the View menu. Open the Beamer by clicking its
icon on the function bar (to the right of the Explorer icon), pressing Ctrl+Shift+B, or select-
ing Beamer from the View menu. Your desktop will look similar to Figure 2.10.

Figure 2.10 Fle Edt View Tools Window Help
Open Explorer h|fI\E://fc\/wmduwsfdesktop/or\lmeselwces! - a 9 7 | 43 ‘ = b = §| i ‘
g'rr)ugs b)I{] Cl'gkln? the I%q Jump =] URL: [ritpre e jumnp.com/ |
tlte art at |Sp ays WindowsDesktop ||
— % ot (Tt = IR = &
the Group name. In % E A ‘ ’_ﬂ G = ﬁ| e
the default chetProorans || : & = I@
Hierarchical layout, bout The Drlre Ao oo "l Compusene
! Services Dpen
open Explorer objects Exploes Pt TP
by double-clicking 29 B
them. You can select HyBielease N
: i i oy Create Link
and right-click objects et o
to open a context Netfeape Commricator -
menu for managing £ e
them (either Netbeape Profile Man. ?d:[:
unopened in the Sustem propettes
Explorer, or opened Diine Services Propsilios
on your desktop, as @]
seen here). Snaglt/32 43
) StarDffice 5.0
Click here to
open group. Starllffices.1
[\ @]
Jobei
Right-click to open |
Tasks
context menu. e
‘work Folder
Explorer 11 of 4 obiects selected (3 KB of 4 KB, 559,136 KB free)
@5t | &5 [yonine sena.. | EFMicrosot . | agmbnagliv/az




Using the Explorer and Beamer | 47

The Explorer and Beamer are both dockable floating windows. They open initially in a
floating, docked state.

To fix them to your desktop, click the Stickpin icon. They will then automatically fit neatly
beside your desktop workspace rather than floating over your open tasks.

Just as with the Explorer, you can alternately hide and reveal the Beamer by clicking the
small arrow on its border.

Part
To resize the Explorer, drag its right border; to resize the Beamer, drag its bottom border. I
"To undock a floating window, press Ctrl and double-click a blank area inside the window. e
To dock a window again, press Ctrl while dragging the window by its title bar toward the D

edge of the desktop where you want to dock it. As you approach the edge, the outline of the
window will change to preview its docked shape. When you see the outline, release the
mouse button.

More information about working with dockable floating windows is given in the section
“Other Floating and Dockable Windows” later in this chapter.

Explorer Context Menus

From the Explorer, you can search for files and folders, move between StarOffice and your
locally available drives, and manage objects with drag-and-drop features. Most importantly,
you can create and manage most types of StarOffice objects—including databases, news,
FTP and email accounts, folders, and links—using commands on the Explorer context
menus. You can open a context menu by either right-clicking in a blank area or selecting an
object and right-clicking. The commands that appear depend, to some extent, on the type of
object (if any) you've selected, although some commands are common across object types.
Figure 2.11 shows the context menu that opens when no objects are selected.

To create a new object, place your cursor in a blank area of the Explorer (or select the folder
that you want the object to be placed in), right-click, and choose the New command. You’ll
see the submenu that appears in Figure 2.11.

To change an existing object’s name or set rules on when and how it updates and displays on
your desktop, select it and choose the Properties command.

Table 2.4 lists the Context menu commands that are specific to file management and desk-
top tasks. These commands appear for folders and links and may be found on the menus of
other types of objects as well. Note that special StarOffice objects such as the Recycle Bin,
Gallery, and Help have a different and limited set of context menu commands that relate to
their special functions.

m The commands that appear also depend on the plug-ins that you have installed on your
system.
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Table 2.4 Basic Desktop

Name of Command

Context Menu Commands

Purpose

Open Opens object’s contents on your desktop.

Find Constructs on-the-fly Boolean searches that can look anywhere on
your system or network to retrieve objects to your desktop. (This
command was called Search in version 5.0).

New Creates new objects, including documents of all types (repeating
the File, New commands), saved searches, and Internet newsgroup
subscriptions.

Cut Deletes object from Explorer and places it in general-purpose
buffer or on the Clipboard.

Copy Copies object into general-purpose buffer or Clipboard.

Create Link Creates a link to the selected object (the target). The link can be
cut and pasted or dragged and dropped elsewhere, or left in the
Explorer.

Show Sets how objects display in the Explorer.

Desktop Designates a chosen location or folder as a desktop, or returns the
object to ordinary status.

Update Updates the contents of the selected object (if the Include in
Update option of its Properties, Contents tab has been selected).

Synchronize Synchronizes data in the cache with data on your local server (for

use on networks).
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Name of Command Purpose
Send To Sends active document as email or fax; directs file or folder to disk
drive.
System Properties Displays basic properties of the selected object, including folder
name, location on your system, and folder or file attributes.
Properties Displays and enables you to change a broad range of properties of
the selected object (including some that appear in System Properties
dialog box). Part
[ For a thorough discussion of the context menu Search, Show, Update, and Properties commands for ch
folder and file management, see Chapter 5, “Managing Files, Folders, and Mail,” p. 191.
[0 For instructions for setting up email accounts in the Explorer, see “Creating Mailboxes,” p. 96. 2

I For a discussion of the context menu Desktop command, see “Managing Multiple Desktops,” p. 123.

Working with Groups in the Explorer

New in 5.1 is the capability to create groups in the Explorer. In previous versions, the
Explorer could get cluttered very quickly, especially if you clicked the Workplace icon to
open your drives and volumes to manage your entire network or drive structure. By desig-
nating folders or drives that you frequently access as groups, you can easily open them with
the click of a button while bringing into view only those objects you need at the moment.

The following groups are created automatically for you at first program launch:
» Tasks group, which repeats the selections of new tasks you can create with the File,
New menu
= Workfolder group, whose contents will depend on your system configuration

= Email and News group that contains either new, empty StarOffice email inbox and
news accounts, or your imported inbox and news accounts from another program

= Bookmarks folder, which contains either StarOffice default bookmarks or your book-
marks imported from another program

The best way to manage your work in StarOffice is to create a group in the Explorer for
each of your current projects. Then, you can store all the documents and templates you
need for a project in one place (whether as originals, copies, or links) and always have
instant access.

Tip #13 from If you need to pull together documents from disparate locations to use in a project, create

Michael & Zarah a saved search in the Explorer. A saved search enables you to create rules that search any
volumes, drives, or directories you specify and retrieve items based on criteria you set. For
more information on creating saved searches, see “Retrieving Distant Files and Folders,” in
Chapter 5.
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Note that while you can technically create a group with special Explorer objects, such as the
Gallery, and the Recycle Bin, they won’t display any individual files in their group window.
You can display the objects’ contents only from the Explorer group.

Creating and Naming New Groups

To create a new group, right-click the New Group button at the top of the Explorer. You
have two choices: to create a new group as a (blank) folder, or to create a new group as a
link to an existing folder. You can link to folders anywhere on your system.

If you select Add Group as Folder, a new group immediately appears with the default name
of New Group.

If you select Add Group as Link, a two-tabbed dialog box opens. If you already know the
exact pathname of the folder for which you want to create a link (which is called the targer
folder), enter it in the text input box on the General tab. If you don’t know the exact path-
name, skip the General tab and go right to the Bookmark tab. Click Directory, which opens
a file browsing dialog box. Navigate to the location of the folder, click it to enter its name in
the text input box, and click Select. Next, enter the Group name in the Name text box. That
name automatically fills in the General tab name box also. Click OK, and your group, with
all its objects, now appears in the Explorer.

Tip #14 from A shortcut for creating a new group as a link is to drag and drop an existing folder onto the
Michael & Sarah New Group button.

To change a group’s name, right-click its title bar and choose the Rename Group command.
Its name on the Group button will become highlighted; type in your new name. Renaming a
linked folder has no effect on the name of the source folder; it affects only the name you see
in your Explorer display. You can also rename a group by choosing Properties from the con-
text menu and entering a new name on the General tab.

m Although your group may be only a link to a folder, the objects inside the target folder are
only links if you originally created them as links. If you delete them, you're deleting them
from the source, not just from the Explorer display. If you find that you've accidentally
deleted something in this way, open the Recycle Bin on your desktop and use the context
menu Restore command.

Rearranging the Order of Groups

"To rearrange the order of groups, grab a group’s button and drag it to its new location.

Removing Groups

"To remove a group, open the group context menu. Depending on whether your group is an
actual folder in the Explorer or only a link to a folder stored elsewhere, you will see either
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Remove Group or Remove Link to Group. If your group is a folder in the Explorer and you
choose Remove Group, everything in the group will be deleted. If your group is a link only,
deleting the group deletes the link only and has no effect on the target folder.

Changing a Group’s Source Folder

If you have created a group as a link, you can change the group’s target folder by choosing
the Properties command from the group context menu, and assigning a new target URL (in

other words, pathname). l;art
Changing Your Explorer Layout Ch
New to version 5.1, you can change the layout of objects in the Explorer by right-clicking 2

the group name to open its context menu. You have three choices of how to display objects:
Large Symbols, Small Symbols, and Hierarchical. “Symbols” are more typically called icons.
The Hierarchical view is the default Explorer view in which folders and drives are displayed
in a branching, hierarchical structure.

Your choice affects not only the objects’ appearance but also how you launch programs and
open objects. In Hierarchical view, a single-click opens the subdirectories on a folder or
drive and a double-click opens a folder on your desktop or launches a program. In the Large
Symbols and Small Symbols views, a single-click opens an object or launches a program.
Also, in Hierarchical view only, you can choose to display the contents of folders in the
Explorer by choosing the command Display Contents on the group context menu. You can
also only display contents of folders and other objects in the Beamer when your group is set
to Hierarchical view. (In fact, so many of StarOffice’s special desktop management features
are available only in Hierarchical view that it doesn’t make much sense to set the Explorer
group to anything else.)

Figure 2.12 shows the Group context menu and the open Tasks group in Large Symbols dis-
play.

Databases and the Explorer

In version 5.0, databases could only be created from the Explorer context menu Users
found that too confusing, so version 5.1 includes the new database command on the File,
New menu. However, a database is still fundamentally different kind of object than a docu-
ment—it’s more like a folder, as it is a container for a number of database objects—and you
therefore still work with it in the Explorer. After you have created a new database, you can
create tables and other database elements using File, AutoPilot; or you can import database
objects from external sources. For more information, see Part VII, “Working with
Databases—StarBase.”

Default Explorer Contents

You should investigate the Explorer because it comes with a number of files, folders, and
objects that can make your work easier; furthermore, it reveals some of StarOffice’s talents
and gives you a head start on creating your own projects.
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The Address Book

The Address Book is a searchable dBase III StarBase database for use as a contact manager.
It’s fully integrated into the desktop, and is available from many text document templates
and AutoPilot wizards.

From within text, HTML, and mail document context menus, if you select a person’s name
and click the Who Is? command, StarOffice immediately pulls up his or her address on
your desktop. You can then select the contact information to insert. By selecting a contact’s
name or other information and choosing AutoBrowse, you can bring up a contact’s Web
site on your desktop while you’re working. You also use the Address Book (or another data
table of your choice) to create mail merge form letters and emailings.

For information on creating form letters and document mail merges, see “Creating Form Letters with
Mail Merge,” p. 360.

For more information on creating mass emailings, see “Creating Mail Merges with StarMail,” p. 1062.

The easiest way to add, edit, and locate entries is with the dialog box that is opened with
the Address Book command on the Edit menu (shown in Figure 2.13). This dialog box has
been considerably improved over version 5.0, and an annoying bug that reversed the coun-
try and state fields has been fixed, making the address book fully functional for U.S. users.

For general discussion of using the Address Book and information on importing contact databases from
other applications, see “Introducing the Address Book,” p. 180.
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To ensure that no one accidentally deletes the Address Book, it is protected. If you try to
delete it, an error message appears, denying your access to the folder in which it is stored.

If the Beamer is open, pressing F4 opens the Address Book in Table view in the Beamer,
where you can also view and edit entries or drag and drop addresses into open documents
(see Figure 2.13). Version 5.1 has a new Lookup Record button on the Beamer toolbar that

Figure 2.13
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The Bookmarks Folder

The Explorer Bookmarks folder is designed to be your site for storing bookmarks in
StarOffice. If you’re a Windows user who had MS Internet Explorer installed when you
installed StarOffice, this folder is a link that was automatically created to your Internet
Explorer Bookmarks folder. If you are a Linux user or a Windows user without MS
Internet Explorer, your Explorer Bookmarks folder will be the StarOffice
Office5S1\Bookmarks folder. If you’re an MS Internet Explorer user, you can create a link to
the StarOffice Bookmarks folder in the Explorer, if you’d like access to this collection of
preset bookmarks, or you can copy any that interest you to your Bookmarks folder in the

Explorer.

Besides appearing in the Explorer, your default bookmarks folder also has its own
Bookmarks group.
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The StarOffice Bookmarks folder contains shortcuts to useful Web sites and links to locally
stored StarOffice documents that contain information about its StarOne programming envi-
ronment. It also contains shortcuts to the Java RunTime console and monitor, and to Web
sites that discuss using the Java programming language

The Bookmark tool on the hyperlink bar automatically drops the currently displayed hyper-
link bar URL into this folder, making it the easiest place to create new bookmarks while
browsing. However, you don’t have to stick with the default assigned Bookmarks folder. It’s
easy to set another folder as your default through Tools, Options, Path dialog box. The
name of the entry is Bookmarks; click Edit to edit the path. The folder that you choose will
then appear in the Explorer.

m If you delete or move the Bookmarks folder, the Hyperlink toolbar shortcut tool no longer
works.

These shortcuts are just like any other links or bookmarks that are created in the program;
they can be moved, copied, and deleted. You can also add your own bookmarks to existing
folders or create your own bookmark subfolders.

In version 5.0, there was a bug that prevented you from renaming a bookmark without los-
ing the link. In version 5.1, you can rename bookmarks without problem.

m Bookmarks, links, and shortcuts are essentially the same kind of object. Each is a type of

reference to a file that enables you to jump to the file’s location or open the file when you
click the bookmark, link, or shortcut.

The Gallery

The Gallery is filled with cool photos, bitmaps, drawings, sounds, animated images, and
backgrounds that are ready to be inserted to lend pizzazz to your Web pages, presentations,
reports, and anything else you create in StarOffice.

You can preview all the images and sounds in the Beamer, as well as drag and drop them
from the Beamer into open documents. For more information, see “Previewing Files,
Sounds, and Images in the Beamer” later in this chapter.

"To add your own graphics or sound files to the Gallery, select the Gallery folder, open the
Gallery context menu, and select the Import command. When you’re browsing the Web,
there’s also a handy context menu command that enables you to easily copy or download any
graphic file and add it to the Gallery.
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Explorer Help Links

Access to help is sprinkled all over the desktop, including here in the Explorer, which pro-
vides a different way of accessing the User’s Guide. To see the contents of the User’s Guide,
click the plus (+) sign to the left of the Help icon to open the Help folder. Continue clicking
plus signs until you see a chapter title that interests you. Double-click on the title, and its
contents appear in a desktop window.

. Part
The Recycle Bin Iar

When you delete most objects from StarOffice, they are not immediately discarded from
your hard drive: they’re stored in the Recycle Bin in case you find that you still have some
use for them. They remain in the Recycle Bin until you explicitly delete them with the 24
Delete command.

Ch

m The Recycle Bin is one example of how StarOffice’s total integration can affect the amount

(@]

of disk storage the program requires. Be sure you set aside enough room on your partition
or hard drive to accommodate the Recycle Bin. Also be sure to empty it periodically so you
don’t build up trash on your hard drive. You can also choose a folder located elsewhere to
serve as your trash folder via the Tools, Options, General, Paths dialog—but you'll lose the
special safety features of the Bin.

The number of objects that are currently stored in the Recycle Bin is always visible in
parentheses to the right of its name in the Explorer.

To delete objects from the Recycle Bin, follow these steps:
1. Double-click the Recycle Bin icon in the Explorer, which opens a desktop task window
that displays its contents.
2. Select the items that you want to delete.
3. Select Delete from the function bar or Edit menu.

4. StarOffice gives you yet another chance to save the file from total destruction. To con-
firm that you want to delete the file and complete its disposal, choose Yes or press
Enter.

Objects that you have moved to the Recycle Bin cannot be dragged and dropped as can
other objects on your desktop. To return objects that are in the Recycle Bin to their original
locations, select the object, and then choose the Restore command on its context menu.

To empty the Recycle Bin, choose the command of the same name from its context menu.

Samples

To give you a taste of StarOffice’s possibilities, a number of sample documents that were
created in the program have been included. Some of the samples (for example, Logo
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Workshop in the StarOffice Pro edition), even show you, step by step, how the final product
was created.

m The samples that you have might vary, depending on which edition of StarOffice you have
installed.

You can use these samples as templates for creating your own projects. For example, a sam-
ple database to keep track of a video collection is included. You can customize this database
to organize your own video collection.

StarSchedule

Manage your schedule, set automatic reminders for upcoming events, and plan projects
from your desktop with StarSchedule. Although StarSchedule can be used to keep track of
just one person’s calendar, its power is revealed when it is used on a network, where you can
keep track of project team or department schedules while enabling all team members to
access the schedule. The StarSchedule Servers folder enables you to add or delete servers
that have access.

You can set automatic reminders to pop up on your desktop, or schedule emails to be sent
automatically to all members of a mailing list.

Part of StarSchedule’s beauty is its simplicity—no more bloated, cluttered desktop calendars,
just a clean, intuitive interface. Open the StarSchedule on your desktop and double-click
Tasks; a task list opens. Add your tasks, and they automatically appear when you open the
Events calendar (by double-clicking). You can then drag and drop tasks onto the calendar or
click in the calendar and type directly. If you click a date on the overview calendars to the
right, your Events page automatically changes to match.

[ For details on working with StarSchedule, see “Getting Organized with StarSchedule,” p. 1020.

Workfolder

When you first launch StarOffice, the program automatically creates a folder or link called
Workfolder and places it in the Explorer. It also automatically makes Workfolder an
Explorer group. Depending on how your system is configured, it may create an empty new
folder or create a link to a folder you’ve already designated in your operating system as your
default storage location. This folder is also the default storage location for your documents
in StarOffice. It is placed on the desktop for your convenience, to help you get up and run-
ning quickly in StarOffice. Some of the desktop navigation buttons have handy shortcuts to
the Workfolder, so it’s a good idea to reassign the path of the Workfolder rather than delete
it altogether. To reassign its path, use the Tools, Options, General, Paths dialog box. Search
for the type Work Folder (the last item in the Paths list), and click Edit to change its path.
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Workplace

Double-clicking the Workplace icon opens a window that shows all your available local dri-
ves, all available network drives and servers (if you are connected to a network), and a com-
plete network map. You can then navigate around your drives, conduct a multiple search,
and view and edit the properties for selected objects using the tools on the object bar and
the Workplace context menus.

Part
(] .
Tip #15 from Workplace in StarOffice is the equivalent of My Computer in Microsoft Windows. |
Mickael & Zarah
Ch
Further Explorations with the Beamer P

The Beamer (shown open in Figure 2.14) was introduced briefly at the beginning of this
section as the Explorer’s assistant, but it’s time to take a closer look at just what it can do.
The Beamer is like a lantern that shines a bright light on what you find with the Explorer,
revealing details of files. You can manage individual files via commands on the main Beamer
context menu and the document context menus. As mentioned earlier, it’s also where the
Address Book table displays if you press F4. With the Address Book open, you can drag and
drop names, addresses, and phone numbers from the Address Book into open documents.
You can also display any other StarBase table in the Beamer, and drag and drop field names
into documents to create merge fields.

To turn the Beamer on and off, click its icon in the function bar, or choose its name in the
View menu. You can also turn the Beamer on (but not off) by pressing Ctrl+Shift+B.

If the Beamer is open, an extended-click on a folder or other object in the Explorer window
displays a list of that object’s contents and its properties—such as last date modified—in the
Beamer. Click on a property’s title bar to change the sort order; drag its right or left border
to shrink or expand its length. Double-clicking some title bars automatically reduces their
size. You can also choose the Property display fields that you want to see using commands
on the Beamer context menu Insert command.

To select a single file, click its name; to select a list, click the first item in the list, and then
press Shift and click the last item. Press Ctrl while clicking to select multiple noncontiguous
items.

After you select an item, you can conduct a search based on that item. Note that you can’t
create saved searches in the Beamer—you can only do that from the desktop or Explorer—
nor can you display the contents of saved searches.

The Remove command does not delete files from the Beamer; it only deletes the property
title display that you currently have selected in the Beamer.
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Previewing Files, Sounds, and Images in the Beamer

Besides being a local file manager, the Beamer is also a preview window in which you can
view or listen to Gallery clips (see 2.16). What’s even nicer is that you can also drag and
drop a graphic or sound file from the Beamer into an active document.

To preview the contents of a Gallery folder, extended-click its name in the Explorer when
the Explorer is set to Hierarchical view. This opens a strip of previews called thumbnails
(because of their small size). To see a file in larger view or to hear a sound file, double-click
it. Double-click again to return to the Beamer’s thumbnail browsing view. To move through
the files in the folder, use the Beamer scrollbar.

Other objects can be dragged and dropped from the Beamer as well. For example, you can
insert a text file into another document by dragging it from the Beamer onto an open text
document page.

Other Floating and Dockable Windows

The Explorer and the Beamer are not alone; StarOffice has a number of other special float-
ing, dockable tools windows that you can keep open while you work. These include the
Navigator and the Stylist, both of which open from the function bar (but are available only
when you have a document open on your desktop). The Help Agent is a dockable window,
and if you use it often as you’re learning the program, you might find it easier to work with
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it docked so it doesn’t cover your work area. The Tips window that opens at program
launching is special part of the Help Agent that only displays tips. It’s not useful as you work
so you may want to dock the real Help Agent there instead, which gives you a context-
sensitive program. Other special tool windows can only be opened from within specific
document types and include the Function List in StarCalc and the Form Navigator.
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You can manage these windows on your desktop much like you do the Navigator and
Beamer. When a window is floating, as the Navigator is in Figure 2.16, you can grab it by
the edges and resize it so it doesn’t take up as much screen real estate.

Double-clicking the title bar toggles the window between the title bar and open views. You
can drag and place the title bar anywhere on your desktop. (Note, however, that you cannot
dock a window when it is in title bar form; the window must be open.) Ctrl+click works to
dock and undock windows, and clicking the Close button in the upper-right corner closes
them.

Floating Toolbars and Dialog Boxes

There are two other types of floating objects that you’ll encounter that are not dockable
and have some other important differences from floating dockable windows as well.

The main toolbar has a number of tools that each boast a small green arrow on the right.
These are double-function buttons. An extended-click opens a toolbar—a mini-toolbar,
really—that can be detached and moved anywhere on your desktop. Some buttons on object
bars also open tear-off floating palettes or toolbars—for example, the background color
palettes in StarCalc and StarWriter. Another mini-toolbar, the Navigation toolbar (refer to
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Figure 2.16), opens from within the Navigator or by clicking the Navigation button in doc-
uments. (Look ahead to Figure 2.17 to see the Navigation button identified.) Unlike the
main program toolbars, these floating toolbars cannot be resized or docked. Click the Close
button (the X) in the corner to close them.
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When you close a mini-toolbar that resides on the main toolbar, the Tool button that dis-
plays reflects the last tool you selected. A regular click activates the displayed tool. If you
need a different tool, extended-click the button to open the entire toolbar and select the
tool you need.

Virtually all dialog boxes also open as floating dialogs that can be reduced to title bars and
moved anywhere on your desktop. They cannot be resized. Although you can move a dialog
box off your desktop, in many cases you can’t do any other work until you’ve closed the dia-
log box.

Understanding Tasks and Task Windows

StarOffice is task-oriented, and most of your work takes place in task windows.

You can have up to 255 tasks open on your desktop at once —and many open tools win-
dows—so learning how to manipulate and manage multiple task windows and organize the
tools on your desktop are keys to efficient use of the program.
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m To get the most out of StarOffice’s desktop, it's best to have a monitor with at least a 17”
viewable area, set to 1024x768 resolution or higher. If you run at lower resolutions or on a
small monitor, you'll find that your desktop gets very cluttered and you cannot see all your
tools at once.

TiP #16 from Keeping many windows open hogs system memory. To avoid system crashes, keep open Part
Michael & Sarah only as many windows as you really need. |

Ch
What Is a Task? 2

A task is anything you open in a task window on the StarOffice desktop.
There are six basic types of tasks in StarOffice:

= Creating and working with documents

= Scheduling and managing tasks and events

= Writing, reading, and sending email and news

» Creating and managing databases

= Managing files, folders, and other objects

= Browsing the Web and viewing HTML documents

In StarOffice, document refers not only to text documents, but also to spreadsheets, drawings,
images, presentations, Web pages, and other types of files that you create.

When you open a new document, double-click an object in Explorer, or drag a file from the
Beamer onto your desktop, and a new task window automatically opens.

Tip #17 from To open an object in the Explorer in a new task window without closing the active task win-
Michae! & Zarah  dow, press Ctrl while double-clicking.

Working with Task Windows

When you open a new task window on the desktop, it is automatically added to the list of
open tasks in the Window menu, made the active window, and placed on top of any other
open tasks. However, just as you can slide papers and folders around on a real desktop, you
can rearrange the order and appearance of task windows.

Even though when it opens it is docked to your desktop, you can make it into a floating
window (as in Figure 2.17) by clicking the Maximize button in the upper-right corner. As a
floating window, it can be dragged anywhere, resized, and reduced to a floating title bar,
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much like the Explorer and Beamer. By clicking the Stickpin, you can also pin your task to
the top and ensure that it is always visible.

Figure 2.17 identifies the basic elements of a task window and shows an open Task window
context menu.
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Tip #18 from

Ctrl+Tab cycles you through all open task windows.
Michael & Farah

The Status Bar

Whenever you have a task window open, a status bar (refer to 2.18) appears at the bottom
of the window, displaying basic information about the document and its current settings.
The specific information you see depends on the type of task.

All status bars are divided into various sections. If your mouse pointer turns into a double-
headed arrow when you move it over an area’s borders, you can drag and resize that section.
In many of these sections, right-clicking opens a fly-away shortcut menu, while double-
clicking opens a dialog boxes—just click around and explore!
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The status bar displays for specific document types are discussed in the sections on each
document type. Check the Index and Table of Contents to find specific page numbers.

Managing Tasks with the Task Bar and Task Buttons

You can manage task windows using any of the following:

s Commands on the Window menu
s The taskbar Part

s The Task window context menu I

» The Close, Maximize, and Minimize buttons in the upper-right corner of all task Ch
windows 2
Tip #19 from The most important commands are located on the taskbar and Task window context menu.

Mickael & Sarah

Of these, the taskbar and its associated context menu is the easiest to use and has the widest
range of commands. The taskbar also contains other items that assist you in managing your
desktop, including the Desktop button (which enables you to switch between different desk-
tops and open the desktop contents menu), the Start button (which opens a menu that
enables you to start programs, tasks, and documents from anywhere on your system), a
quickstart area, and task tray icons. This section describes these elements in more detail and
explains how to use the task buttons to manage open tasks.

When you open a new task, a button for that task is automatically placed on the taskbar at
the bottom of your StarOffice desktop (see Figure 2.18). This Task button can be used in
many ways to rearrange the order and appearance of tasks on your desktop.

Right-clicking a task button opens the Task window context menu (refer to Figure 2.17),
which gives you a range of commands for arranging task windows.

With the New Window command, you can open a copy of your selected task in a second
window; this is handy if you’re working on a long document or in a spreadsheet where you
want to see two different worksheets at once. The Tile, Horizontal, and Vertical commands
arrange the open task windows in preset patterns. Floating Task is a toggle that alternately
floats and docks a task, whereas Task Always on Top leaves a task on top even when it isn’t
the active window.

Tip #20 from If you're dragging and dropping a lot of files or data between two open task windows,

Michael & Sarah make one into a floating task window and set it to Task Always on Top (or click the Stickpin
icon). Then both are always visible, and you can use your entire desktop for working—even
with the Explorer and Beamer open.
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If only one copy of a task is open, Close Active Window (Ctrl+W) and Close Open Task
have the same effect—they close the task—but if you have multiple copies open, Close
active window closes only the active copy of the task.

If the integrated desktop is on, you see a unified taskbar. If it's turned off, you have sepa-
rate Windows and StarOffice taskbars. If the Windows taskbar is in the way, click it in an
empty area and drag it to the side.

17 ﬁ
||:||:

WINDOWS

Some users experience problems with StarOffice’s taskbar hiding beneath the FVWM2-95
taskbar. If you have this problem, try editing the App-Window line in your sofficerc file
(in your StarOffice directory) so that it reads as follows:

App -Window=0,0,16,1024,752;0. (This assumes you're running at 1024x752
resolution.)

Besides managing task windows individually, you can also combine tasks into one window
by dragging and dropping one task button onto another. There are three basic ways you
can combine open tasks:

» If you drag and drop one task button onto another, it combines the two tasks into one
window (although each remains a separate file).
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» If you Ctrl+drag and drop a task button (Task 1) onto another (Task 2), a copy of Task 1
is combined in a single window with Task 2. This copy is separate from Task 1 and is no
longer updated.

= If you Shift+Ctrl+drag and drop a task button (Task 1) onto another (Task 2), a linked
copy from Task 1 is created and combined in a single window with Task 2.

This feature makes many tasks much easier to accomplish. Here are some possible uses:

Part
= Drag and drop a StarCalc spreadsheet Task button onto a StarWriter Task button. You I
can then easily drag and drop a table of StarCalc data into a StarWriter document.
Ch

= Drag and drop your mail Inbox into an open StarWriter document. You can then easily
drag and drop individual mail messages into StarWriter documents, which is much easi- 2
er than exporting them as ASCII files!
= Drag and drop the Task button of one open copy of a document onto the Task button
of a second open copy. You can then easily view two parts of your document at the same
time.
= Drag and drop the Task button of an HTML document in Source Code view onto the
Task button of the same document in Online view. You can then easily see the effect of
changes you make in the source code to the final document as seen onscreen.

= Drag and drop the Task button of a StarBasic session onto the Task button of the docu-
ment for which you are creating macros or scripts. You can then see the program code
in one window and the results for the document in the other.

The Start Menu  From the Start menu (shown in Figure 2.19), you can launch new
StarOffice tasks, manage your system, and run system programs.
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Tip #21 from

; You can customize the appearance of the Start menu by adding or deleting entries in the
Michae! & Sarah

Config\start menu folder in your StarOffice directory.
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The Documents folder contains a list of the last nine documents you worked on, enabling to
you open recently used documents with a single-click.

TiP #22 from If you right-click the Start menu, a fly-out menu opens from which you can open your
Michael & Sarah Programs folder (Windows users), or your /bin folder (Linux users) onto your desktop. If
you're on a network, you can also open your network systems folders from here.

Tip #23 from Here is a quick way to customize your desktop: Open your Programs or network folder
Michael & Sarah from the Start Menu, and Ctrl+Shift+drag links onto your StarOffice desktop for any pro-
grams or administration tools you want to launch from your desktop.

Tip #24 from Choose the Show Large Symbols command on the fly-out menu to increase the font size of
Michael & arah items on the Start menu.

The Quickstart Area  You can create your own quickstart buttons for single-click launch-
ing of any object by dragging it from your desktop and dropping it onto the quickstart area
(the small area between the Start menu and the Desktop menu on the taskbar; refer to
Figure 2.18). This is particularly useful for objects that you frequently open, such as your
email account inboxes or a project schedule.

"To remove an item, right-click it and choose Remove.

The Desktop Menu  Just as you might have one desktop at home and another at work,
you can create multiple desktops in StarOffice. By default, the StarOffice Desktop folder
and your systems Desktop folder are both designated as desktops. You can also create your
own desktops by selecting a folder in the Explorer or in a task window, right-clicking to
open the folder’s context menu, and then choosing the Desktop command.

These desktops are managed through the Desktop menu, which opens with a right-click (see
Figure 2.20). To select a different desktop as your default, click its name in this menu.

While you can have as many folders as you want designated as desktops and waiting in the
wings, only one desktop can be on stage—that is, selected as your default—at a time.

If you want to designate a linked folder to be a desktop, you won't see the Desktop com-
mand on the main context menu; you'll need to open the Target's context submenu.

An extended-click opens the Desktop Contents menu, which shows all the items you have
stored in your currently selected desktop.



Figure 2.20
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A click on the Desktop icon in the taskbar toggles you between the current default desktop

and your most recently opened task.

[0 For more information on creating and working with multiple desktops, see Chapter 3, “Getting Ready

for Work” p. 75.

The Icon Tray and Clock The Taskbar icon tray displays two StarOffice-specific icons:
the system clock and a Globe icon, which changes appearance when you have new mail. If

you double-click the clock, your StarSchedule desktop calendar opens.

The New Mail Notification icon works only when you have set up your StarOffice Internet
connection and created an email account Inbox.

The other icons that appear depend on your computer’s configuration.

[

[
U

If the Integrated Desktop is turned on, your Windows system icons appear in the StarOffice
icon tray. If not, only StarOffice-specific icons appear. You can turn the Integrated Desktop
on or off by selecting Integrated Desktop from the View menu.

Tip #25 from
Michael & Sarah

Make the User’s Guide Help window a floating task, and then select the Task Always Visible
command to keep Help open alongside tasks while you're learning the program.

Part

Ch
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Closing Task Windows

All open desktop windows close in the same way, whether their contents are a document,
Web page, email, or the contents of a folder you have opened. (The one exception to this is
the designated desktop, which always remains open as long as the program is open.)

There are three ways to close an open task:

» Click the Close button in the upper-right corner of the desktop window. (If you have
integrated desktop turned off, be careful to click the Jower Close button because the
upper Close button exits StarOffice.)

m Select Close from the File menu. Do not select Exit because this exits StarOffice alto-
gether.

= Right-click the Task button in the taskbar, and select Close Task.

Adjusting Your View

Besides manipulating desktop windows, you can also change your view of the desktop, turn
on and off the display of various desktop tools, and zoom in and out of tasks. These actions
are carried out with commands on the View menu or with context menus.

Making More Space on Your Desktop

One of the disadvantages of having an integrated desktop is that your workspace can get
very cluttered. When you need to see more of a task, you can make it fill up your display by
selecting Full Screen view from the View menu. Click the Monitor icon that appears to
return to the regular Desktop view.

Turning Toolbars On and Off

Another way to make more space on your desktop is to turn off the display of unneeded
tools. To turn on and off the status bar, click its name on the View menu. To globally turn
on and off the display of program toolbars—including the function and object bars—open
the View, Toolbars submenu, and then click the name of the toolbar that you want to hide
(or reveal). Note that the Main toolbar may be selected (as indicated by a check mark next
to its name) but still not be visible because it displays only when you have an open docu-
ment on your desktop.

To turn off the display of a toolbar within a particular context, position your mouse in a
toolbar and right-click. This opens the toolbar context menu, which lists only those toolbars
currently open. Click to deselect or select a toolbar. If you’ve turned them all off, you’ll
need to use the View menu commands to turn them back on again.
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Zooming

The View menu Zoom command becomes active only when you have a document open in a
task window. Clicking Zoom opens a dialog box that enables you to either select a preset
zoom value or enter your own value. You can select any value between 20-400.

The value that you select is in effect for all documents you open in that application until you
change it again.
Part

Finding Help in StarSpace

StarOffice offers superior functionality and ease of use in most areas; unfortunately, howev-

er, the English online Help system is not yet one of them. Because the program documenta- 2
tion is relatively weak (although the version 5.1 Help is more complete than previous

versions), you are pointed to some other useful resources.

Ch

Help Agent, Tips, and Extended Tips

When you launch StarOffice for the first time, the Help Agent tips window automatically
opens and Help Tips are turned on. The contents of this tips window are static during a
work session, changing only when you exit and then re-open the program. The main Help
Agent window opens automatically when you execute certain program commands, but you
can also open it yourself at any time by selecting the Help, Help Agent command.

If you find the Help Agent annoying, you can turn it off globally by deselecting the Start
Automatically option in the Help Agent portion of the Tools, Option, General, Other dia-
log.

The Help Agent is a searchable help file that displays context-sensitive help as you click on
different commands and tools. It also contains a number of tips that are not found in the
User’s Guide.

Figure 2.21 shows the Help Agent and identifies its tool buttons and window controls.

You can reduce the Help Agent to a floating title bar by clicking the Minimize button, or
you can dock it to your desktop to keep it open but out of the task’s way, just as with the
Beamer and Explorer.

Help Tips give you the names of StarOffice tools and buttons in dialog boxes. When Help
Tips are turned on, move your mouse pointer over the tool button or dialog box command
whose name you want to know, and a tip with the name pops up on your screen. After you
move the cursor away, the tip disappears. If you turn on Extended Tips, explanations of the
tools and how to use them appear. Although Tips and Extended Tips can be simultaneously
selected on the Help menu, this is misleading, as only one functions at a time for a given
button. If no Extended Tip exists, the tool name appears.
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The Help Pointer

2] The Help pointer gives you immediate, brief, context- sensitive help with StarOffice tools
and dialog boxes that is more detailed than Help Tips. To activate the Help pointer, press
Shift+F1. Your pointer shape changes and becomes an arrow with a question mark attached.
To get help, move your mouse pointer over the tool button or dialog box command about
which you want to know more, and help pops up on your screen. It disappears after you
move the cursor away. Click anywhere in the desktop to turn the Help pointer off.

User’s Guide (Contents)

The User’s Guide is a searchable hypertext manual that provides a basic introduction to the
StarOffice desktop and program modules. Open it by selecting the Help menu Contents
command, or by selecting Help on the StarOffice Start menu. The User’s Guide contains a
good reference guide to StarBasic, with alphabetical dictionaries of all the available func-
tions and an overview of StarOffice’s API programming structure (called StarOne).
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m The online Help describes StarOffice’s functionality as it exists in the Windows version. Not
all these functions are available on Linux. (Most notably, the StarBase format database, the
native format that enables users to create relational databases, is available only on the
Windows32 platform.) Therefore, if the functions described here or in the StarOffice Help
are not available, don’t assume it is a program error.

The User’s Guide Help system has the same Find, Contents Home Page, and Zoom In and BRI
Zoom Out buttons as does the Help agent. To move forward and back in the User’s Guide, I

use the Forward and Back buttons on the desktop function bar.
Ch

Tip #26 from

i You can print sections from the User’s Guide with the File, Print command.
Michael & Farah

The User’s Guide Help window main toolbar has two other buttons: one for bookmarks and
one for annotations (see Figure 2.22).
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Clicking the Bookmarks button creates a hyperlink to the section that you are currently
browsing in a Bookmark folder inside the Explorer Help folder. (Note that this folder is
different than the main Bookmarks folder.) Clicking Annotations opens an annotations win-
dow into which you can enter notes—for example, your own tips or explanations. After you
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click OK to confirm the annotation, the Annotation icon appears to the left of the section
title. When you’re browsing in that section again and click the Annotation icon, your earlier
note pops up for review.

Specific sections of the User’s Guide also appear as menu items on the program Start menu.

Internet Resources

StarDivision, Inc. maintains a Web site that offers some basic support for installing and
using StarOffice. Most usefully, it offers information links to StarOffice Internet newsgroups
it maintains. These newsgroups address the use of specific applications and troubleshoot
general installation and desktop problems. The newsgroups are lively, and both StarOffice
personnel and eager power users offer translations from German documentation on many
topics that are still undocumented in English. As of the time of this writing, the URL was
http://www.stardivision.com/support/ek_news.html. Old newsgroup postings can be
found on the Deja News Web site at http://www.dejaneww.com. The StarOffice desktop and
Bookmarks folder contains bookmarks for single-click travel to StarDivision Web sites that
can also guide you to the newsgroups and other help resources. The StarDivision and
StarOffice overview links jump you to the general home page and an overview of the pro-
gram, respectively. Click Support at the top of the page, and then follow the links to find a
list of StarOffice newsgroups in English.

m StarDivision Web Help is only available after you've configured your Internet account in
StarOffice. For information on configuring StarOffice for the Internet, see Chapter 3.

For German readers, there’s an abundance of StarDivision documentation available online.

Tip #27 from German readers who are interested in StarBasic might want to download the 1,200-page

Michael & Farah StarBasic 4.0 manual in . pdf format from ftp.stardivision.de. (The reference is still
useful, although much has changed. There is no more recent detailed reference available,
at least not for public distribution. If you have specific questions, post them to the StarBasic
newsgroup.) The document is in the basic folder (not pub). Log in as anonymous; you'll be
requested to enter your email address as a password.

Other StarDivision Program Support

When you’ve exhausted your program and Internet help resources, StarDivision’s U.S. office
maintains a telephone support line from Monday through Friday, 8 a.m. to 8 p.m. (PST) at
(510) 505-1490. You're entitled to 30 days of free support after registration. The company
says that most questions can be answered within six minutes. If a representative cannot help
you right away, you will receive a written response from customer support within 48 hours.

StarDivision also offers different types of support contracts to personal, commercial, and
institutional customers. If you are considering installing StarOffice on an office or net-
worked system, you should explore these options.
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If you have downloaded the program for free, keep in mind that the company cannot afford
to devote its resources to giving free support indefinitely to non-paying customers. Make
good use of your initial free support, if you need it, but be considerate and be aware that
many of the most common questions have answers already on the newsgroups. Alternatively,
if you find the program worthwhile, consider paying for a support contract.

Troubleshooting

Suddenly, I can’t find the Explorer and Beamer tools on my function bar: Help! Where did they go?

You probably turned off the StarOffice integrated desktop, reducing the width of your
StarOffice display window; and there’s no longer enough room to display all your tools at
once. A double-headed arrow should have appeared at the right end of your toolbar—click
the black arrow, and the rest of your tools should appear.

Every time I try to exit StarOffice, my system crashes!
7y 7y , MY 5.

Some versions of fvml in Red Hat conflict with StarOffice and cause a system lockup, if you
exit the program by clicking the Close button on the title bar. Try exiting using the Control
menu Close command, or use the File menu Exit command instead.

I keep getting a message on startup that the plug-ins manager couldn’t be loaded and I should run
Setup with the -repair option. I run setup as instructed, but continue to get the message.

StarOffice is looking for Netscape or Internet Explorer plug-ins already installed on your
system to incorporate into its own browser and file management system. If you don’t have
either of these browsers currently installed, it won’t find any plug-ins to manage and will
generate the message you see. StarOffice will run fine without the plug-ins for most desktop
tasks, but you will be unable to open certain types of email attachments or Internet docu-
ments unless you have the proper plug-ins loaded on your system.

I can’t see my desktop workspace, the Beamer and Explorer cover things up.

Click the stickpin icons on their borders to pin them to the desktop. When they’re not
pinned, they float on top of the desktop workspace. Click the arrow button to hide the win-
dow entirely.

I can’t find my deleted files.

StarOffice maintains its own separate Recycle Bin. Check the StarOffice Recycle Bin, which
can be opened by double-clicking its icon in the Explorer.

I can’t drag my files out of the Recycle Bin.

As you've discovered, drag and drop doesn’t work on objects in the Recycle Bin. To restore
an object to its original location, select the object, right-click to open its context menu, and
choose Restore.



74 | Chapter 2 Stepping into StarOffice

I can’t get folders to display their contents in the Beamer.

If a folder contains only other folders, its contents won’t display. Only files display in the
Beamer. If a folder does have files, an extended-click does the trick. (A double-click opens
the folder on your desktop in Hierarchical layout, a single-click in either of the symbols lay-
outs.)

I can’t find the Explorer context menu New command.

You’re opening a context menu when you have a non-folder object selected. Select any fold-
er object, or position your cursor in a blank area of the Explorer and right-click.

I can’t open more than one task window at a time.

You’re probably opening objects from the Explorer or Beamer by double-clicking them. Try
pressing Ctrl when you double-click, or selecting an object, right-clicking, and choosing the
Open command.

I click on hyperlinks in the Help Agent and Contents and don’t get anywhere.

The original program documentation is in German and the English program documentation
is not yet fully translated. These hyperlinks indicate sections not translated in time to add to
the version you have. While the English version of 5.1 has a few hundred pages of addition-
al English Help files, it still does not offer the full range of help that the German version
does.

I want to set a graphic as my desktop background, but I need to see what’s in the file to be sure it’s the
right one. All I see is a big box with an X in it!

You need to select the Preview option in the dialog box, and then you can see thumbnail
images of any graphic files you select while browsing around your directories.

Every time I open StarOffice, I see things on my desktop that I don’t want. How can I change what
appears on my desktop on launching?

Change your default desktop. You can designate any folder you want as a desktop by select-
ing it, opening its context menu, and clicking Desktop.
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Setting Your General Options

After you’ve installed StarOffice, it’s a good idea to customize your workspace. Everyone has
certain preferences when it comes to using menu commands, buttons, and directories, and
StarOffice enables you to customize your workspace to match your work habits and aesthet-
ic sensibilities. If so inclined, you can change toolbars, buttons, and menus; default directo-
ries, paths, and custom commands; as well as the appearance of your desktop.

Most users will want to start out with setting their general options for working in
StarOffice. These options enable you to modify your personal data, paths to important files,
overall desktop appearance, as well as the default save, print, and color settings. You can set
these options in the General Options dialog box (see Figure 3.1). To access the General
Options dialog, select Options, General from the Tools menu on the menu bar.
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Modifying Your User Data

The User Data dialog boxlists your contact information—including name, company,
address, phone, and email—which you were asked to provide during the setup process.

Tip #28 from

. To take full advantage of all that StarOffice has to offer, be sure to keep your contact infor-
Michae! & Sarah . by

mation up to date. StarOffice includes a series of templates that use fields to plug in all or
part of your contact information (depending on the template you use), which it retrieves
from this dialog box.

"To update your user data, place the cursor in the text box you want to change and start typ-
ing. You can move between text boxes by pressing the Tab key and reverse by pressing
Shift+Tab.

If you’ve changed certain key portions of your user data when you choose OK to confirm
your new user data, StarOffice warns you that you’ll need to re-register the program or it
will expire in 30 days. Choose Yes in the warning box to complete entering the new data.
Choose No if you've changed your mind, and then choose Cancel in the User Data dialog.
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It’s best to re-register at the same time you change your user data so you don’t have an
unhappy surprise when you try to start StarOffice one day. To re-register, choose Help,
Registration, and select the Register button. If you’re online, it takes just a few seconds. If
you don’t have an Internet account or online registration fails for some reason, you’ll need
to mail or fax your registration to StarDivision.

Setting Your Save Options

While computers are great tools, it’s frighteningly easy to lose work when you’re using
them. Power outages, computer crashes, a slip of the fingers on the keys—and there it is, a
whole afternoon’s work gone. Has this ever happened to you? Then you know you can never
save your work too often.

You should regularly save open documents on your desktop by clicking the Save button on

the function bar or pressing Ctrl+S. For an added level of security, you should also set the Part
Automatic Save and Backup options in the Options, General, Save dialog box (see Figure |
3.2). Taking the time to set these two options in the beginning might end up saving your ch
nerves and neck as well as your work! Just click the Automatic Save Every check box and set

a fixed time interval in the Minutes spinner box. You can also choose if you want to be 5

prompted to confirm each save (default) or not. If you prefer not to be interrupted by con-
stant Save dialogs while working, you should deselect the Prompt to Save option. StarOffice
will now save your open documents every x minutes (where x is the time interval you speci-
fied), replacing each time the previously saved version of your document.
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If you prefer to keep a backup copy of your documents and files, you should select the

Always Create Backup Copy check box. Every time you save a new version of an open docu-
ment, StarOffice automatically saves the previous version with a .bak file extension in the

backup folder of the StarOffice directory.
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You can always change the default path for saving backup files in the Path dialog box in the
General Options category. However, be sure the folder you want to designate already exists
or you will get an error message. You can create a new folder from inside the Select Path
dialog box that opens when you click Edit—the second button from the right creates a new
folder (directory). To open a file with a . bak extension, double-click it from inside the
Explorer.

In addition to the Automatic Save and Backup options, you can also set the Undo Number
of Steps, which determines how many steps you can backtrack (by pressing Ctrl+Z, for
example) to undo changes in your document. The default value is 20, but you can set this
number anywhere from 0-100.

If you’re the worrying kind, you might be tempted to set the number at 100. Keep in mind
that these undo steps take up space in RAM and temporary swap files on your hard drive,
and might also slow down system performance. If you have less than 64MB of RAM, you
should probably set this number at 50 or less.

However, StarOffice handles Undo differently in StarWriter than you might be used to,
because it treats individual additions—such as a space—as an action, so 20 backward steps
might be smaller steps than you imagine.

If you’re particularly uptight about keeping track of different versions and contents of a doc-
ument, you can also check the Edit Document Properties Before Saving check box. Each
time you save a document with the Save As command, the Properties dialog box appears,
enabling you to update and save the document information. Information you enter in the
Properties dialog box can later be entered as fields in your document. This is a particularly
useful tool for working in project teams and managing document storage and retrieval for an
office, as you can easily track such things as document authors, keywords, and document
titles through fields in headers and footers.

[J For more information on working with fields in text documents, see “Working with Fields,” p. 350.

The Restore Working View options affect what information StarOffice saves about your task
window arrangements when you exit the program. If you choose the Open Windows or
Open Documents options, it will save and reopen your last desktop windows arrangement
and your last open documents or folders, respectively.

Changing Default Locations for Important Files

All program paths for default file searching and storage are set through the Paths dialog box
in the Options, General category. StarOffice enables you to create your own directory struc-
ture.
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The default location for bookmark storage is \Explorer\Bookmarks. While you can
change this path (to store them in another program’s directory), keep in mind that you
must store your bookmarks in a folder in the StarOffice Explorer, or create a link to that
folder in the Explorer, to have them available on your StarOffice desktop.

Paths you might consider changing include the Recycle Bin (\Store\Trash), the Internet
and network download path (\download), the Mail/News Storage paths (\Store), and the
Backup copies path (\Backup).

To change a path, select the type you want to change, and then click the Edit button in the
Paths dialog box (see Figure 3.3). Enter the new pathname in the Path text box on the
Select Path dialog, or select a folder from the list box. You can click the Up One Level but-
ton to move up to the next level in the folder hierarchy. An extended-click opens a submenu

that displays the hierarchy of the next highest directory up to the workplace. You can also
click the New Folder button to create and name a new folder within a hierarchy. When
you’re finished, click Open to assign the new path to the selected type.
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Selecting Spelling and Language Options
The Spelling/Language dialog boxin the Options, General category enables you to set glob-
al spelling and hyphenation rules that will be used on all your StarOffice documents (see
Figure 3.4). In addition, you can set the default language used for spellchecking and manage

installed and custom dictionaries.

Part

Ch
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Check this box to ensure that footnotes, text
boxes, and other non-body text are spellchecked
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You can also turn this on and off on the main toolbar
Table 3.1 lists the various options you have when spellchecking your documents.
Table 3.1 Global Spellcheck Options
Option When Selected...
All Caps Uppercase words are included in spellchecks
Words with numbers Words that contain numbers are included in spellchecks
Case-sensitive Capitalization is checked
Check Special Regions Headers, footers, footnotes, and other areas of text outside the text
body are included in spellchecks
All Languages All installed dictionaries are used to perform spellchecks
Tip #29 from

i If you use many foreign words in your documents, or if you frequently write entire sen-
Michael & Zarah tences or paragraphs in another language, you might want to select the All Languages
check box. StarOffice will catch your spelling errors as long as you've installed the dictio-
naries for the languages in question. You can install up to three language dictionaries in
StarOffice. For more details on managing your installed dictionaries see “Understanding
Dictionaries in StarOffice,” in Chapter 12, “Proofing and Printing Your Documents.”

If you want StarOffice to automatically mark your spelling errors with the AutoCorrect
feature as you type, select the Check Spelling as You Type check box in the Auto
Spellchecking section. When you select this option, the Don’t Mark Errors option becomes
available, allowing you to turn off the automatic highlighting of your spelling errors.
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m While you can turn Auto Spellchecking on and off with a button on the main toolbar, you
can only set the Don’t Mark Errors option in this dialog.

In the Hyphenation Rules section, you can turn automatic hyphenation on and off. If it is
off, StarOffice will hyphenate words based on the hyphenation rules entered here.

When you installed StarOffice, the installer program gave you the option to install up to
three language dictionaries and set a default language. You can change the default language
at any time if so inclined. As long as the dictionary for the language you choose has been
installed, StarOffice will continue to catch your spelling errors.

The drop-down menu lists a huge number of languages, even though you are only given Part
the option to install three (or less). (Note another minor localization glitch: It also lists |
some languages available only in the European versions—such as Finnish. Given Linux’s

current popularity, who knows? Maybe we’ll soon all be speaking and spellchecking in ch
Finnish!)

While the program allows you to set any language you want as your default, be aware that
you might not currently have it loaded on your system. You won’t know you've made an
error until you check your spelling. For more details on switching your installed diction-
aries see the section “Installing New Dictionaries,” in Chapter 12.

At this time, there is no way to purchase additional dictionaries from StarDivision, although
a top product development manager says they are working with their third-party dictionary
providers on this.

Efjjg /fr;m Cara) Be sure to set the language you use most often as the default language.

Besides being able to choose three language dictionaries, you can also create and manage
custom dictionaries from this dialog. Custom dictionaries are specialized dictionaries that (if
turned on) are checked in addition to your currently selected language dictionaries. Since
you cannot add to or alter the language dictionaries, custom dictionaries allow you to create
your own dictionaries of commonly used words and acronyms, which speeds up spellchecks.

The program comes with two custom dictionaries. The Standard dictionary is the default
that StarOffice uses to record words you add when running the Spelling command. The
StarDiv custom dictionary contains a number of words and terms specific to computing and
the Internet.
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The program depends on the Standard custom dictionary for spellchecking, so don’t
delete it!

(] For more details on the custom dictionaries, see “Installing New Dictionaries,” p. 474.

Creating Custom Colors

Although not in a league with professional publishing and imaging programs such as
QuarkXPress, Adobe PageMaker, and Adobe Photoshop, StarOffice 5 comes with some
pretty sophisticated graphics and color capabilities, including the capability to mix your own
RGB and CYMK custom colors for onscreen and online display or output, respectively.
These colors are available to you in all StarOffice modules.

(] For more details on RGB and CYMK colors, see “Understanding Color Models and Modes,” p. 796.

To create custom colors, follow these steps:

1. Select Colors in the Options dialog, General category. A color palette opens, shown in

Figure 3.5.
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2. Next, click a color on the Standard Colors palette, select RGB or CYMK in the Color
sample drop-down list box, and then change the percent value for the individual colors
(Red, Green, and Blue or Cyan, Yellow, Magenta, and Black).

3. Click a color on the Standard palette to form the base for your mixing. Your results are
shown in the Preview area in the lower window, while the upper window shows the
original base color before you applied changes.

4. Once you're satisfied with your choice, label the color by typing a name in the Name
text box, and then click the Add button. The color is immediately added to the Color
menu, but will not appear on the palette until you click its name in this menu.

You can also choose to replace the Standard palette color with your custom color, or you
can edit or replace your standard and custom colors.
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The Reset button returns all colors to the values they had before you made any changes in
your current session. Cancel cancels all changes and exits the dialog.

Selecting Global Printer Alerts

You can set three global printer alerts through the Print dialog box in the Options, General
category. These commands are particularly useful for users on a network.

Check the Document Printer Not Found option if you are working with a document on
more than one machine or across a network, but need to print it to a specific printer. After
you select the printer that the document is associated with, StarOffice sends you an alert if
anyone tries to print the document from a machine that is not connected to the specified

printer.

If the Paper Size and Orientation options are checked, you will be warned when the size and Part
orientation you have selected for your page(s) do not match the current printer settings for I
your attached printer. You can then open the Printer Settings dialog box to change your

printer’s settings, as appropriate, without wasting time or paper. Ch

Selecting Font Substitutions

StarOffice has its own font substitution table built in. It automatically applies this table any-
time you open a document created in another program that contains fonts you don’t have
currently loaded, that StarOffice does not handle, or when you export files. However you
can also choose to apply your own font substitution table, which makes substitutions within
your StarOffice documents and desktop. Certain fonts used on the desktop, in the Explorer,
or for the display of data in StarBase tables are determined by system settings that you can’t
change directly. However, by creating and applying a font substitution table, you can achieve
the same effect and see the fonts you want onscreen.

You create a font table through the Substitute Font dialog boxof the Options, General cate-
gory (see Figure 3.6). To apply your own table, check the Apply Replacement Table check
box in the upper left of the dialog. Only when this option is checked can you create your
table.

The Font box on the left contains a drop-down menu listing all fonts currently available on
your system. Scroll down the list until you find the font you want to replace. Click to select
it. Next, select the font you want to replace it with from the Replace With drop-down
menu, which also lists all currently available fonts.

Once you have selected both fonts, the two previously grayed out buttons on the right
become active—the Add (green check) and Delete (red X) buttons. To add this font pair to
your table, click Add.
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Figure 3.6 Dptions - General - Font Substitution mE
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The pair appears in the table with two additional check boxes. Click Always to always apply
this substitution option. Click Screen to have the substitution affect the screen fonts as well
as printer fonts.

Michael & Sarah

Defining the Appearance of Your Desktop

The General Options View dialog box enables you to define the general look and feel of
your desktop windows, the size of your buttons, the spacing between icons on your desktop,
the mouse positioning, and the Beamer controls. For example, you can give your desktop a
Macintosh, X Window, OS/2, or StarDivision look and feel, each of which has its own style
of title bars and colors for common elements. The Window Drag drop-down list box
enables you to choose if task windows appear as full windows or outlines (frames) when you
drag them. You can also leave this choice to your operating system (OS).

T'F’ ?:32 /fr;m y Dragging windows with their complete contents visible requires more memory and proces-
Micpael & zara sor power. If you have a small amount of RAM or are experiencing frequent memory
faults, set Window Drag to Frame Only.

Tip #33 from

Michadl & caral If you want StarOffice to start a little bit faster, select Don’t Show from the Logo drop-down

list in the Display section. This turns off the program splash screen that you normally see
during startup.

Setting Miscellaneous Options

The Options, General, Other dialog box enables you to set your 3D view and influence the
behavior of the Help Agent. For those of you worried about Y2K, it also enables you to
determine how two-digit dates are handled by the program.



Getting Online | 85

The 3D View option enables you to decide how StarOffice displays three-dimensional
objects created in 3D charts or StarDraw. If you have at least 64MB of RAM and a
Pentium-speed processor, select all these options. It will significantly improve onscreen
appearance and printing.

By default, the Help Agent is set to start automatically when you invoke many program
commands. Some people find that the Help Agent hovers around annoyingly when they are
working. If you are one of them, deselect Start Automatically and you will be spared its sud-
den appearance. The Help Agent tips window displays at the bottom of your window the
first time you launch StarOffice. If you’re not content with just hiding it on your desktop,
you can turn it off globally here, as well as reset the Tip list to the beginning of its cycle.

The tips referred to here are tips given in the Help Agent, not the Tips and Extended Tips Part
you turn on through the Help menu. |

Documents created in StarOffice do not face the Y2K problem because StarOffice stores %

year dates internally as four-digit numbers rather than two. However, many other docu- 3
ments have not been created on systems with four-digit date year handling. Two-digit year

date handling, as you’re probably aware, can cause problems at the turn of millennium as

two-digit dates are no longer sufficient to distinguish between, say, 1905 and 2005.

StarOffice’s two-digit date handling option enables you to set the start year, which defines

how two-digit years are interpreted by StarOffice.

The default setting is to begin at 1930 and end at 2029, which means that StarOffice will
interpret the date 01/01/30 as January 1, 1930, but the date 01/01/29 as January 1, 2029.
This doesn’t entirely solve the Y2K dilemma, but it does loosen the noose a bit. It’s recom-
mended that you set the start date as close to the current date as possible—but think care-
fully about the date you choose, as this will affect all date handling of spreadsheets you
import into StarCalc. Let’s say, for example, you set the start date as 1960 but you were
born in 1955. If you've imported an Excel spreadsheet that automatically calculates how
many years until you can collect social security, you’ll find that you haven’t even been born
yet and have to work another 101 years!

The dates you select here also affect how file dates are interpreted; so, consider the age of
non-StarOffice computer files that you regularly access.

Getting Online

"To take advantage of all that StarOffice has to offer, you need to connect your desktop to
the outside world. While you can choose to run third-party mail, news, FTP, and browser
applications, StarOffice has good built-in Internet programs. The advantages of StarOffice’s
total Internet integration are particularly great when running StarOffice on a network.
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If you run StarOffice all the time and remain online, you can do it all right from your desk-
top—automatically download new email from your server, browse the Web, send a draft
document as email to a colleague—not to mention synchronize your schedule with col-
leagues on a common StarSchedule calendar! There are some technical issues to consider,
though, so read on before making any decisions.

If you connect to the Internet through a modem, telephone line, and ISP, you must have a
dial-up networking program installed on your system that you’ve set up to dial your ISP.
This section assumes you are either connected to a LAN or have already set up your dial-up
networking.

You now have two choices for Internet setup:

= New to 5.1, you can use the Internet AutoPilot, a wizard that guides you through the
process. The AutoPilot starts automatically the first time you launch the program and
can also be started anytime by choosing the File, AutoPilot, Internet Setup command.

= You can enter settings and create mail and news accounts manually. Internet and brows-
er settings are entered in the Tools, Options, Internet and Tools, Options, Browser dia-
log boxes (respectively). Mail and news accounts are created via context menu
commands in the Explorer.

While the AutoPilot makes getting online easier, it’s still a good idea to understand how to
create and configure accounts manually as you may want to create additional Inboxes or
change settings that you can’t access via the AutoPilot. There are also some technical issues
to consider in configuring your account and choosing your default Internet programs. It’s
therefore recommended that you read the entire “Getting Online” section.

If you have multiple mail accounts to manage, setting them up can be confusing in
StarOffice because of the way the program uses Inboxes and Outboxes. If you have more
than one email account, refer to “Managing Multiple Mail Accounts” in Chapter 29,
“Communicating with StarMail and StarDiscussion.”

Setting Up Your Internet Accounts with the Internet AutoPilot

An Internet AutoPilot (shown in Figure 3.7) greets you when you first launch the program
to ease you through the intial steps of configuring your Internet accounts in StarOffice.

If you want to defer configuring your Internet connection until later, click Don’t Use the
Internet. You can run the AutoPilot again at any time by choosing File, AutoPilot, Internet
Setup. (You can also use this AutoPilot to change your settings.) Alternatively, you can set
up your Internet account and create your own mailboxes and news accounts manually in the
Explorer, with methods that are described later in this “Getting Online” section.
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Considerations in Choosing Your Default Internet Programs

The program you choose to serve as your default browser is not that important if you are

only online intermittently and open your Internet programs each time you connect. It
becomes more important if you are continuously connected, whether through a local area

network (LAN) or intranet, or a dedicated connection to an Internet Service Provider (ISP).
Your default program will run in the background all the time, managing your Internet and
network services.

If you’re running StarOffice from your local drive, keep in mind that StarOffice is compara-
tively memory-hungry, so consider your needs carefully. If you need only to be connected to
email and you have less than 64MB of RAM or a less powerful processor, you might be bet-
ter off running a less demanding program (such as Pine (Linux) or Eudora Lite (Windows))
as your default email client. You then won’t need to run StarOffice or have it online all the

time. On the other hand, if you’re using StarOffice as your regular desktop work environ-

ment, you'll save memory and take advantage of its integration if you use it routinely for all
your connection needs instead of opening other programs on top of the StarOffice desktop.

If you are running StarOffice off a server on a regular workstation installation, memory
demands will not be an issue.

You should also be aware that StarOffice mail and news files can get very large very quick-
ly—larger than you may be used to with other programs. If you choose to use StarOffice for
these tasks, make sure you have ample space on the partition or drive where you're storing
these files. The default path is Office51\Store; you can change this path in the Tools,
Options, General, Paths dialog box.
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Selecting Your System Default Internet Programs
The first step in completing the Internet AutoPilot is to choose if you want StarOffice to be
your default program for handling any or all of your Internet needs.

If you want StarOffice to handle any of your Internet chores on a regular basis, click the
Use StarOffice as Default Internet Application option.

"This option sounds more global than it is. Once you select it, the grayed-out list of choices
in the lower part of the dialog box becomes active, enabling you to select only those chores
you want StarOffice to handle.

You can set StarOffice to be your default for any of five tasks:
= Web browsing
» Email client for POP3, VIM and IMAP accounts
= News client
m FTP client
m Safe HTTP connections (secure HTTP)

Secure HTTP is an extension to HTTP which provides a number of security features, includ-
ing Client/Server Authentication, Spontaneous Encryption, and Request/Response
Nonrepudiation.

This section focuses on using the AutoPilot. Later sections in “Getting Online” offer more
detailed technical explanations of Internet accounts.

Once you select StarOffice to be your default Internet application for a specific task or type
of file, StarOffice will be your system-wide default. For example, if you select StarOffice to
be your default browser, anytime you open an HTTP file on your system or activate a
script to access the Web, StarOffice will automatically start (if it isn’t already running) and
open the selected file or URL.

If you don’t choose StarOffice as your default Internet application, you can still use any
StarOffice’s Internet capabilities from within StarOffice.

Equally, if you do choose StarOffice as your default application, you can still open and use
other applications for those tasks. However, be sure StarOffice is offline to avoid conflicts.

Make your selections by clicking the checkbox(es) next to the option(s). When you’re done,
or if you don’t want StarOffice to handle any of Internet chores at all, click Next to move
to the next dialog box, shown in Figure 3.8.
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Importing Settings and Mailboxes from Other Programs

If you run either Netscape Communicator, or MS Internet Explorer and/or Outlook
Express, the Internet AutoPilot automates the process of importing existing email inboxes
and outboxes and browser settings from these programs (see figure 3.8). Importing these
settings and files is not the same as integrating these programs into StarOffice and its
menus, however. When carrying out tasks with StarOffice menus and commands, you’ll still
use the StarOffice modules for browsing, email, FTP, and news accounts—unless you open
the other program within the StarOffice desktop and run it as you would normally.

New to 5.1, you have the option of integrating the MS Internet Explorer browser into
StarOffice’s desktop. This option must be selected at the time you install StarOffice, and MS
Internet Explorer must be already installed on your system. If you have already installed

HH StarOffice but want to use this feature, you'll need to deinstall StarOffice and reinstall it as Part
— a custom installation. |
WINDOWS
Ch
Regardless of your selection, if you have MS Outlook Express on your system, you can send 3

mail through it directly from the desktop using the Explorer Send command.
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If you choose not to import settings and mailboxes from these other programs, you can set
up new, separate accounts and mailboxes within StarOffice.
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Tip #34 from
Michael & Farah

It can be useful to maintain different mail or news accounts in different programs. In case
you want to exchange files between them, it's handy to know that StarOffice imports MS
Outlook Express and ASCII files directly from the Explorer, and exports only in ASCII format.
You can also always import Netscape or MS Outlook Express mailboxes again using the
AutoPilot (although the imported mailbox will overwrite the existing one for that account).
StarOffice’s Address Book is a dBase database file that will import easily into many contact
managers and email programs, including MS Outlook Express. Netscape doesn’t do as well
either importing or exporting address books.

Importing Settings Automatically If you select one of the two programs and the Apply
All Settings Automatically, and click Next, StarOffice will automatically import all Internet
settings from your selected program as well as any existing mailboxes and news folders.

StarOffice will not import any subfolders you have created in your Outbox(es). StarOffice’s
Outbox is built differently. You can't create subfolders in its Outbox, only direct your sent
mail to regular folders via filters set in the Outbox properties, where each message exists
as an individual document file.

If you’ve taken the automatic route, you’re almost done! The AutoPilot presents you with a
screen that summarizes what actions StarOffice is about to take, similar to the screen shown
in Figure 3.9. Clicking Create gives it your permission to proceed.

Figure 3.9
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Skip ahead to the section “Creating Your Accounts with AutoPilot” to see what happens
next.

For information on working with StarMail (email) and StarDiscussion (news groups), you should begin
with “Orienting Yourself in StarMail and StarDiscussion,” p. 1046.

Entering Settings Manually If you’re the sort who likes to have more control over your
setup, you can choose the Apply Single Settings / Manual Selection option (refer to Figure
3.8). This will step you through three additional dialogs—one for your browser, one for
email, and one for news—that enables you to pick and choose how your Internet settings are
configured.

Taking the manual route gives you two options:

= Importing all your settings automatically, but mixing and matching between Netscape
and MS Explorer or Outlook Express

Part
= Entering some or all of your settings directly |
If you choose the latter option, you should be prepared with the following information: Ch
= For manual browser setup (LAN users): proxy settings for your browswer, if any. Ask 3

your system administrator for your network’s settings.

= For manual email setup: your incoming (POP3, IMAP, or VIM) and outgoing (SMTP
or VIM) mail server names; your user or login name; and (optional) your password.

= For manual news subscription setup: the address of the news server

After you’ve selected the manual option and clicked Next, you’ll see the dialog box shown in
Figure 3.10 that prompts you for browser settings.

You can choose to have no browser settings configured at this time, to enter your settings
manually, or to import them from Netscape or the Internet Explorer. You need only choose
to configure your settings manually if you’re on a network and need to enter settings for a
proxy server. Otherwise, choose No Browser Settings or import them from an existing pro-
gram. Regardless of which option you choose, you’ll want to check and adjust an extensive
set of browser configuration choices later via the Tools, Options, Browser series of dialog
boxes.

For more information on configuring your browser, see “Fine-tuning Your Broswer,” p. 105.

When you’re done establishing your browser settings, click Next to move ahead to the email
settings dialog box. You’ll have the same set of choices: applying no settings at all, importing
from available programs, or entering your email account information manually. If you
choose to enter your settings manually and click Next, you see the dialog box shown in
Figure 3.11, which prompts you to enter your basic account information.



Figure 3.10
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Figure 3.11
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Just click in a text entry box and start typing. You can enter any name you like as your
account name, which is simply the name your account will display in the Explorer
Email/News group. The remaining information you should have from your ISP. Note that
you don’t have to enter your password here. If you choose not to, StarOffice prompts you to
enter it every time you log on from within the program.

Later, you can create as many additional Inboxes from the Explorer as you like. However,
you can create only one Outbox. The reasons for this are explained in “Creating Mailboxes”
later in this “Getting Online” section.

If your username requires you to use the @ symbol, be sure you enclose your full name in
carets, like this: <roadrunnereacme . com>. Otherwise, StarOffice will choke on the @
symbol.

Click Next when you’ve finished typing, and you’ll be faced with the next-to-last dialog box
(shown in Figure 3.12), where you can enter news settings. Here again, you enter an
account name and a server name—but this time a news server name. You can enter the
name of any publically accessible news server; it doesn’t have to be the one run by your ISP
or network. For example, in Figure 3.12, the StarDivision server,
stardivision.starnews.com, was entered.

Part
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Once you've entered the required information, click next to take you to the final dialog,
which looks similar to the one shown earlier in Figure 3.9. Check the summary of your
selections, and if you’re satisfied, click Create to complete the setup process. If you want to
make any changes, just click Back to step back through the process. Click Cancel to abandon
all settings and return to the desktop.

Creating Your Accounts with the AutoPilot After you click Create, depending on
how large your mail and news files are, it may take StarOffice a few minutes to complete its
work.

It will automatically create a mail Inbox and Outbox for you in the Explorer Email/News
group, enter relevant browser settings in the Tools, Options, Browser series of dialog boxes,
and enter your basic Internet connection information in the Tools, Options, Internet series
of dialog boxes. To open your mail or news account, first open the Email/New group in the
extended Explorer by clicking the group title bar. If your group is set to icon view, click the
mail or news account you want to open on your desktop (or Ctrl+click if you want to open it
on top of other open documents). If it’s set to Hierarchical view, double-click (or Ctrl+
double-click) to open it.

Tip #35 from

Michadl & Caral If you have your mail and news group set to Hiarchical view, you can display a list of indi-

vidual messages or news items by selecting the Display Contents command on the group’s
context menu.

Modifying and Customizing Your Internet Connection

While your default and/or imported Internet settings may be just fine for you, there are
many settings you can modify and customize to better suit your network needs. In case you
experience connection problems, you may also need to make adjustments to these settings.

"To enter or change Internet settings, open the Tools, Options master dialog box and click
the plus sign next to the word Internet. You’ll see a list of five dialog boxes, each of which is
discussed briefly below.

Modifying and Customizing Mail and News Settings

Figure 3.13 shows the Tools, Options, Internet Mail/News dialog box. This dialog box saves
your default Internet connection information. These settings are used to determine how all
outgoing mail is routed, as well as email sent from the desktop (that is, without opening a
specific account Inbox). Changing these settings will not delete or otherwise change any
existing Inboxes you have; it will only change the routing of mail.
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You can choose here to set defaults for email file formats. Messages are always sent in ASCII Part
format; you can also choose to send them in any of three additional formats: HTML, RTE, I

or StarOffice. Creating mail in these formats allows you to format your message in more

sophisticated ways, such as applying bold face or italics. If you select one or more of these Ch
options, the default will be set to send your message in both ASCII form and the selected 3
format(s). (However, you can change your options for a specific message from within the

StarMail composition window.)

Only select an option if you know you need it. Many email accounts and newsgroups accept
only standard ASCII text messages, and your HTML, RTE, or StarOffice copy might not be
readable by your recipient. Choosing one of these formats also increases the size and trans-
mission time of your message substantially. Besides, it’s not polite to clog up someone’s
mailbox with fancy-formatted mail messages they can’t read.

[ For a discussion of these different formats and their uses, see the section “Creating and Sending Mail,”
p. 1053.
If you check the Autoload option, the contents of news postings automatically appear in
your viewing window when you open your news Inbox and begin to scroll. If you check
Automatically Mark Mail as Read, you can set your mail to be marked as Read after a time
delay you specify—anywhere from 0-999 seconds.

Changing Proxy Settings

You can change proxy settings in the Tools, Options, Internet, Proxy dialog box. Some net-
works use a proxy server as a kind of cache in order to ensure network security and improve
performance.

If you work on a network, ask your MIS computing support guy or gal or your ISP support
contact about your proxy configuration. If you are told that you do not have one, select
None. Otherwise, enter the settings as instructed.
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Adding Web Search Engines

The Tools, Options, Internet, Search dialog box contains the names and site addresses of
Web search engines that you can call up from a handy shortcut menu that you open with the
Find button on the Hyperlink toolbar. A number of common search engines are already list-
ed. You can delete these entries and/or add new ones.

Adding LDAP Directories

The Tools, Options, Internet, LDAP Server dialog box contains names of Web directory
services (the Web version of phone books) that you can search from the StarOffice Address
Book dialog box. The only default entry is the Four11 Directory. Once you locate an address
in one of these directories, you can automatically add it to your own Address Book as well.

Modifying Your Internet Protocols

The Protocol dialog box contains options that define how you connect to servers. The
Domain Name Server (DNS) translates a human readable Internet addresses such as
(www.stardivision.com) into the real Internet Protocol (IP) address (209.0.29.180). If the
option is set to Automatic (the default), StarOffice automatically reads the DNS server’s
address from your operating system settings. If the option is set to Manual, you can manual-
ly enter a DNS IP address as provided by your ISP. Most users will want to leave this option
set at Automatic.

Tip #36 from

; Your default Internet settings and ISP information are all saved in the soffice. ini file
Mickae! & Sarah 9 soffice.ini

(Windows) or sofficerc file (Linux) located in your root StarOffice directory (0ffice51 is
the default). They can be checked and edited manually by advanced users.

HTTP and FTP servers are servers you use to connect to the WWW and FTP sites,
respectively. You can be connected to more than one HT'TP or FTP server at a time; this
allows you to download something from one site while you’re browsing a Web page from
another. The defaults are four HTTP sites and two FTP sites. Don’t increase these defaults
unless you have a good reason, because the more sites you connect to at once, the more
likely your browser or FTP connection is to crash.

HTTP stands for Hypertext Transfer Protocol, and FTP stands for File Transfer Protocol. They
are two languages (protocols) used for communication between computers on the
Internet.

Creating Mailboxes

When you send and receive snail mail (computer lingo for that quaint artifact, a stamped,
paper letter), you can use the same mailbox for incoming and outgoing mail. When you
send and receive email in StarOffice, you use separate Inboxes and Outboxes.
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Your Inbox receives and (if you download your mail from the server) stores mail people send

you. This Inbox also directs your outgoing mail under certain conditions. (See “Setting Up
Multiple Accounts” in this chapter for more information).

Your Outbox processes all your outgoing mail. Messages you write and defer sending while
offline are stored in the Outbox until you go online again. Copies of every message you suc-
cessfully send are automatically saved here as well.

All incoming and outgoing mail and news files are saved in the \Office51\Store folder (with
the . scs extension). You should frequently browse through your saved mail in the Inboxes
and Outbox and delete old mail that you no longer need in order to free up space on your
hard drive. If you need to keep a lot of your old mail or news messages, keep an eye on
the size of this folder, as it might quickly outgrow the size of your assigned partition for

StarOffice. If necessary, assign a different path (on a different partition or hard drive) using Part
the Mail/News Storage category of the Tools, Options dialog. |
Ch
You create Inboxes and Outboxes from the Explorer context menu New command (see 2]
Figure 3.14).
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subscriptions.

If you used the Internet AutoPilot to set up your accounts initially, a Mail/News group was
created for you automatically in the Explorer. If you don’t have such a group, it’s a good

idea to create one as it’s easier to manage your mail and news if it’s in the same place.

However, when you create mailboxes manually, you can put them anywhere you like.

Tip #37 from
Michael & Farah

Storing all your mail in one big Inbox or Outbox gets unwieldy pretty quickly. By setting
rules to sort and filter your mail, you can store incoming and outgoing mail messages in
different folders anywhere on your network or directory. Create and apply rules through
the Inbox and Outbox context menu Properties command (Rules and Views tabs).

[0 For more information, see the sections “Using Filters to Manage Files,” p. 197 and “Techniques for
Managing Mail and News,” p. 1075.
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Creating an Account Inbox

What StarOffice separates on the Explorer context menu as POP3 Account, IMAP Account,
and VIM Account (refer to Figure 3.14) are really just three different routes to the same
end: creating an email account Inbox. This Inbox is the mailbox that receives and (if you
choose) stores all your incoming mail for a specific account. There are three separate com-
mands because each type of account works with a different mail protocol and can be
assigned slightly different properties.

Linux users who were frustrated with the lack of IMAP support in version 5.0 will be glad to
know that improved IMAP support for Linux is one of the major features of the 5.1 release.
However, if support for a particular IMAP Server is critical for your ability to use StarOffice

as an email client, check before you commit to using StarOffice, as it still does not support

a full range of IMAP Servers.

Because POP3 accounts are the most common type, we’ll use creating a POP3 account
Inbox as an example here. The process and principles of creating an account Inbox are pret-
ty much the same, regardless of its type

Before you create your mail account Inbox, you need to know:

= The type of mail protocol your ISP or server uses to manage mail
= The names of your incoming and outgoing mail servers

= Your email and newsgroup password(s) (optional)

POP3, IMAP, and VIM are the three most common protocols for managing incoming mail.
POP3 is popular with commercial ISPs oriented toward individual dial-up connection,
whereas individual users download mail and store it on their own hard drives. IMAP is
used by many UNIX and Linux computing environments, as it assumes mail is being stored
and managed on a central server. VIM is the mail protocol used in Lotus Notes and cc:Mail,
and is used on many corporate intranets. If you aren’t sure or can’'t guess what protocol
you use based on this information, ask your ISP or network administrator.

[ For in-depth discussion of using StarMail to send and receive mail and manage newsgroups, see
Chapter 29, “Communicating with StarMail and StarDiscussion,” p. 1045.

After you have all your email account Inbox information at your fingertips, follow these
steps:

Select the group and/or folder where you plan to store your account.

Right-click to open the Explorer context menu.

Open the New submenu.

[ N R S

Select the name of the mail protocol your server or ISP uses to manage mail (POP3,
VIM, or IMAP). This opens a new account Inbox dialog box. Figure 3.15 shows a new
POP3 Account Inbox dialog.
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Figure 3.15 Properties of POP3 Account wE
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If you want to create an Inbox for a different account, select the current information
and type over it. Replacing this information here has no effect on the information you
saved in the Tools, Options, Internet, Mail/News dialog box or your user data.

You can leave the password blank if you’re concerned about security. As long as you
haven’t saved your password in the Internet dialog box or an Outbox, you’ll be prompt-
ed for your password each time you connect and it won’t be saved.

6. The Send tab enables you to determine how outgoing mail is routed. If you only have
one email account, your Outbox settings will determine how your outgoing mail is sent
(As Outbox Settings option). If you have multiple mail accounts, you will want to select
the User-defined Settings option, click the User-defined settings button, and enter the
appropriate information for your second account. For more information, see the section
“Managing Multiple Mail Accounts” later in this chapter.

7. Click the General tab and enter a name for the account. If you don’t assign a name,
StarOffice automatically names it after your mail server.

8. The Rules and View tabs enable you to create filters to manage your Inbox messages.
(Learn about using these commands in Chapter 5, in the section “Using Filters to
Manage Files” and the section “Techniques for Managing Mail and News” in
Chapter 29.)

9. The Headers tab enables you to determine what header information displays when you

read incoming mail.

10. Click the Contents tab (see Figure 3.16). Here you can set your Inbox to automatically
check your mail server and download your mail at an interval you specify, as well as
update every time you click the Update command in your Inbox’s context menu.
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Figure 3.16
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Tip #38 from
Michael & arah

If you're not continuously online, you might want to set the update time interval to 0.
Otherwise, if you forget go offline from within StarOffice (by clicking the Online button on

the function bar so it does not look pressed), StarOffice will keep looking for a connection,
taking up system resources, and generating connection error messages.

11. You also set your mail storage options here—a very important setting. To set these
options properly, you need to understand what happens when you open your Inbox to

read your mail.

When you open your Inbox, StarOffice copies the headers of your mail messages (the
"To, From, and Subject lines, along with some technical information) from your mail
server into a temporary file called a cache and makes these headers visible in your Inbox.
When you double-click a header to view the message, StarOffice fetches the message
contents from the mail server and allows you to view them. The message contents are

not stored on your machine—they’re stored on the mail server.

If you select Remove Messages from Server, every time you connect to your incoming
mail server (here, the POP3 Server) and read your mail, all messages will automatically

be deleted from your mail server after you’ve read them. POP3 accounts are designed

to be used this way.

If you select Store Document Contents Locally, complete copies of your incoming mail

messages will be downloaded and saved on your hard drive.

If you select Remove Messages from Server and do not select Store Document Contents
Locally, every time you finish reading an incoming mail message, it is automatically sent to

the Recycle Bin.

12. Click OK to confirm your entries. Clicking Reset returns the settings as they were on
opening the dialog box and leaves the dialog box open. Cancel returns the settings to

their original state and closes the dialog.
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You are now the proud owner of an (empty) email account Inbox.

To download, read, and reply to mail, double-click your Inbox icon in the Explorer. Your
account Inbox opens on your desktop, displaying any messages, and you are in StarMail.

Tip #39 from

) If you have the You Have New Mail! icon turned on in the status bar and are online contin-
Mickael & Sarah

uously and update automatically, a Globe icon in the icon tray will signal when you have
new mail. You can turn this icon on and off in the Tools, Configure, Status Bar dialog.

If you open your Inbox when you’re not connected to your ISP or network, you might get a
Connection Failure error message, or you may be prompted with your system’s dial-up
networking dialog—the program seems unpredictable this way. If you are connected but are

not in Online mode, the program sends you a message and asks if you want to go online. Part
Once you are connected and online, StarOffice logs in to your server and downloads your |
mail.

Ch
You can also check your server for new messages at any time by clicking Update on the con- 3

text menu, or clicking the Globe icon in your icon tray and choosing Update from its con-
text menu.

[ For more information on reading and replying to email, see “Creating and Sending Mail,” p. 1053.

Creating an Outbox from Scratch

If you used the Internet AutoPilot to set up your Internet accounts, you had an Outbox cre-
ated for you automatically and you don’t need to create another one. If not, you’ll need to
create one manually from the Explorer. You cannot send mail until you have an Outbox.

You cannot create multiple Outboxes for multiple accounts. While technically you can cre-
ate additional Outboxes, in reality these only enable you to apply different sets of filters to
your one and only Outbox.

[J For the steps required to set up your mail account to route mail through a different account, see
“Setting Up Multiple Accounts,” p. 103.

[ For the steps required to send outgoing mail through a different account, see “Managing Multiple Mail
Accounts,” p. 1067.
If you create your Inbox manually, StarOffice asks you on completion if you want to create
an Outbox. It’s a good idea to reply Yes and proceed because you can’t send any email until
you create an Outbox. To create an Outbox, you need to know the protocol your system
uses to send mail and news to your ISP or network server.

SMTP and NNTP are the dominant Internet protocols for sending mail and news, respec-
tively. VIM is the other major protocol, and sends both mail and news. If you don’t use
Lotus Notes or cc:Mail, you can assume your system communicates with SMTP and

NNTP.
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Here are the steps to follow to create an SM'TP Outbox from scratch; if you create your
Outbox directly after creating your Inbox, you’ll begin at step 3.

1. Select the folder where you want to store your Outbox settings.

2. Select Outbox from the Explorer context menu New submenu.

3.

4. Click the SMTP tab. Your server, username, and password should have already been

Enter a name for your Outbox in the General tab.

copied from your Internet settings. If they have not, enter the name of your outgoing
mail server, your email username, and (if you choose) your email password. (Your server
name will be something like smtp.wenet.com.) If you don’t enter your username and/or
password here, you will be prompted with a dialog box to supply them every time you
connect. These settings determine the default route for all your outgoing mail.

If you enter your password, others might be able to access your account without your per-
mission or knowledge.

5. If you entered an email address as part of your registration or Internet setup, that

box

address has automatically been entered into the Sender field of the SMTP tab. This
address appears in the Sender field of email messages you write from your default Inbox
or from your desktop. (If you have multiple Inboxes, your default Inbox is the Inbox
that uses the email address in your Tools, Options, Internet, Mail/News data.) If you
want return mail sent somewhere else, enter your return email address in the Reply To

Surround your email addresses with caret brackets, for example: <jlopez@wenet.com>.
If you don't use these brackets, StarOffice will choke on the @ symbol in your address.

You don't need to worry about any of the other tabs right now. The Rules and View tabs
will help you manage your outgoing mail later, and the NNTP tab relates to newsgroup
subscriptions. You've entered all the information you need to send outgoing mail.

6. Choose OK to complete the creation of your Outbox. Choosing Cancel cancels the

creation of the Outbox and returns you to the desktop; choosing Reset returns the
Outbox to its initial settings on opening and leaves the Outbox dialog box open.

If you use the VIM protocol, ignore the SMTP tabs. Enter your information on the VIM
tab and click OK. Otherwise, the procedure is the same.
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After you choose OK, your Outbox appears in the selected Explorer folder. You’re now
ready to send mail from your desktop. You can send mail from your Inbox or Outbox by
selecting the New, Mail command from the File menu, or by clicking the New Mail icon on
the StarOffice desktop.

To read and manage copies of your sent mail and news postings, double-click the Outbox to
open it on your desktop.

Tip #40 from

Michael & carah To open your Inbox and Outhox at the same time, double-click to open the Inbox on the

desktop, and then press Ctrl while double-clicking the Outbox.

[J For more information on sorting, filtering, and managing your Outbox mail, see “Techniques for
Managing Mail and News,” p. 1075. Part

Setting Up Multiple Accounts |

StarOffice manages multiple email accounts through account Inboxes. You can create as Ch

many account Inboxes as you want. (The program documentation, by the way, often refers 3
to account Inboxes as mzail servers because they contain information for receiving mail from
a server.)

Why would you want more than one Inbox? Perhaps you have more than one email
account. If you work on an intranet, for example, you might have one email account on
your company intranet for work mail and another account at a personal dial-up ISP account
that you sometimes call from work. Or maybe you maintain separate business and personal
accounts.

Creating Multiple Account Inboxes

Setting up multiple accounts is easy. Begin by following the steps in the earlier section
“Creating an Account Inbox.” Then follow these steps:

1. Assign the Inbox a different name than any existing Inboxes.

2. Input the name of the mail server for this second account in the Receive tab along with
the username and (if you choose) password. If there is already a username and pass-
word, delete them and enter your new information.

3. On the Contents tab, select the options you want for updating and storing your mail
for this account. (Refer to the section “Creating an Account Inbox” earlier in this chap-
ter for more information.)

4. Click the Send tab. Here you’ll enter information that directs mail you send from this
second account through the correct outgoing mail server.

5. The Send tab by default has the As Outbox Settings option chosen for both the SMTP
and NNTP accounts, as. When this option is selected, StarOffice automatically uses
the settings in your Outbox to route outgoing mail; you don’t want this option. Choose
instead the User-Defined Settings option for both (see Figure 3.17).
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6. Click the User-Defined Settings button on the lower right. This opens a new dialog,
shown in Figure 3.17, called Properties of Send Protocol.

Selecting the User-Defined Settings options is the key to sending your mail through a sec-
ond account. When—and only when—this account Inbox is opened on your desktop, this
option over-rides the default Outbox settings that normally guide the routing of your out-
going mail and sends them according to the settings in the Properties of Send Protocol dia-
log box (shown in Figure 3.17).
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This dialog box has two tabs: one for your SMTP account settings and the other for your
NNTP account settings. Delete any existing information that is not relevant, and enter the
correct server names, and (if you choose) username and password. Change the sender and
return address (Reply) as appropriate.

When you’ve finished, choose OK to confirm your settings, which returns you to your
Inbox dialog. Choose OK in your Inbox dialog box to confirm. You’ve now successfully set
up a second email account!

Regardless of how your outgoing mail is sent, all copies of your outgoing mail are saved
and stored in the same Outhox.
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[l For more information see “Managing Multiple Mail Accounts,” p. 1067.

Creating Multiple Outboxes
An Outbox has two different functions:

= It contains the default outgoing mail server address for routing your outgoing mail and
news postings, along with your username and password (if you’ve saved it) for that
server.

= It stores unsent mail and news postings and stores and filters all copies of sent mail.

You can create as many Outboxes as you like. However, all the Outboxes you create will

have the same settings because you can have only one default outgoing server in StarOffice.

If you create a new Outbox and enter new server information, username, and password in

the SMTP and NNTP or VIM tabs, this information automatically overwrites the existing Part
information in all your other Outboxes. |

To send outgoing mail through a different server, you don’t need to create a second Outbox. Ch
You manage this by creating a second account Inbox, as described in the section “Creating B
Multiple Account Inboxes.”

However, creating multiple Outboxes can help you deal with the mammoth task of sorting,
filtering, and filing all your sent email. By using the Rules and View tab options of your
Outbox properties, you can create different views of your sent mail, and create filters that
copy or move outgoing mail to different folders and locations.

The steps for creating a second Outbox are simple.

1. Select Outbox from the context menu New submenu.
2. Give your new Outbox a unique name.

3. Ignore the SMTP, NNTP, and VIM settings unless you want to change your default
Outbox settings. Settings you enter here will overwrite settings in any other Outboxes.

4. Set any rules or viewing options you want on the Rules and View tabs.
5. Choose OK.

Fine-tuning Your Browser

A browser is a program that reads documents created in HT'ML and can communicate via
the Internet hypertext text protocol (HTTP, the first part of every WWW address).
StarOffice has a built-in browser fully integrated with the program’s file searching and file
management tools. Just type or paste a WWW address into the URL Locator, press Enter,
and voila! The Web page appears on your desktop, where you can view it or email it like any
other StarOffice document. Pretty cool! This browser, together with StarWriter, is also
what you use to create, edit, and view HTML documents.
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Feature-wise, the StarOffice browser stacks up quite well against Netscape Navigator and
Microsoft Internet Explorer. You can define a wide range of browser characteristics, includ-
ing the size of your caches and how cookies and security are handled. If you installed the
Java RunTime environment, it also works with Java applets and JavaScript.

When you start StarOffice for the first time, you have the option of setting StarOffice as
your default browser. If you do, StarOffice will be the program that handles all your future
Web browsing on your system. Even if you choose not to set it as your default, however,
you can still use it to browse from your StarOffice desktop.

New with 5.1, you can integrate MS Internet Explorer 5 into your StarOffice desktop. IE5
must be loaded first, so if you want to integrate it but have already installed StarOffice,
you'll need to uninstall it, install IE5, and reinstall StarOffice.

All your browser characteristics are set in dialogs in the Tools, Options, Browser category
(look ahead to Figure 3.18). Note that settings in the Browser HT'ML dialog box also
determine the file format of HTML documents you create and export from StarOffice.

The most important dialogs to check during setup are Cache, Scripting, and Other, so
you’ll look at those first.

Setting Memory and Hard Drive Cache Sizes

WWW pages are complex documents that can contain graphics, video clips, sound, and
text. It takes time for such complex documents to travel across your network connection or
phone line. To speed and smooth your viewing, browsers store recently visited Web pages
both in system memory (RAM) and on your hard drive in caches of documents.

You can set the size of your caches on the Cache tab of the Browser dialog, as well as clear

each cache of stored documents and determine how often StarOffice compares a document
in the cache with the actual Web site. If you want, you can also do without a cache at all by
entering the name of your machine or server(s) in the No Cache For box.

As shown in Figure 3.18, the default cache sizes are 10 documents stored in RAM, with
10240KB (10MB) of space set aside on the hard drive. You can set your RAM cache from
0-999 documents and your hard drive cache from 0-500,000KB (500MB).

The sizes at which your memory and hard drive caches are set affect the speed of your
browsing. Another consideration is that if cache sizes are too low or too high, you might
experience crashes. You also don’t want to set your caches too high because you don’t want
to take up all your system resources—you need RAM and hard drive space for your other
applications as well.
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After you’ve loaded a Web page into your StarOffice Web browser and it’s saved in a cache,
StarOffice doesn’t necessarily keep going back to the original site to see if anything’s
changed. If you want StarWeb to always compare a page in the cache against the original on 3
the site, select Always in the Verify Document drop-down menu. If you select Never or

Once per Session, you’ll need to click the Reload button on the function bar to freshly

reload the page from the original site.

Ch

Clearing Documents from Your Caches

Because StarOffice caches Web documents as you browse, you can build up a lot of clutter
that you don’t want. Also, if you’re having memory management problems or your system
has been crashing frequently, you might want to clear your RAM cache at intervals while
you’re browsing. You can manually clear all files currently stored in your RAM or hard drive
caches with the two Clear buttons on the Cache tab. Even though the buttons have the
same name, they serve different masters—the top Clear button clears the RAM cache, while
the bottom button clears the hard drive cache (refer to figure 3.18).

Enabling Java

Fava is a computer programming language that runs on all machines regardless of their
operating system. Many Web sites have mini-programs called Java applets that run when you
visit or carry out specific actions on the site, and will work properly only if your browser can
run Java.

StarOffice works with Java if you have installed the Java RunTime environment (an option
at initial installation), and if Enable is selected in the Java section of the Other dialog, shown
in Figure 3.19.
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Figure 3.19 Options - Browser - Other mE
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Tip #41 from

Selecting the Enable Security Checks option is a good idea if you're running Java programs
because StarOffice then checks the source of the program and alerts you if it seems
suspicious.

Michael & Garah

Because a Java applet is a program from a foreign source entering and running on your
computer, it can pose a security risk, especially if you are on a network. As a safety feature,
you can determine the type of access applets have to your network—None at All, Host (the
same access as your computer), or Unrestricted (total access to the network). Unless you
have a specific reason to allow unrestricted access, you’re best advised to set this to Host or
None.

Setting Your Browser Home Page

The function bar has a button called Home that instantly takes you to the page designated
as your home page. Your default home page is the main StarDivision page at

www . stardivsion.com. In the Other dialog box, you can change your default home page to
any page you like—just delete the StarDivision address and enter your new URL into the

URL box (refer to Figure 3.19).

Selecting How Scripts Are Handled

Some Web sites have scripts, miniature programs, attached to them that are designed to run
on your machine when you connect. While most scripts are benign and do things such as
help process online orders or register you for a site, some scripts are nasty and carry com-
puter viruses or do things you might not want. With the Scripting dialog box in the
Options, Browser category, you can control, to some extent, how scripts are handled by your
browser.

StarOffice recognizes two types of scripts: JavaScript, which is the most common Web
scripting language, and StarBasic scripts, which are used on StarDivision’s sites (as well as
other sites created with StarOffice). JavaScripts are in the same family as Java applets (dis-
cussed earlier in the section “Enabling Java”).



Fine-tuning Your Browser | 109

If you select Enable JavaScript, StarOffice will run all JavaScripts it encounters during
browsing.

With StarBasic scripts, you have a greater level of control. You can choose to not recognize
them at all, to run scripts only from a list of authorized sites that you maintain, or to run all
encountered scripts. The default option is to run scripts from authorized sites.

Because your local drive is treated just like another node on the Internet, you must have
either the From List or Always Execute options checked to run StarBasic scripts on your
computer. A script on your own computer is listed as private:nameofscript.

Some sites will not function properly if you do not execute their scripts. Part
Managing Plug-ins Ch
A plug-in is a program that works together with your browser to extend its capabilities to 3

open different types of files. Common plug-ins include the RealAudio player, which enables
you to listen to radio over the Internet or even watch TV, zip programs that automatically
unzip downloaded program files, and document-viewing programs that allow you to open
email file attachments.

At installation, StarOffice checks your system to see if you have a Netscape or MS Internet
Explorer installation. If you do, it automatically uses these plug-ins in StarOffice as well.
You can view the list of currently loaded plug-ins and add new ones on the File Types tab.

If you do not currently have a browser installed, you might receive an error message on
startup saying that StarOffice could not load its plug-in manager and prompting you to run
Setup with the -repair option (Linux) or choose the Repair option on the wizard
(Windows). Running repair will have no effect because you don’t have any plug-ins for
StarOffice to find. StarOffice will still run without plug-ins, but some browser functions will
be unavailable and you may not be capable of opening some types of email attachments.

A plug-in automatically opens any files with file extensions that have been assigned to the
plug-in. The File Types list shows all the file types StarOffice currently handles. You can
change the association of a specified file type with a plug-in or add new file types by enter-
ing the MIME type and file extension, and then choosing the plug-in and plug-in filter you
want to open that type of file. Choose Replace to replace a current file type association, or
choose Add to add a new one.

Select Open with Plug-In, and then click the drop-down Filter menu to see the complete
list already in your version of StarOffice.
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For plug-ins to work, Enable must be checked in the Plug-Ins area of the Other dialog box
in the Tools, Options, Browser category.

You can also associate StarBasic macros and StarOffice application modules with specific file
types by choosing Other from the Open With drop-down menu, or browse on your local
drives and attach executable programs stored outside the StarOffice directory by choosing
External from the Open With menu.

Choosing Cookie-Eating Options
A cookie is a piece of data that a Web site sends to your browser. It stores certain information
about you that the site wants every time you connect (for example, perhaps your browser
type, name, and email address). Cookies speed up connection time. They have roused some
controversy about privacy because you don’t actually see what’s in a cookie. However, cook-
ies can’t reveal any information you have not already given to the Web site.

If you select Accept on the Cookies dialog box (Tools, Options, Browser category),
StarOffice will always accept cookies. If you select Confirm, you will always be asked if you
want to accept a cookie, whereas Ignore ignores all cookies. Also, all cookies currently saved
in your cache display in the list. You can select cookies and either delete them with the
Delete button or choose to ignore them with Ignore.

Showing a fierce kind of hospitality, some Web sites don’t allow access if your browser
doesn’t accept cookies.

Selecting HTML Document Formatting

In the browser HTML dialog box (Tools, Options, Browser category), you can determine
how HTML pages are imported and exported from StarOffice, as well as the displayed font
sizes of Web pages. The export settings affect the appearance of HTML documents you
create in StarWriter\Web as well as documents you export in HT'ML format.

Because Web pages have to display on many different kinds of systems, they don’t handle
fonts in the same way as regular documents. Instead of having specific fonts embedded in
them, they refer to font sizes that range from Size 1 (smallest) to Size 7 (largest). You can
set the font size StarOffice assigns to each of these sizes and thus determine how large the
type of a Web page is onscreen. The maximum font size is 50 points.

Handling Security with Site Certificates

Many people now shop over the Web and send confidential financial information, such as
credit card numbers, which need to be kept secure. Remember those secret decoder rings
from childhood? Well, one way of securing this information from snoopers is to encrypt it—
provide your computer with a secret decoder ring through a site certificate system—so you
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can send valuable information safely. There are a number of third-party companies that
manage site certificates for Web sites, each with their own encryption system. You can
determine what type of site certificates StarOffice accepts by editing the list of these compa-
nies on the Site Certificates tab.

Managing and Importing Bookmarks
Browser bookmarks are managed from the Explorer Bookmarks folder.

When you install StarOffice, it tries to locate any existing bookmarks you have and automat-
ically places them in the Bookmarks folder. If you have bookmarks that don’t make the cut,
you can create a link to them in the Bookmarks folder or somewhere else in the Explorer so
you have all you need at your fingertips.

I For more information on the Explorer Bookmarks folder, see “Default Explorer Contents,” p. 51. -
ar

Configuring Your Document Options -

You can also find dialog boxes in the Tools, Options dialog box that enable you to set all 3
kinds of options related to how you work with the seven basic StarOffice document types

(text, HTML, spreadsheet, presentation, drawing, formula, and image). Setting these

options is mentioned where appropriate in the individual chapters or sections that deal with
StarWriter, StarCalc, StarImpress, StarDraw, StarMath, and StarImage.

You can also turn on the Help Agent, which guides you through most of these options as
you click your way around the dialog box tabs. Be sure to turn on Extended Tips in the
Help menu as well; moving your pointer over options will then make visible basic descrip-
tions of tool functions.

Setting Program Template Defaults

Almost every program module in StarOffice—StarWriter, StarCalc, StarDraw, StarImage,
StarImpress, StarMath, StarChart, StarMail, and StarWriter\Web—has a default template,
called the Standard template. There are also default templates for a Master document (a
special kind of document you can create in StarWriter), and a Frame document (a special
kind of Web document). These templates define the basic properties of a new, blank docu-
ment of that type, including fonts, colors, styles, and document margins. A template also
includes the definition of the default desktop work environment for that document type—
toolbars, menus, keyboard shortcuts, and so on.

You cannot delete the Standard templates nor can you edit them directly as files (although
you can add your own custom styles and customize your workspace from inside a docu-
ment). However, you can assign a document template of your own to serve as the new
Standard template in the stead of any of the program default Standard templates. The tem-
plate you assign will be the template that opens every time you choose the File, New com-
mand or double-click one of the new task icons from the StarOffice desktop.
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"To make your own template the default, follow these steps:

1. Open the folder that contains the document you want to set as the template, either on
the desktop or in the Beamer.

2. Select the file.

3. Right-click and choose Set Default Template. A submenu will open that lists the match-
ing StarOffice template.

4. Select the template icon.

Customizing Your Desktop

Because StarOffice offers so many ways to customize your workspace, sometimes settings
commands are spread out across various menus and dialogs, such as those for changing the
look of your desktop, which can be found in three places:

= The Desktop context menu
= The Options, General, Desktop dialog
= The Options, General, View dialog

Methods for achieving other kinds of desktop customization, such as adding and deleting
items from the Start menu and setting non-StarOffice programs to start when StarOffice is
launched, don’t involve commands. However, they do involve understanding StarOffice’s
directory structure and special program directories, things that may not be intuitively obvi-
ous to a new user.

This section guides you through desktop customization specific to the general desktop envi-
ronment. It does not exhaust the customization possibilities, but once you understand the
general principles and procedures, you will quickly be able to customize almost anything
you encounter in your StarOffice workspace.

Setting Desktop Properties

Every object on your desktop, including your desktop, has properties that you can see and
change through the Properties command on the context menu. (Be sure you've selected the
correct object first.) The desktop Properties dialog, like all other StarOffice objects, has
Rules, View, and Contents tabs which allow you to create viewing and saving filters, and
determine if the object can be updated with the context menu Update command. Using the
options on these tabs is discussed in detail in Chapter 5.

Changing Your Background Color and Graphic

Buried deep in the back of the Properties dialog box is also a tab for changing the look of
your desktop background, (see Figure 3.20). With the Background tab, you can change the
background color of your desktop and assign a graphic to display.



Figure 3.20
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To open the Desktop context menu, make sure the default desktop is visible. Place your cur-
sor in the desktop and right-click it. Then choose the Properties command and click the Ch
Background tab. 3

At the top of the tab, next to the As label, is a drop-down box where can choose to set the
color (fill) or background graphic. (You can apply both a color and a graphic if you want, but
you choose each in separate dialogs.)

If you select Color, a Color Palette dialog box appears with a Preview window on the right.
The default setting is No Fill. To select a color, click it. Choosing OK exits the Properties
dialog box and returns you to your freshly colored desktop.

Tip #42 from

Michae! & Sarah

You can create your own custom desktop colors by blending colors in the Colors dialog
box in the General category of the Tools, Options dialog box.

If you select Graphic, the choices are more complex. Your first decision is whether you
insert the graphic as a copy or link the graphics file to your desktop. It’s usually best to link
it, as this requires less space and ensures your desktop display automatically updates when
changes are made to the original graphic.

You also have three choices of how to position the graphic:

» Position—Placed in a position you choose

= Area—Expanded to cover the entire area of the desktop

m Tile—Repeated in tiles to cover the entire desktop

If you select Position, a grid appears with a red dot it the middle and purple dots around the
perimeter. Click the purple dot that best represents the area where you want the graphic to
be placed. If you leave the red dot in the middle, the graphic will be centered.
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By default, the dialog box tab previews graphics in Wireframe mode. Click Preview to see a
thumbnail of the graphic. If you don’t know the exact pathname of the file, click the Browse
button and search your directories for the file you want to use. Be sure to click the Preview
button here as well if you want to take a look at the file.

Once you're satisfied with your selection, click OK to accept the graphic and return to the
desktop. If you don’t want to accept the changes, click Cancel to cancel all changes and close
the dialog box, or click Reset to return your original settings and experiment some more.

StarOffice includes a number of sample drawings as well as many graphics in the Gallery
that you can use as backgrounds—and of course, you can also create your own background
with StarDraw or StarImage.

Besides applying a graphic or background to your desktop, you can do the same to any fold-
er or object that opens on your desktop. This includes your Explorer groups. There is no
global way to set the background for desktop objects; you must set the properties individual-
ly for each object (unless you’re a clever programmer).

Setting Desktop Icon Display

In the Options, General, Desktop dialog, you can set the appearance and behavior of icons
on your desktop. If you select Free, you can freely move the icons around. If you select Snap
to Grid, they are arranged in alignment with the invisible grid that StarOffice uses to deter-
mine object locations in the program. If you select Auto Arrange, StarOffice automatically
arranges icons on the desktop so they are equidistant from one another and line up from left
to right, top to bottom. You determine the spacing that is used in the Icon Spacing spin
boxes in the next section. Note that the changes you make here affect the display of objects
only when you are in Icon view, not List view.

Customizing the Start Menu

The Start menu is really just a special folder within the office51\config directory. Items that
you move, copy, or link to the Start folder will appear on your Start menu the next time you
launch StarOffice. The More folder in the same directory contains the items that appear
when you choose More from the Start menu.

Setting Program Start-up Options

Right below the Office51\config\start folder is a folder named Startup. If there’s a particu-
lar program you always want to start simultaneously with StarOffice, create a link to the
program here. (It’s not a good idea to move the actual program file here, as that may inter-
fere with a variety of system and program settings.)

In practice, some programs won't start up properly. It’s a good idea to add links one at a
time, restarting StarOffice each time, to see if it works. It’s also not a good idea to start up
too many programs simultaneously.
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Other Custom Folder Options

Besides the Startup and Start folders, there are some other folders in the 0ffice51\config
directory that enable you to place shortcuts, templates, links, files, and folders where you
want them on your desktop:

» Tasks

= Helpmenu
= Groups

= New
Quickstart

The Tasks folder contains items that appear in the Tasks group in the Explorer. The

Helpmenu folder contains items that appear on the Help submenu that opens from the Start Part
button. Groups, as you might expect, contains all the group folders you create in the |
Explorer. You can easily create groups from within the Explorer, but it’s also handy to be
able to just drag and drop an entire folder (or a link to a folder) here and have it appear. The
New folder contains items found on the File, New menu, whereas the Quickstart folder 3
contains items that will appear in the quickstart area of the taskbar. (For more information

on the quickstart area, see “Understanding Tasks and Windows” in Chapter 2.)

Ch

Customizing Desktop Tools and Menus

In previous generations of software, the goal was to be user-friendly. StarOffice goes beyond
being friendly; it wants you to be like family, come in, take a look around, and start rear-
ranging the furniture. To that end, it makes customizing all your desktop tools amazingly
easy.

You do most of your customizing via the Configure dialog box. You can open the Configure
dialog box either from the bottom of the Tools menu or from the toolbar context menu. In
the case of toolbars, where you can construct your own from scratch rather than just add
and subtract elements, you also use the Customize dialog. Alternatively, you can do
on-the-fly toolbar customization using the Visible Buttons fly-out menu (new to 5.1).

In version 5.01 (the filter update), it was a known bug that creating custom menu configu-
rations could cause StarOffice to crash every time you attempted to open a menu—which
means you couldn’t configure your menus at all. This bug has been fixed in version 5.1, so
feel free to experiment. If you encounter problems with any customization such that your
program does not run properly, exit StarOffice, delete the soffice. cfg file from the
office51\ config directory, and relaunch the program. StarOffice will automatically gener-
ate a new, clean soffice.cfg file, and your program should run without problem.
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Using the Configuration Dialog

When you choose the Configure command, a multitabbed dialog box appears. (You can look
ahead to see an example in Figure 3.21). There are five tabs: Menu, Keyboard, Status Bar,
Toolbars, and Events. The basic procedure is similar for all five tabs, although there are
slight variations for each tab. For example, the Status Bar and Toolbar tabs don’t allow you
to assign commands, only turn on or off the display of specific tools. (You assign tool but-
tons through the Customize dialog.) With events, you cannot save a configuration file, only
assign events to the standard StarOffice configuration file.

This section gives a quick overview of the general procedure for configuring your desktop
tools and discusses the differences between each tab. The following section takes you
through the process of assigning or reassigning keyboard shortcuts step by step. Since the
process of assigning menu commands or events is essentially the same, for step-by-step
guidance, refer to the section on keyboard shortcuts. The instructions on saving and loading
configuration files in the keyboard shortcuts section are also relevant to the Status Bar and
Toolbar tabs, which are discussed in sections following the one on keyboard shortcuts.

For those of you already familiar with the concepts of direct and style formatting in docu-
ments, those concepts offer a good metaphor for understanding your choices in this dialog.
You can make new assignments in the dialog box and choose OK, which changes the set-
tings of the Standard program template (the equivalent of direct formatting). Or, you can
make new assignments in the dialog box and choose Save, which saves a new configuration
file under a name you choose (the equivalent of creating a new style).

[] For more details on style formatting and templates see Chapter 8, “Using Styles and Templates,” p. 291.

You'll find the same two sets of buttons on the lower portion of all the tabs. Aligned from
left to right on the very bottom are OK, Cancel, Help, and Reset. These buttons are com-
mon dialog box buttons across the StarDesktop. OK confirms your selections and completes
your interaction with the dialog; Cancel cancels the entire operation; Help opens the Help
Agent, which gives you (more or less) context-sensitive help tips; and Reset returns the dia-
log box settings as they were when you opened the dialog box.

Stacked in the lower right of all but the Events tab are the Load, Save, and Reset buttons.
These get more to the meat of this dialog’s special function:

= Load opens the \0ffice51\config directory and enables you to load a configuration file
that contains custom menu or keyboard shortcut settings for that program module.

= Save saves the current menu or keyboard shortcut settings in the dialog box as a config-
uration file in the \0ffice51\config directory, under a name of your choosing. Saving a
file in this way enables you to load the file at a later date, giving your desktop a custom
design.

= Reset is misnamed here, as it doesn’t do what Reset does in most other StarOffice
dialogs, or at the bottom of this very same dialog. Rather than resetting the values to
those in force when you opened the dialog, it resets them to the StarOffice program
defaults. (This button is usually logically called Default elsewhere in the program.)
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In the Keyboard, Menu, and Events dialogs, you’ll also see a list at the top of keyboard
shortcut keys, menu names and items, and events, respectively. Below each list you'll see a
list of function categories (or StarBasic modules) on the left, and commands (or StarBasic
macros) contained within the category on the right. In the case of keyboard shortcuts, you’ll
see a third pane to the right, which lists the currently assigned keyboard shortcut, if there is
any for a specific command.

Basically, you want to browse the Category list to find a category that seems to describe the
command(s) or macros you want to assign. All available program commands are listed in the
Keyboard and Menu lists, as are all StarBasic modules and any macros and program mod-
ules you might have created yourself. The Events list displays only StarBasic and program
modules. Then, browse the Commands list. When you find a command that you want to
assign or reassign to a key combination, add to a menu, or assign to a program event, make

sure its name is highlighted. Then look to the buttons in the upper-left portion of the dialog Part
box to guide your choices. I

In the case of keyboard shortcuts, you’ll click the Assign button. Note that if there is already ch
a different command assigned to that key combination, it will be replaced by your chosen

command. 3

In the case of menus, you can choose to add a new entry (New), replace an existing entry
(Modify), or create a new menu entirely (New Menu). Choosing Delete deletes the item
currently selected in the Menu list without adding anything new from the Command list.
The up and down arrow buttons move the currently selected item in the Menu list up or
down in the order of the menu. The dotted line symbol is a separator that creates a thin
border on your menu to help visually organize your commands.

In the case of events, you first can choose between three types of commands: those in
StarBasic, those in StarScript, or those in JavaScript. (The JavaScript category is empty
unless you have your own scripts that you’ve copied into the config directory.) The default is
StarBasic; a slew of built-in macros are listed and available here for assignment. When you
find a macro you want to assign, click Assign. The Remove button then becomes active and,
obviously, you click Remove to cancel the assignment of the macro to the event.

When you finish making your selections, choose the appropriate command at the bottom of
the dialog—Save or OK—and your new settings will either be saved to a new configuration
file, or applied immediately to your current program module desktop.

Assignments are module-specific not program-wide. Changes you make and save with the
OK button are saved to the default template for that module.

Customizing Your Keyboard Shortcuts

Assigning a command to shortcut keys or changing the default assignment of a shortcut is
extremely easy in StarOffice. You’ll be surprised at the large number of program commands
available for assignment. You also can assign your own StarBasic macros to a shortcut.
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It’s helpful to turn on Extended Tips in the Help menu before you start—you’ll then get
brief descriptions of these program commands as you move your mouse over their names in

the command list.

Also, it’s important to understand that while some keyboard shortcuts are commonly

assigned across StarOffice, assignments are actually application-specific. Therefore, the spe-
cific assignments you’ll see in the Keyboard list described will vary, depending on what type
of document you’re in when you open the Configure dialog. This means you can create dif-
ferent custom keyboard assignments for each document type.

[] For a complete listing of default keyboard assignments, see Appendix E, “Default Keyboard Shortcuts,”
p. 1429.
Here are the steps to follow:

1. Select the Tools, Configure command. A Configure dialog box opens (see Figure 3.21).
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2. Click the Keyboard tab. On the top of this tab is a list in the Keyboard section that dis-
plays all the current keyboard assignments. Notice that all the keys and key combina-
tions available for assignment are listed and many of them have nothing written next to
them. On the bottom of the tab is the Function section, which has three lists:

well, although not all).

Category—A list of categories of commands (many of them are menu names as

Commands—A list of all commands within the currently highlighted category.

Keys—The current key assignment (if any) of that command. There are a huge

number of program commands listed that you can assign to keys.
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Any StarBasic libraries you’ve created appear at the bottom of the Categories list, and
those commands can be assigned like any other. There are a few StarBasic commands
included with the program in this list as well that you might want to browse.

3. Scroll down the Keyboard list to find the key or key combination to which you want to
assign a command and highlight it.

4. In the Function section, select a category of commands you want to browse or select
from.

5. Scroll down the Commands list until you find the command you want to assign.

6. Click Assign. You'll see the name of the command appear in the Keyboard list and the
keyboard shortcut appear in the Keys list in the Function section.

At this point, if you change your mind, you can restore the assignments as they were when

you opened the dialog box by either choosing Delete while your new entry is still highlight- 't
ed in the Keyboard list, or by choosing the Reset button (Esc) at the bottom of the dialog. |
You can then make another selection following the same steps as earlier. ch
If you choose Cancel, not only are your changes canceled but the dialog box closes as well. 3

You can continue assigning keys until you’ve assigned all you want. Once you’re satisfied
with all your assignments, you have two choices:

= You can choose OK to confirm them and return to the desktop—Your assignments
don’t take effect until you choose OK. Choosing this permanently changes the default
keyboard assignments by writing them to the soffice.ini (Windows) or sofficerc
(Linux) configuration file.

= You can choose to save your keyboard assignments to a file with the Save
command—The Save command prompts you to save in the StarOffice Configuration
directory, which is probably the best place for you to do so. Leave the Automatic File
Extensions options checked so StarOffice is sure to recognize it as a configuration file
when you want to open it. When you save in this way, the original StarOffice defaults
are not changed because you have created a new, separate configuration file listing your
assignments.

You can then apply your new keyboard configuration with the Load command any time you
want. This enables you to create as many custom keyboard configurations as you like, so you
can create different configurations for different jobs

If you want to return to the default program keyboard assignments, load the soffice file
from the \config directory.

Configuring the Status Bar

You can also configure the status bar via the Configure dialog box. Open the Configure dia-
log box via the Tools menu or by right-clicking in a blank area of any toolbar.
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The status bar is the bar that appears at the bottom of your task window. Besides informing
you of the status of your document or desktop folder in StarOffice, it also contains the hid-
den treasures of shortcut context menus and shortcuts to dialog boxes. Get to know your
status bar, as it will help you work smarter, not harder.

Just as with all other aspects of StarOffice, status bar assignments are specific to each mod-
ule, so the choices you’ll see on the Status Bar tab will vary. Therefore, make sure you have
the document type open on your desktop whose status bar you want to configure.

When you open the dialog, you’ll see a list of all status bar items available for that program
module. All items marked with an X are currently selected and on display. Those items
without an X are not selected. If you have turned on Extended Tips, hovering over a name
with your mouse will pull up a brief description of that status bar item’ function. If you're
still unsure what an item really does, you can test it by selecting or deselecting it, clicking
OK, returning to your document or desktop, and seeing what appeared or disappeared. (It’s
easy enough to change the configuration back again.) Be sure you double-click and right-
click in a field to test its function. Be aware that some fields may not have any noticeable
function until you begin entering data into a document or carrying out specific operations.

Customizing Toolbars

New to 5.1, you can turn off and on the display of tools on-the-fly using the Visible Buttons
fly-out menu. Customizing couldn’t get much simpler. This menu is the place you should
begin if you’re looking for a tool that you just can’t find visible on your desktop but you
think should be there.

"To open the Visible Buttons fly-out menu for a specific toolbar, place your cursor in a blank
area of the toolbar and right-click. Move your mouse over the Visible Buttons menu com-
mand, and a fly-out menu will open (see Figure 3.22). This menu contains all the currently
visible buttons on your selected toolbar and their names, as well as a number of buttons that
are not currently turned on but activate commands relevant to that toolbar’s function. To
turn a button on or off, select its name in the menu.

There is no Visible Buttons menu for the desktop object bar. The buttons you see are the
buttons you get.

If you want to customize your toolbars in ways that are permanently saved to either your
Standard template or a configuration file, there are two different dialogs you use. The first
is in the same Configure dialog box that you open to configure menus, keyboard shortcuts,
and the status bar as well as assign events to program actions. The second is a Customize
dialog box specific to toolbars.

The Toolbars tab in the Tools, Configure dialog box is where you turn the display of specif-
ic toolbars in a program module on and off. By default, all available toolbars for a module
are turned on. You can turn off a toolbar display by clicking its check box to deselect it. Bars
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that are indented in the list represent toolbars that do not display continuously but appear in
a specific location when the context is appropriate.

The Customize dialog box is where you get down and dirty and can create your own tool-
bars from scratch or reassign the toolbar assignments of existing toolbars.

You can open the toolbar Customize dialog box only from the toolbar context menu. Right-
click in an area of any toolbar and a context menu like the one on the left in Figure 3.22
appears. Choose Customize to open the Customize dialog box. It’s useful, however, to first
select the Visible Buttons command and open the Visible Buttons submenu (like the one on
the right in Figure 3.22), where you can see each button currently assigned to the selected
toolbar and its name (which is the name of its assigned command).

Figure 3.22 B Inser e
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When you choose Customize, a dialog box like the one in Figure 3.23 appears. (The specif-
ic dialog box you’ll see will likely be different.)
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Figure 3.23
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In the bottom are a Functions Category list and a Command list. The Functions Category
list organizes available commands into categories. The Functions Command list shows all
the available program commands, prebuilt StarBasic macros and scripts, and any macros and
program modules you may have created yourself within a given category.

In the top portion is an Icons list, which displays all the toolbar button icons that by default
are assigned to the commands in the currently selected category. You'll notice that many
buttons (like many of those in Figure 3.20) don’t have pretty pictures assigned to them.

Don’t despair—you can assign any existing program button bitmaps to a command by click-
ing the Icons button and browsing through a thumbnail album.

"To add a new tool button to your toolbar, follow these steps:

1. Browse the Functions Category list to locate the category that interests you.

Tip #43 from Many StarMail commands are in the Explorer category, as they’re considered general desk-
M/&Ad@/ & 40/0A top commands.

2. Browse the Command list to find the command you want. Notice that when you select
a command in this list, the icon associated with it appears pressed in the Icons list
above.

3. If you don’t like the default picture assignment, click Icons and browse the available
Icons list to find one you like. Click the icon to select it and choose OK to assign it;
then return to the Customize dialog. The Default button returns the tool button

assignments to the program default settings, so have no fear of messing about with
them.
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4. Drag the button onto the toolbar where you want it available. Space will be made to
accommodate it. If you add a tool button to a toolbar that already fills the entire length
or height of your screen, it will be added but hidden, and a double-headed arrow button
will appear. Click the dark arrow of the pair to reveal the invisible portion of the tool-

bar.

5. If you want to remove a button, drag it off the toolbar into any blank space on the desk-
top, and then release the mouse button. Poof! It disappears. (Just from the toolbar, not
from the program.)

You can also save your toolbar configurations to a separate configuration file if you like—
although not from the Customize dialog box. You must open the Configure dialog box to do
that. Otherwise, changes you make here in the Customize dialog box will be saved to your
current Standard template and will appear any time you create a new document of that type

o Part
or open an existing document that uses the same template.

Ch
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You must always have at least one default desktop while StarOffice is running. However, you
can create as many desktops as you like and switch between them during your work session.

Creating Multiple Desktops

From a user’s point of view, a desktop is a space on your screen with icons for launching pro-
grams and documents. From the program’s point of view, a desktop is a folder that either
has the name Desktop and is stored in the StarOffice and OS directories; or it is a folder
you have made a desktop by selecting it and applying the Desktop command on the
Explorer context menu.

In order to make a folder become a desktop, check the Desktop entry of its context menu.
You will see a check mark to the left of the command. Its Folder icon in the Explorer is also
replaced with the Desktop icon. A right-click on the Desktop icon in the taskbar (shown in
the margin) reveals that your newly designated desktop has been added to the menu of avail-
able desktops. Also, the items in the Desktop folder have been added to the Desktop menu
(which opens with an extended-click). (If the folder is still empty, so too will be your desktop
and the Desktop Contents menu.)

Why Use Multiple Desktops?

Why have multiple desktops? Imagine you’re using StarOffice for both personal and busi-
ness use. You can create one desktop that has templates and programs you regularly use for
personal matters, and another with templates and programs you regularly use for work.

Then designate them both as desktops. Both will appear on the Desktop shortcut menu as
desktop choices (see Figure 3.24). When you select one as the default (Active) desktop, all
the objects it contains also automatically appear on the Desktop menu. This means you can
always have the tools and documents you need most readily available, even as you cover
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your desktop with multiple tasks. And you can easily switch back and forth between the two
different desktops without disturbing the arrangement of your open tasks.

Figure 3.24 |
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When you exit the program, the default desktop is the desktop that opens on next launch.
So, by creating your own desktops, you can also choose the tools that appear when you start
your next StarOffice session.

Switching Between Multiple Desktops

To set a different desktop as the default, open the Desktop menu and click its name. The
contents of both your desktop and the Desktop Contents menu instantly change.

You can only have one desktop from this menu selected at a time. However, because a desk-
top is just a specially designated folder, you can also open the contents of any folder you
have designated a desktop in the usual way—by double-clicking it in the Explorer.

When a folder designated as a desktop is opened in this way, it is opened as a regular task
window with a Task button on the taskbar. In its incarnation as a task window, it can be
manipulated just like any other task window.

To demote a desktop to a folder again, select the folder in the Explorer, right-click to open
the context menu, and click the Desktop command again. The check mark disappears, and
the magic of being a desktop is over.

You cannot deselect either the StarOffice desktop or your OS desktop as desktops.
StarOffice automatically places these folders on the desktop path on first program launch,
and then searches for these folders every time you start up. While you can add and delete
objects from the StarOffice Desktop folder, it’s best not to delete the folder itself. If you do,
be sure you also delete its path entry in the Tools\Options\General\Paths tab or StarOffice
will be confused the next time you launch the program.
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Improving StarOffice’s Ease of Use for the
Physically Challenged

If you have physical limitations or disabilities that make the conventional StarOffice setup
less than ideal, no worries! You can make a host of small changes to improve StarOffice’s
ease of use. This section offers you some ideas. However, it does not exhaust the customiza-

tion possibilities so it’s recommended that you explore on your own as well.

Table 3.2 points you to options that improve the visibility and usability of desktop tools like

toolbar buttons and menus.

Table 3.2 Options to Improve Usability of Desktop Tools

Option Name
and Action

Location

Result

Increase the
value in the
Scaling spin
box to more
than 100%

Tools menu,
Options,
General
category, View
dialog box,
Display section

You can see menus
and dialog boxes
more easily as both
the size of dialog
boxes and the
system font size
increase.

Select Large
Buttons

Tools menu,
Options, General
category, View
dialog box,
Buttons section

You can see toolbar
buttons more
easily.

Deselect Flat
Buttons option

Tools menu,
Options, General
category, View
dialog box,
Buttons section

You can tell
toolbar buttons
apart more easily.

Deselect Menu
Follows Mouse
Pointer option

Tools menu,
Options, General
category, View
dialog box,

Tools section

Your menus remain
open once you've
opened them (rather
than following your
mouse movement);
you can use certain
types of command
and control

software more
easily.

Select Dialog
Center from the
Mouse Positioning
drop-down list

Tools menu,
Options, General
category, View
dialog box

You save wrist
strain as the mouse
pointer
automatically
positions itself

continues

Part

Ch
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Table 3.2 Continued

Option Name Location Result
and Action
over the default
command in dialog
boxes.
Select Colored Tools menu, You can see and
Tab Controls Options, General distinguish the
option category, View tabs of tabbed

dialog box,
Tools section

dialog boxes more
easily as they
appear in a
multicolored array
instead of gray.

Add buttons to

your toolbars

with the

Customize command

Toolbar context
menu, Customize
command; to access,
place your cursor

in the toolbar

you want to
customize,
right-click, and
choose Customize

You can put all the
tools you regularly
use on your
desktop, reducing
the need to use
mouse or keyboard.

Select icons and
text, or text
only, as the
displayed
contents of your
toolbar in the
Contents
drop-down list

Tools menu,
Configure command,
Toolbars tab,
Contents section

You can see toolbar
buttons more

easily; also,

choosing text

display makes it
easier for some
command and control
programs to
recognize commands.

[] For more information on customizing your toolbars, see “Customizing Desktop Tools and Menus,”

p. 115 in this chapter.

Sometimes rescaling your view can cause your system to become unstable, especially if
you increase the scale to a large number. If you find you're unable to start StarOffice after
rescaling or the program runs but keeps crashing, remove the soffice . cfg file from the
office51\config directory. (Or, if you have saved the rescaling to a different configuration
file, remove that file.) Do this when the program is not running. You can either delete the
file or save it to another location. Then, restart the program. StarOffice automatically gen-
erates a new default configuration file that enables the program to run. (Or, it takes its set-
tings from the soffice . cfg file instead of your custom configuration file.) You lose all
your custom configurations, however. If you understand how to edit configuration files and
have saved your old broken file, you may be able to simply edit out the scaling configura-
tion and reuse the file. Otherwise, you need to recustomize your desktop.
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You should also take full advantage of StarOffice’s automated features such as AutoText and
AutoFormat to make your work easier.

If you have repetitive stress injuries (RSI) to your hands or arms and cannot type, or have
other physical disabilities that require you to speak into your computer, you can install the
optional Dragon NaturallySpeaking API that enables you to use Dragon NaturallySpeaking
on the Windows platform. If you did not choose a custom installation this during your ini-
tial installation of the program, you need to run Setup from the Office51 directory, Choose
Modify and follow the installation wizard instructions.

Troubleshooting

What do I have to do in order to access the Internet?

First of all, you must have a network connection to a LAN or intranet, or an Internet
account with an ISP and a dial-up networking connection.

The easiest way to inform StarOffice of your Internet account information is to use the
Internet AutoPilot, which helps you get online in a jiffy. It launches automatically the first
time you start StarOffice. If you chose not to complete the AutoPilot when you first
launched StarOffice, you can start it anytime from the File, AutoPilot menu. Follow the
steps in the section “Setting Up Your Internet Accounts with the Internet AutoPilot” in this
chapter.

If you want to set up your account yourself, refer to the relevant parts of the “Getting
Online” section in this chapter.

Once you’ve checked these settings, click the Online button on the StarOffice function bar
so it looks pressed in. Now, you’re ready to browse! Click any Web bookmark in the
Explorer and your dial-up networking dialog box will open as StarOffice seeks an Internet
connection. Take whatever actions you usually do to connect. After you’re connected, you
can browse by entering Web addresses (URLSs) in the URL Locator field on the function
bar and pressing enter.

If you want to download files using FTP, read Usenet newsgroups, or send and receive
email, you need to have within StarOffice an FTP account, news account, and email account
Inbox and Outbox respectively. If you used the Internet setup AutoPilot on first launching
the program, you may already have an email Inbox and Outbox and/or a news account in
your Email and News group in the extended Explorer. If you did not, the simplest way of
setting up an email account and/or news account is to select File, AutoPilot, Internet, and
step through the dialog boxes, selecting only those new options you want to add. Complete
details on creating a StarDiscussion news account are given in the section “Beyond Mail:
Joining Newsgroups with StarDiscussion,” in Chapter 29. Creating an FTP account is dis-
cussed in Chapter 27, “Publishing Your Work on the Web.”
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How does email access work in StarOffice?

To receive email, you must set up an email account Inbox. If you completed the Internet
wizard on opening the program for the first time, you should already have an account Inbox
in your Email and News group in the extended Explorer. If for some reason you did not, or
if you want to set up a second Inbox, you’ll need to create it in the Explorer. Right-click the
folder in which you want to store your email and choose the New command. From the sub-
menu, choose the type of email account you want to create—POP3 (the most common, and
the type you surely have if you connect through an ISP), IMAP, or VIM. To send email, you
must first create an Outbox via the same context menu New command. If you completed the
Internet AutoPilot, you already have an Outbox and don’t need to worry about it. For
detailed instructions on completing these dialogs, see the section “Getting Online” earlier in
this chapter.

Im a Linux user and I don’t like the look of the StarOffice desktop and windows. How can I change

it?

Select Tools, Options and click View in the General category. You can change the appear-
ance of dialog boxes and buttons using the Look & Feel drop-down list box in the Display
portion of the View dialog. One of the options includes their attempt at an X look-
alike—Xwindows.

Ive created an IMAP account, but every time I open my mailbox, nothing bappens.

While StarOffice 5.1’ IMAP support is much improved over that of version 5.0, it still does
not support all IMAP servers. If you’re unable to use a POP3 connection to access email at
all, you’re probably out of luck. You should try contacting the company to confirm if they
support your particular type of IMAP server. If you don’t know the details about your server,
ask your network administrator.

Im a Linux user; and my POP3 connection bangs every time I try to download my mail. I have to
kill the process. What can I do to use StarOlffice as my email client?

There are a variety of reasons you might be experiencing problems. One common cause is
that you have not entered a fully qualified domain name for your server. Try editing your
etc/hosts file and entering the fully qualified domain name. Linux connection problems can
be complex, however, and it also must be said that StarOffice is not as stable on Linux as on
Windows. If this does not solve your problem, check out the StarMail newsgroup, which has
lots of good discussion about email connection issues.

How can I integrate PGP with email?

PGP integration is new to 5.1. However, you must have installed the optional PGP integra-
tion pack during installation. If you did not, run Setup from the 0ffice51 directory and
choose Modify. When you click Next, a dialog box with the title Select StarOffice 5.1
Modules appears. Scroll through the list of Optional Components until you see
PGP_Support. Click the Blocks icon to the left so it appears colored in. Click Complete and
follow the steps home. Once you install the PGP module, a PGP icon will appear on your
StarMail object bar.
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How can I import my existing email files into StarOffice?

Using the Internet AutoPilot, you can import entire mailboxes from Netscape
Communicator and MS Outlook Express. Importing in this way overwrites any existing
messages you have in your default Inbox and Outbox, however, so it may not the best route
if you already have some stored messages. (If your messages are stored on a server, however,
you can always just synchronize with the server again to download new copies of your mes-
sages.)

From the Explorer, you can import ASCII and MS Outlook Express files. So, first be sure
your file is in a suitable format, and then select your email account Inbox (the Inbox in
which you want the messages to appear) in the Explorer. Right-click and choose File,
Import. Navigate to the directory where the file you want to import is located, and the rest
should be clear from the dialog box.

I keep getting the ervor message, “Read Error; could not resolve host name...” when I try to connect

to the World Wide Web.

You’re trying to get online but do not have Online mode activated and/or are not connected
to your Internet server. You must activate your dial-up networking program and connect to
the Internet, and also click the Online button at the end of the StarOffice function bar.

I created custom keyboard assignments, but now they don’t work!

What application or document type were you in when you created them? Keyboard shortcut
assignments are application-specific (although some are attached to the desktop and are
common across all applications). You probably created them while in, say, a StarWriter doc-
ument and are now trying to use them in StarCalc or StarImpress. This capability to attach
keyboard assignments to specific applications is part of StarOffice’s “the tools you need
when you need them” approach to desktop organization.

I don’t want my System folder set as my default desktop, but I want to be able to open it on my
desktop.

Create a link to the System folder in the Explorer. You can then open it as a task window on
the desktop. Keep in mind that in 5.1, you can also create a System group that links to your
System folder.
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Desktop Integration in StarOffice

The basic word processing and spreadsheet applications StarOffice provides are similar to
those you find in any major Office suite today. Where StarOffice stands out from the pack is
in its tight integration of applications and Internet programs into one desktop—a desktop
designed to blend into office networks and the Internet as well as work smoothly across plat-
forms.

This integration includes the sharing of commands, tools, and desktop utilities across appli-
cations, which makes learning to use StarOffice relatively quick and easy. For example, if
you learn to use the table AutoFormat feature in StarWriter, you already know how to auto-
format tables in StarCalc—even if you’ve never opened a spreadsheet in your life.

This chapter gives you an overview of StarOffice’s common dialog boxes, tools, and desktop
organization and a glimpse of the integrated desktop at work. It’s packed with tips and tricks
to maximize results and minimize your work in StarSpace. Later chapters go into detail
about how to best accomplish specific tasks when you’re using these tools in the individual
application modules.

Creating and Opening Documents

Because StarOffice is a task-oriented program, you begin work on the desktop by creating
and opening files and documents, not opening applications.

Creating New Documents

To start a task, you can open new documents from a number of locations on your desktop
workspace, or you can create documents by using templates and the AutoPilot Wizard. In
StarOffice, document refers not just to text documents, but to many other document types as
well.

Table 4.1 lists the types of documents you can create in StarOffice.

Table 4.1 Using Document Types in StarOffice

Use This Document Type To Create

Text Letters, faxes, reports, and other text documents

Spreadsheet Financial reports and analyses, lists, and some types of databases
Presentation Slides, transparencies, handouts, and outlines for oral presentations
Drawing High-resolution illustrations

HTML Simple Web pages and other kinds of documents that use hyperlinks
Mail Email letters

Frameset Complex Web pages that combine multiple files and documents

onto one online page
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Use This Document Type To Create

Master document Master document for long documents, to simplify tasks such as gen-
erating an index and a table of contents

Chart Graphical representation of numerical data

Image Simple graphics suitable for publishing on the Web or customized
screen elements such as buttons and icons

Mathematical formula Complex mathematical formulas requiring special fonts and symbols
sets

Creating Documents from Scratch
To create a new StarOffice document, you can choose from these options, among others:
= You can choose File, New from the menu bar and then select a document type from the
submenu.

= You can choose File, AutoPilot for help with creating text, presentation, and Web docu-
ments and templates.

= You can choose New, Documents from the Explorer context menu and then select a

document type from the submenu. The choices are the same as those on the File, New Part
submenu. |

= You can open the Tasks group in the extended Explorer by clicking its title bar. Then ch
you can click the desired document type icon to start a new document. 4

= You can open the Start menu from the task bar and click the desired document type
icon to start a new document.

Creating Documents from StarOffice Templates

If you create a document by choosing File, New, you open a generic, blank document based
on the StarOffice Standard template for that document type. It’s the equivalent of a blank
piece of paper.

You can also create a new document based on a template. A template is a prebuilt form for
creating a specific type of document—for example, a memo or a loan calculator. A template
can include custom styles, prebuilt tables, background graphics or graphics placeholders,
formulas, and fields that draw data from your user data or Address Book database. In
StarOffice, it can also contain custom desktop configurations.

Using a template, you can create a professional-looking document more quickly and easily.
You're not bound by a template’s design; you can change parts of a document created from a
template just as you can in any other document.

StarOffice includes templates for a wide range of tasks, ranging from an academic paper to a
loan and mortgage calculator to perfectly sized zip disk covers. These templates are
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organized by category and task, not by StarOffice application, and they include templates for
tasks carried out with StarWriter, StarWriter/Web, StarCalc, and StarImpress.

Tip #44 from Exploring these included templates is a great way to see some of the tasks you can perform
Michael & Sarah in StarOffice. You can also always cut and paste elements you like from a template into

O

your own document or template. Using the Style Organizer, you can drag and drop styles
from a template into your current document or template as well, a technique explored later
in this chapter in “Managing Styles and Templates.”

To create a new document from a template, choose File, New, From Template or press
Ctrl+N. Then start browsing for the desired template.

For more details on using the New templates dialog, see “Working with Templates,” p. 308.

Previewing and Opening Templates from the Desktop The Templates directory
appears in the Explorer, and one way to browse the templates is to open a templates folder
on your desktop. If you click the Preview option on the desktop object bar, you can see full-
sized previews of the templates.

m Even if you have turned on the Display Documents option in the Explorer Group context

menu, individual templates are not displayed in the Explorer. You must open a template
folder in the Beamer or on the desktop to see its contents.

If you see a template you want to use to create a new document, double-click it. A blank
document based on the template opens on the desktop.

If you want to place a shortcut to start a template from your own custom desktop, make
sure that you select the option blank on the Internet tab of the document’s Edit menu
Properties dialog.

m If you want to edit the template directly rather than create a document based on the tem-

plate, select the template, right-click to open its context menu, and select Open As
Template.

Creating Custom Templates A template is a special type of document file and has its own
extension, *.vor. If you have created a document that you want to use as a model for other
documents of the same type, you should save it as a template.

The simplest way to save an open file as a template is to use the Templates command from
the File menu. First, make sure the file is the active document on your desktop (that is, it is
the document on top and/or contains the cursor). Then select File, Templates. Next, select
the category (folder) where you want to store your template. Finally, type a name for the
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template in the New Template text box, and click OK. Your active document (complete with
text, styles, and everything else) is saved as a template in the Templates directory and will be
available to you the next time you open any of the templates dialog boxes.

You can also save a file as a template in the Save As dialog box. To do so, just select the
appropriate StarOffice 5.1 Template type from the File Type drop-down list. You can save a
template anywhere you like. However, it’s a good idea to either save your template in the
Templates directory or create a link to your template in the Templates directory. You can
then access your template via the File, New, From Template and File, Templates dialog
boxes.

For more information on working with templates, including manually importing templates and styles
created in other programs, see “Managing Templates and Styles,” p. 167, in this chapter.

Flying on AutoPilot

AutoPilot is a document- and template-creation wizard that helps you quickly create pol-
ished, formatted versions of the most common document types—Letter, Fax, Agenda,
Memo, Presentation, and Web Page—by stepping you through a limited set of formatting
and layout options. It simultaneously creates a custom template for you based on your
selections.

New to version 5.1, a special AutoPilot Wizard imports your Microsoft Office document
templates and/or documents into StarOffice formats in a few easy steps.

Creating New Documents and Templates with AutoPilot To create new documents
and templates with the AutoPilot, select File, AutoPilot, and then the type of document you
want to create. StarOffice walks you step by step through a series of dialogs that assist you in
creating a template according to your needs. If you make a mistake or change your mind,
retrace your steps with the Back button and make changes. Click Cancel to cancel the entire
process and return to the desktop.

After you’ve entered all the necessary information, choose Create. StarOffice opens a blank
document based on the template. With ordinary text documents and presentations, it also
automatically creates and saves a custom template in the Standard subfolder of the
Templates directory, using the name you entered during the creation process. It saves this
template even if you do not save the document created with the AutoPilot. With Web
(HTML) documents, you must click the Save Template option box to save your custom
template.

For more information on working with the AutoPilot for text documents, see “Creating Documents and
Templates with the AutoPilot,” p. 253.

For more information on creating and working with text templates, see “Working with Templates,”
p. 308.

For more information on working with StarCalc templates, see “Creating StarCalc Templates,” p. 579.

For more information on working with HTML (Web page) templates, see “Creating Web Pages in
StarOffice,” p. 946.

Part
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You can also create StarBase database elements with the AutoPilot. Working with StarBase
elements is different from working with ordinary documents, however, so it is not discussed
here. For information, refer to Chapter 30, “Working with Databases in StarBase.”

Importing Microsoft Office Documents and Templates If you’re making the switch
from Microsoft Office, you can get up and running quickly by using the Microsoft Office
Template and Document Import Wizard on the AutoPilot menu. You can import and con-
vert Microsoft Word, Excel, and PowerPoint templates into StarOffice templates, as well as
import and convert existing Microsoft documents into their corresponding StarOffice docu-
ment types—all in one fell swoop. (Your original templates and documents remain
unchanged.)

StarOffice has a fine set of filters for Microsoft Office documents, so you don’t need to
import your documents to open them in StarOffice. You can work with them directly in
their native formats if you like.

Begin by selecting the Microsoft Import command from the AutoPilot menu on the File
menu. You then see a dialog box like the one shown in Figure 4.1.

This AutoPilot searches thiough a complete file with all subdirectories in the Microsoft Office

spreadshests or Pawerpaint presentations. Select the Microsoft file folder and the target folder

Help Cancel CoBE

Click Continue to move to the next dialog, which looks like the one shown in Figure 4.2.

This dialog box is the key to your import process. You need to complete three steps for
each of the three programs:

1. Determine whether you want to import templates for that program and change the
listed template path, if it is not correct. You can also choose to search subdirectories of
your selected template import directory.
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2. Determine whether you want to import existing documents created with that program
and change the listed directory path, if it is not correct. StarOffice will import only doc-
uments stored in that directory (and its subdirectories, if you have selected that option).

3. Determine the path for the target directory into which your imported documents will

be placed.
Figure 4.2 Microsoft Office Importautopilot EE
In the second dialog AT -~ D A5
box of the v A o
Importautopilot, you 57 @
can select the options
for importing MS 2 [irvous tomplatos The WirWord template path:
Word, Excel, and 7 including subdirectories [ Program Fies\Microsoft Ofize! Templales | . |
PowerPoint templates
and documents. ¥ Wirlword documents The Winword document path;
I including subdirectories [Cy Documents m
The exported StarWriter documents path:
JE:\Stardffice\Working [
Help Cancel << Back Continue > |

Part
By default, the Importautopilot is set to import all existing Microsoft Office templates and |
documents in the listed directories and their subdirectories. StarOffice uses the same filters ch
to import documents and templates as you use when you open an individual document via 4

the File menu’s Open dialog. You might want to test the filters on selected documents
before importing them en muasse to see whether your documents import acceptably. Of
course, your original documents still exist in case the imported version is not usable.

m Some features, such as revision marks in Word and certain Excel functions, may not trans-
late. If you speak German, you can find a list of the import/export status of every feature
at www.stardivision.de, Star Division’s German site.

The settings you see initially are only those for Microsoft Word. To confirm or change the
settings for MS Excel and MS PowerPoint, you must click their respective buttons in the
upper part of the dialog box.

You don’t need to list a target path for imported templates because StarOffice automatically
creates folders for them in the Templates directory.

After you have confirmed the settings in this dialog box, click Continue. You then see a dia-
log box like the one in Figure 4.3 that summarizes your selections. You would be wise to
scroll through the summary to confirm your selections.
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Figure 4.3 Microsoft Difice Importautopilat =]
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Help Cancel <¢ Back

When the summary says A11 Directories Will Be Considered, it means you
have selected the Include Subdirectories option for the relevant program, not that the
Importautopilot will import templates and/or documents from anywhere on your local
drives.

m You are essentially making copies of all the selected templates and files. Be sure you have
enough room on your hard drive or partition to import all the templates and/or docu-
ments you select.

The default template folder names are listed here—Imported Text Templates (for Microsoft
Word templates), Imported Calculation Templates (for MS Excel templates), and Imported
Presentation Templates (for MS PowerPoint templates). You can change these names, if you
like, by selecting the default names and typing over them.

After you have confirmed your settings, click Import to begin the import process.
Importing takes a few minutes, so be patient. StarOffice first searches your selected folders
and counts the number of templates and/or documents that have the appropriate format;
you can see the number on the dialog box. (If you see an alarmingly large number and are
worried about your drive space, click Cancel to stop the process.) It then imports them.

Tip #45 from Want to see just what the import wizard did? Open the URL Locator history list on the
Mickae! & Garah function bar right after the AutoPilot completes its work. You'll see a list of the last 100
templates and/or documents that were imported.
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Opening Existing Documents

StarOffice includes filters for opening documents and file types created in many other pro-
grams and on other major platforms, as well as for opening older versions of StarOffice doc-
uments.

[ For a complete list of non-native file types handled by StarOffice, see Appendix B, “File Formats and
Extensions,” p. 1395.

m The free version of StarOffice (Personal Edition) comes with a limited set of import and
export filters. To obtain the complete set, you must purchase the Personal Edition Deluxe or
the Professional Edition.

Tip #46 from Normally, when you're opening files using the desktop shortcuts described next, your new
Mickae! & Zarah task replaces your currently active task (if there is one), which is closed. To place your new
task on top of existing ones, press Ctrl while opening the file. This trick works with entering
paths into the URL Locator field, as well as clicking and double-clicking files in the Explorer

and Beamer.
Part
"To open existing StarOffice and non-StarOffice documents, you have a number of options: |
= You can select File, Open from the menu bar to open the Open dialog (look ahead to ch
Figure 4.4). You can navigate anywhere on your system from here. After you've located
your file, you can select it and click Open. 4

= You can click the Open File icon on the function bar, which opens the same dialog box
as the File, Open command.

= You can double-click a document or file in the Beamer or on the desktop.
= You can type the file’s complete path into the URL Locator field and press Enter.

= You can open the URL Locator drop-down history list and click a path listed there.
(Your last 100 opened URLs are listed there, which includes locally stored files and
Internet addresses such as Web addresses and news servers.)

= You can open the Start menu and move your mouse pointer over the Documents entry.
It opens a submenu listing the last 30 documents you have opened—not just in
StarOffice but anywhere on your system. Just click a document to open it.

Tip #47 from A handy shortcut for opening files is the recently opened files list at the bottom of the File

Michael & Sarah menu. Just click a filename to open it. The default number of files listed is four, but you can
change this number by adding a line to your soffice.ini (Windows) or sofficerc
(Linux) file. Open the file in a text editor such as Notepad or VI. Then search for the

continues
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continued
heading [soffice-Picklist]. This section records your browsing and file opening histo-

ry. Next, go to the end of the section, and add the line

Pick=x

where x is the number of recently opened files you want to appear on the File menu.
Finally, save the file and exit. The change goes into effect the next time you start StarOffice.

Opening Documents from the Open Dialog

A common way to open documents is to use the Open dialog (Ctrl+O), which you access
from the File menu (see Figure 4.4). This method presents a number of advantages. You can
navigate anywhere on your system. You can select the specific filter you want to use in open-
ing your file. You even can choose to open your file in read-only form, in case you want to
look but not touch.

Default

Create New Directory Directory

Figure 4.4
The Up One Level v
. . arlihce

and Default Directory
buttons at the top of (02 Appendices 2 el & Todd th Olne
the Open dIaIOQ . (1 Backmatter (1 Outtakes (1 ToSend eve
enable you to navi- (1 Backups (3 ProgNates (3 Troubles Details
gate anywhere on (3 Chapters 0 sen-0ut Cwarking View
your system. You can (1 Ediing [ sentiia Lifcheckls:
extended-click them (20 Figures [} StarFl!es E] crashlog y List View
to open handy short- 23 InstallDocs (20 TesiFiles ﬁ Mcpglobl -
cut fly-out menus. a |_ i

Filename: Jeheckist.doz =l Open I

Mersion: ICurrenl wersion j Cancel |

File tupe: J <> El

™ Read-only

Features of the Open Dialog You might think you have nothing to learn about an
Open dialog, but StarOffice’s Open dialog actually has a number of unexpected features.
Those that relate to navigating around your system and opening files are explored here,
whereas those that ease file management are explored in Chapter 5, “Managing Files,
Folders, and Mail.”

[ For more information on managing files from the Open dialog, see “Managing Files and Folders from
the Open and Save As Dialog Boxes,” p. 192.
The first time you open the Open dialog in your current StarOffice session, it opens to

your designated work folder. After that, it opens to the last directory in which you opened a
file.

The upper portion of the dialog contains navigational buttons.
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The main portion of the dialog is filled with a list of files and their attributes. You can see
more details on the files, such as last modification date and file size, if you click the Details
View button. (Figure 4.4 shows the dialog in the default Icon view, and Figure 4.5 shows it
in Details view.) You can also resize the dialog itself by grabbing a corner and dragging—
pretty unusual, but also useful in these days of long filenames. The ability to resize the
Open dialog box is also one of the features that enable you to manage files and mail in this
dialog box.

The lower portion of the dialog contains text boxes in which you or the program enters
information about the files you want to open. The Version text box relates to the StarOffice

Versions feature, which enables you to save different versions of the same document in a sin-
gle file.

[J For more information on working with versions, see “Working with Versions,” p. 1007.

By default, all file types are displayed, but you can target and speed your search by selecting
a specific file type from the File Type drop-down list.

Using Wildcards to Search for Files You can enter a portion of a filename by using a

wildcard character (*) or an extension by using a wildcard character (*) and then press Enter

to list only those files that match your search criteria. For example, if all files related to a

specific project begin with the letters ARC, you can enter arc* in the Filename box and Part
press Enter to see only those files listed. If only one file in the folder matches your search |

criteria, StarOffice opens it on your desktop. .

4

Don't place an asterisk at the beginning of your search string because it is interpreted to
mean “Search for all files.”

Use the question mark character (?) to stand in for a single instance of a character. For
example, if you’re looking for Microsoft Word files that have the number 9 at the beginning

Opening Files To open a file from the Open dialog, double-click it, or select it and click
the Open button. Files are placed on top of any other open tasks.

If you only want to read a document, you can ensure it isn’t accidentally changed while open
by selecting the Read-only option in the lower left of the Open dialog.

Tip #48 from If you're unable to open a document, your template may be corrupted. You can load the

Michael & arah  document without its template, however. Just press Ctrl+Alt+L, click OK in the resuiting dia-
log box, and choose Open. StarOffice checks the formatting and replaces any corrupt styles
on-the-fly with its standard format.
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Navigating in the Open Dialog The basics of navigating in the Open dialog are likely
familiar to you from other programs. However, as usual, StarOffice has a few unlikely tricks
up its sleeve.

You can navigate anywhere on your local and network drives by double-clicking folders to
see their contents or using the navigation buttons at the top of the dialog to move to higher
levels or other areas of your directory structure.

The Up One Level button moves you up your directory structure one folder at a time. If
you accidentally go too far, just double-click the folder or icon that you want to open again.

The Create New Directory button creates a new folder in your current location, which
means you can easily manage your files at the same time you open and save them.

In Microsoft applications, you can set frequently visited folders as “favorites” and quickly
navigate to them. In StarOffice, you can do something similar but better by using the
Default Directory button. A click on the Default Directory button takes you to your desig-
nated work folder. This button works not just in the Open dialog, but in many other dialog
boxes you use, so it’s a good idea to set your most commonly used directory as your work
folder. Doing so really speeds your navigation.

Tip #49 from You can change the directory assigned to the Default Directory button by editing the entry
Michael & Zasah for Work Folder in the General category Paths dialog box, opened from the Tools, Options
“master dialog” box.

Some of the Open dialog’s unlikely tricks relate to the small green arrows sported by the Up
One Level and Default Directory buttons. The arrow is StarOffice’s signal that an extended-
click on these buttons opens something special—in this case, handy fly-out menus with navi-
gational shortcuts. Both give you access to the Workplace (which lists all your drives and
volumes) and a shortcut to the root level of your C: drive. The Default Directory fly-out
menu (shown open in Figure 4.5) gives you further choices that include the StarOffice
Templates folder, the Explorer, the Explorer Groups folder, and all your designated
desktops.

Designating directories you use frequently as desktops is an easy way to ensure speedy navi-
gation. Just select a folder in the Explorer or Beamer, right-click, and choose the Desktop

command.
Ti? #50 from Clicking the Filename drop-down list in the Open dialog opens the same history list of your
Michael & Zarah last 100 accessed documents as opens from the URL Locator field. Just click a document on

the list to open it on the desktop.
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Displaying and Sorting by File Properties

When you save a file, a number of properties are saved with it, including its title, path
(URL in StarOffice lingo), type, size, and modification date. When you select Details view
in the Open dialog, you can display these properties in the Open dialog to help you identify
and manage your files (refer to Figure 4.5).

By default, files are sorted alphabetically from A to Z by title, but you can sort on another
field by clicking its name on the field title bar. Clicking again on the field title bar reverses
the sort order.

Tip #51 from

- You can also drag and drop files within the Open dialog to create a custom list order. This
Michae! & Sarah

capability can be handy when you’re opening multiple files.

Many fields are hidden from view—including Filename and URL. To insert a hidden field,
place your cursor on a field name, and right-click to open a context menu. Choose Insert to
open a submenu of available fields. You can also remove a visible field by choosing the
Remove command. The Optimal Width command, just as it suggests, sizes the field column
to fit the widest entry and no more. Don’t bother with the two Sort commands; they do the
same as clicking the field names, which is much quicker.

By default, the title of your file appears in the Open dialog. The title is a property set in the
Document Properties dialog box, which you open from the File menu. If you don’t assign a
title yourself, usually StarOffice assigns your saved filename as your document’s title.
Sometimes it uses other names, like the name of its document template.

The Open and Save As dialogs are linked, so any changes you make to one apply also to the
other.

You might be surprised to see the long list of properties, many of which are traditionally
used only in connection with email and news accounts. This connection reflects two aspects
of StarOffice’s serious Internet integration: StarOffice applies many techniques for labeling

Part

Ch
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(1]

WINDOWS

and managing email and news messages to ordinary folders and files, and you can actually
manage your StarOffice email and news accounts from this dialog box.

For more information on managing email and news from the Open dialog, see “Managing Files and
Folders from the Open and Save As Dialogs,” p.192.

Using Find to Search for Files If you're not sure of the location of the file(s) you want
to open, click the StarOffice Start menu and choose the Find command. In Windows,
choosing this command opens a submenu with three choices: the StarOffice Find command
and two Windows system search dialog boxes. In Linux, you should see the StarOffice Find
command but some users report that the menu integration of this menu command doesn’t
work and they see no choices. It doesn’t matter, as you can access Find from the Explorer
context menu.

You can also open Find by right-clicking in the Open dialog and choosing Find from the
context menu.

Find enables you to construct a complex Boolean search on-the-fly for files anywhere on
your system.

TiP #52 from You can also construct and save searches with the context menu’s New, Search command,
Mickael & arah which creates a special search folder on your desktop.

You can construct a search with Find in two basic steps. On the Criteria tab, specify the
characteristics of the file(s) you are searching for by selecting conditions from the drop-
down list and entering the text string you are searching for—for example, a filename—in the
Expression text box. If you click the Regular Expression option, you can use a wide range of
wildcard characters that enable you to search for files that share characteristics that are simi-
lar but not exactly the same. If you want to search for multiple files, click the Multiple
Search tool on the desktop object bar.

m Be sure to click Add when you're crafting new criteria statements. Entering them in the text

boxes at the bottom of the dialog box is not enough.

[1 For a list of regular expressions and a discussion of their use, see “Using Regular Expressions,” p. 153,

in this chapter.

On the Location tab, navigate to the directories, drives, and/or volumes where you want
StarOffice to search, and click the Add button to add them to your list of searched sites.

After you have completed these two steps, click Show to begin the search and show the
results. A new window opens on your desktop to display the results; if no files or directories
are found, the desktop window is empty.
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If you want to modify your criteria, select the statement you want to modify. Its statement
appears in the text boxes below. Make your changes as desired, and then click the Modify
button.

To delete a criterion, select it and click Delete.

After you make changes, you might need to click Update to refresh the display. The Update
command searches only for new files and folders that match your criteria; it does not match
the contents of your Find folder against those of the target directories and drives you are
searching.

Clicking Synchronize, however, does just that. Because it matches the contents of your desk-
top folder against the target directories based on your criteria, some items may disappear
from your folder if you have changed the criteria and those objects no longer match them.

Searching for Files with Specific Extensions If you want to search for files with a spe-
cific extension, you first need to make sure you have clicked the Show File Extensions but-
ton on the desktop object bar. (To reveal this tool, you must have a folder open on your
desktop.) Then open a Find dialog box, and enter as your criteria Title Contains. (You can
use File Type in place of Title as well.) In the Expression text box, type a period (.) fol-
lowed by the extension—for example, .sdw.

Part
On the Location tab, enter your location. Be sure to select the Search Subfolders option if |
you want a broad search. e
Note that neither *.sdw nor *sdw will work. 4

For more information on using the Find command and its cousin, Search, see “Retrieving Distant Files
and Folders,” page 206.

Opening Multiple Files To open multiple files, you select the files you want to open
using either Shift+click (which enables you to select a contiguous list of files) or Ctrl+click
(which enables you to make non-contiguous selections). When your selections are complete,
click Open or press Enter.

Depending on the number and size of files you have selected, loading all your files might
take a few minutes. They are placed one on top of the other on your desktop. You then can
use the Window menu or press Ctrl+Tab to move among your documents.

Opening Documents from the Desktop

Besides using the File menu’s Open dialog, you can also preview and open files directly from
your desktop by using the Explorer and Beamer, or by opening a folder on your desktop.
The shortcut you use to open the file varies. If you have set the Explorer to one of the sym-
bols views, you open a file by single clicking its icon. Otherwise, you open a file by double-
clicking its icon.

It doesn’t matter if the file was created in StarOffice. If not, StarOffice opens the file in the
correct application based on the file’s extension. If the document does not have a file exten-
sion that StarOffice recognizes, you need to open it by using the File menu’s Open dialog,
where you can specify the correct file type manually.
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Using drag and drop, you can also insert a file from the Beamer as a section in an open doc-

ument.
TiP #53 from In general, you cannot open a file on the desktop by dragging and dropping it from the
Mickael & arah Beamer. However, you can open a spreadsheet in this way if you drop it on top of an open

text document.

Previewing Files To preview files, you must first open a folder on the desktop by select-
ing it in the Explorer and double-clicking, or right-clicking and choosing Open. If you dou-
ble-click, the currently active task (if there is one) is closed and the folder opened in its
place. If you right-click and choose Open, the folder is automatically opened on top of any
currently active task.

Next, click the Preview button on the desktop object bar. Then select the file you want to
preview. After a moment for loading, it appears in the preview window as a read-only copy.

m If you want to preview graphics files, you need to import them into the Gallery. You can
then display your folder in the Beamer, which can function as a thumbnail viewer.

Opening Files from the Explorer Now in version 5.1, you can display and open docu-
ments directly from the Explorer in one of three ways:

= If your group is set to either of the Symbols views, you can click a document to open it.

= If your group is set to Hierarchical view, individual documents are listed only if you also
select the Display Documents command on the Explorer context menu. (Place your
pointer on the group title bar, right-click, and choose Display Documents.) Just double-
click a document to open it.

= In all three views, you can also open a document by selecting it, right-clicking, and
choosing Open from its context menu.

Opening Files from the Beamer If you open the Beamer and click a folder in the
Explorer when it is set to Hierarchical View, the folder’s contents are displayed in the
Beamer. To open a file, select and right-click it; then choose the Open command.

Opening Multiple Files You can open multiple files in an Explorer group set to
Hierarchical view or the Beamer. To do so, first select the files you want to open by using
Ctrl+click (for noncontiguous files) or Shift+click (for a contiguous list). Then right-click
and choose Open from the context menu.

Opening Files as Templates If you want to open a copy of a document as a template,
select it, right-click, and choose Open as Template from its context menu.

Opening a Linked File’s Target Frequently, you do not have original files stored in your
Explorer groups, but only links to files saved elsewhere. You can open a link just as you can
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open a file. However, you cannot open a link as a template. You can easily open the original
file as a document or as a template. To do so, select your link, right-click, and choose the
Target’s Context command. From the submenu that opens, choose either the Open or Open
as Template command.

Inserting Files as Sections  StarOffice’s drag-and-drop features are extensive and
increase your efficiency considerably. A nice shortcut for inserting one text document into
another as a section is to drag it from the Beamer and drop it into the other document when
the document is open on the desktop. Sections are a complex feature that can involve data
links, so you might want to consult Chapter 10, “Working with Long Documents,” before
using this feature.

[] For more information on sections, see “Defining Sections,” p. 378, and “Hiding and Protecting Text with
Sections,” p. 1009.
Note that you cannot undo a section insert by choosing Edit, Undo (or pressing Ctrl+Z). To
delete or otherwise manage sections, you must use the Edit menu’s Sections dialog box.

Saving and Closing Documents

StarOffice’s Save commands come in the standard flavors: Save, Save As, and Save All. Bart

Save saves the active task on your desktop. Save is also known as fast Save because you can |
save on-the-fly by using the Ctrl+S key combination or by clicking the Save button on the

. h
function bar. ¢

Save All saves all open documents.

TiP #54 from If your current document has not yet been saved or has been changed since your last save,
Michael & Garah an asterisk appears in the status bar as a reminder.

Using Save and Save All automatically overwrites the previous version saved under the same
name.

If you choose either Save or Save All and have not yet assigned a filename to the open docu-
ment(s), StarOffice automatically prompts you with the Save As dialog (see Figure 4.6).
Using this dialog, you can name your current document and select a file type in which you
would like to have your work saved, as well as assign a password.

m The Save and Save All commands are grayed out until you assign a name to an open
document.

The Save As dialog box offers you a number of important choices for saving your files, as
you’ll learn in the following sections.
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Figure 4.6
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Saving Files with a Password

You can select the Save with Password option in the lower left of the Save As dialog box if
you want to secure your file with a password. If this option is checked, choosing OK in the
Save As dialog box opens an Enter Password dialog that prompts you to enter your pass-
word. After you have entered a password and clicked OK, a second dialog prompts you to

retype the password and confirm it. When you click OK in the Confirm dialog box, your
file is password-protected.

Tip #55 from

i Don't forget your file password! You cannot open a file whose password you don’t remem-
Michael & Sarah

ber or know.

Undoing Password Protection

Undoing password protection is simple—if you remember the original password. In this
case, you can open the document (which requires the password) and then save with Save As
again. This time, save without checking the Save with Password option.

Saving with Automatic File Extensions

By default, the option Automatic File Name Extension is checked in the Save As dialog box.
StarOffice therefore automatically assigns the correct file extensions to all files saved within
the program, including those saved in non-StarOffice formats.

Many programs manage and recognize files by using specific file extensions, and StarOffice
is no exception. For example, StarWriter documents have an *. sdw extension, whereas
StarCalc documents have an *sdc extension. These extensions help programs search for and
manage files more effectively, and make opening files easier. (On the Windows platform,
the extension also enables you to open a document in its source application by double-click-
ing a document icon.)
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If you want to assign your own file extensions, or if you have no file extensions at all, dese-
lect this option. Deselecting it is recommended for advanced users only.

[] For complete lists of StarOffice file extensions and foreign file formats supported in StarOffice, see

Appendix B, “File Formats and Extensions,” p. 1395.

Saving and Exporting Files in Different Formats
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The Save As command enables you to choose the format in which your document will be
saved. By default, StarOffice saves in StarOffice document types for new documents. If you
open a document that was saved in a different format—say, Microsoft Word—StarOffice
automatically selects that file type as the format in which to save. However, if you have
made changes to your document that might not survive if you save it in a non-StarOffice
format, you are prompted and asked to confirm your Save format.

All the supported file formats for a document type are listed on the drop-down menu in the
File Type box in the Save As dialog. To select a file type, click to open the drop-down list,
scroll to find your choice, and click to select it.

To save presentation and drawing documents in non-StarOffice formats, you must choose
the Export command on the File menu.

For information on exporting presentations, see “Exporting a Presentation, Slide, or Object,” p. 909. Part
For details on exporting drawings, see “Saving and Closing a Graphic,” p. 775. |

For information on saving and closing bitmapped images, see “Saving and Closing Images,” p. 806. ch

Available File Types 4

The file types available to you depend on how many filters are available in your edition of
StarOffice and how many you chose to install during the initial installation.

For a list of available file formats and extensions, see Appendix B, “File Formats and Extensions,”
p. 1395.

Saving and Exporting Email and News

You can choose to save StarMail messages or StarDiscussion postings as files in the StarMail
.sdm format. If you have composed messages using formatting, saving them this way pre-
serves your original formats. If you store mail and news on your local drives, you can also
move individual messages and postings to other folders through drag and drop or any other
conventional desktop file management techniques (although you lose threading).

To save your Inbox, Outbox, or news account in one large file as a backup, use the Explorer
context menu’s Export command. To access this command, first select your Inbox, Outbox,
or news account. Then right-click, and select File, Export from the context menu. Your
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mailbox or news folder is exported as an ASCII .mbx text file that can be opened in all word
processors.

] For basic information about managing mail and news, see “Using Filters to Manage Files,” p. 197.

I For advanced information on managing your StarMail and StarDiscussion accounts, including a more
detailed discussion of importing and exporting files, see “Techniques for Managing Mail and News,”
p. 1075.

Working Across the Desktop

If you understand the logic of StarOffice’s common tools and design, you’ll be able to work
more efficiently and creatively, no matter what your task.

Issuing Commands
You can issue commands in numerous ways in StarOffice. For example, you can do any of
the following:
= Click commands on menus
= Highlight commands on menus and press Enter
= Click toolbar buttons
= Click buttons in dialog boxes

m Press Enter in a dialog box, which activates the button that is the current focus (indicat-
ed by a darker, bolded line around the but